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BusinessObjects XI Integration for SAP Solutions provides support for specific
BusinessObjects products and delivers improvements in the areas of usability,
implementation, and administration.

This section's focus is to provide a high level overview of the key new features
and enhancements that are specific to BusinessObjects XI Integration for
SAP Solutions.

For more information on what's new in Crystal Reports 2008, see the “What's
New in Crystal Reports 2008” chapter of the Crystal Reports User's Guide.
For more information on what's new in BusinessObjects Enterprise, see the
“What's New in BusinessObjects Enterprise” chapter of the SAP
BusinessObjects Enterprise Administrator's Guide.
Related Topics
• About this guide

About this guide
The BusinessObjects XI Integration for SAP Solutions provides you, the SAP
user, with the ability to extract the business intelligence contained within your
SAP systems. BusinessObjects EnterpriseInfoView allows you to share your
reports over the Web, and SAP Authentication enables Single Sign On
between your SAP system and BusinessObjects Enterprise.

BusinessObjects XI Integration for SAP Solutions consists of several main
components: Crystal Reports is the report-design tool that allows you to
report off your SAP data; BusinessObjects Enterprise provides the framework
for managing, scheduling, and distributing reports over the Web; Web
Intelligence enables you to create queries and documents quickly; and
Voyager allows you to analyze and report off the multidimensional data that
is stored in the Info Cubes of your SAP Business Information Warehouse.

BusinessObjects XI Integration for SAP Solutions provides the database
drivers and other features for reporting off SAP. This guide documents the
SAP report-design features that are available once you install on top of
Crystal Reports or Voyager. It also shows how to publish and view these
reports in a BusinessObjects Enterprise environment.
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Who should read this guide

This guide is intended for SAP and BusinessObjects Enterprise administrators
who want to install and configure the core Business Objects products with
BusinessObjects XI Integration for SAP Solutions. Familiarity with your SAP
system and BusinessObjects Enterprise is required to use this guide.
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This section introduces the various reporting components that make up
BusinessObjects XI Integration for SAP Solutions. The section then provides
information on the overall product architecture and describes features
provided by various components.

Overview
BusinessObjects XI Integration for SAP Solutions provides you with powerful
report-design tools and a framework for managing, scheduling, and
distributing your reports over the Web. As such, it enables you to extract
additional value from your SAP Business Information Warehouse (BW) and
R/3 data and share it with users across the enterprise.

BusinessObjects XI Integration for SAP Solutions includes four major
products—BusinessObjects Enterprise Professional, Crystal Reports
Professional, Web Intelligence, and Voyager—along with components that
integrate the Business Objects reporting technologies with your existing SAP
systems.

Add-Ons

The Add-Ons distribution contains the setup program and additional
documentation for the components that integrate with your SAP system. The
setup program determines which Business Objects products are already
installed, and then installs the add-on components as required.

The add-on components are:

• Data Access

This component provides database drivers that are designed specifically
for reporting off SAP data. Crystal Reports drivers are included for
OpenSQL, Infoset, BW Query, BW MDX and ODS. Crystal Reports drivers
need to be installed on the machines that host the Crystal Reports servers.
The MDA SAP driver needs to be installed on the machines that host the
Voyager server, Universe designer, Offline Web Intelligence designer
and Web Intelligence Processing Server.

• Crystal Reports SAP Toolbar
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Integrated within Crystal Reports, the SAP Tools toolbar facilitates tasks
associated with reporting off BW queries. It allows you to log on to BW
and work with its data sources, save reports to BW, and publish reports
immediately to BusinessObjects Enterprise via BW.

For details on using the toolbar, see the BusinessObjects XI Integration
for SAP Solutions User's Guide.

• SAP Authentication

This component allows you to map your existing SAP roles and users to
BusinessObjects Enterprise. It also enables BusinessObjects Enterprise
to authenticate users against the SAP system, thereby providing Single
Sign On to your SAP users. As a result, once SAP users are logged on
to the SAP system, they are recognized by BusinessObjects Enterprise
as authenticated users.

• BW Publisher

This component allows you to publish reports individually or in batches
from BW to BusinessObjects Enterprise.

• Web content

This component includes BusinessObjects EnterpriseInfoView. InfoView
allows users to organize and view their Crystal reports in multiple
languages over the Web.

• Transport files

The transport files are included in the transports directory of the installation
CD. You must import these transports and configure a number of
authorization objects in order for users to connect to SAP through Crystal
Reports and BusinessObjects Enterprise.

• BW Content Administration Workbench

This feature allows you to manage report publishing from with BW. You
can identify roles in your BW with specific BusinessObjects Enterprise
systems, publish reports, and synchronize between BW and a
BusinessObjects Enterprise system.

• Sample reports

The sample reports demonstrate a variety of ways in which you can extract
value from SAP data using different database drivers.

• Sample iViews
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Sample iViews illustrate how BusinessObjects Enterprise SAP Edition
can be implemented with SAP Enterprise Portal version 6 and later. These
iViews demonstrate sample functionality for alerts, and thumbnail views
inside SAP Enterprise Portal.

• Knowledge Management

Knowledge Management (KMC)

The Knowledge Management interface enables third-parties to integrate
any repository into the SAP Enterprise Portal. The KMC allows users to
integrate BusinessObjects Enterprise into the SAP Enterprise Portal,
When the BusinessObjects Enterprise repository is integrated into the
KMC framework, the objects in the repository are accessible for different
work flows like the collaboration features of the SAP Enterprise Portal.

Related Topics
• Reporting off BW queries, InfoSets, Operational Data Stores, and MDX
cubes
• Reporting off other SAP data sources
• Authenticating SAP users
• Publishing from BW to BusinessObjects Enterprise
• Configuring transports

Integrated architecture

The following diagram illustrates how each of the BusinessObjects XI
Integration for SAP Solutions components expand upon the multi-tier
framework of BusinessObjects Enterprise.
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If you are new to BusinessObjects Enterprise, see its documentation for a
more detailed explanation of its framework, its components, and the general
tasks that each component performs.
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Reporting with BusinessObjects XI
Integration for SAP Solutions

This section describes the key features provided by BusinessObjects XI
Integration for SAP Solutions.

Authenticating SAP users

Security plug-ins expand and customize the ways in which BusinessObjects
Enterprise authenticates users. The SAP Authentication feature includes an
SAP security plug-in (secSAPR3.dll) for the Central Management Server
(CMS) component of BusinessObjects Enterprise. This SAP security plug-in
offers several key benefits:

• It acts as an authentication provider that verifies user credentials against
your SAP system on behalf of the CMS. When users log on to
BusinessObjects Enterprise directly, they can choose SAP Authentication
and provide their usual SAP user name and password. BusinessObjects
Enterprise can also validate Enterprise Portal logon tickets against SAP
systems.

• It facilitates account creation by allowing you to map roles from SAP to
BusinessObjects Enterprise user groups, and it facilitates account
management by allowing you to assign rights to users and groups in a
consistent manner within BusinessObjects Enterprise.

• It dynamically maintains SAP role listings. So, once you map an SAP role
to BusinessObjects Enterprise, all users who belong to that role can log
on to BusinessObjects Enterprise. When you make subsequent changes
to the SAP role membership, you need not update or refresh the listing
in BusinessObjects Enterprise.

• The SAP Authentication component includes a web application for
configuring the plug-in. You can access this application in the
"Authentication" area of the Central Management Console (CMC).

Related Topics
• Configuring SAP authentication for BusinessObjects Enterprise
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Reporting off BWqueries, InfoSets,OperationalData
Stores, and MDX cubes

BusinessObjects XI Integration for SAP Solutions provides connectivity to
your SAP data through four database drivers—the BW Query driver, the
InfoSet driver, the ODS driver, and the MDX driver:

• The BW Query driver is integrated directly within the Crystal Reports
interface. The SAP Tools toolbar works with the BW Query driver to allow
you to report off your BW queries from within Crystal Reports. The toolbar
also allows you to save reports to BW and publish them directly to
BusinessObjects Enterprise.

• The InfoSet driver provides Crystal Reports with another means of
accessing SAP data sources: this driver can access R/3 InfoSets
(previously known as Functional Areas) and ABAP Queries. You access
this driver through the Data Explorer in Crystal Reports.

• The Operational Data Store (ODS) driver allows you to use existing ODS
objects from your BW Data Warehouse as a data source in Crystal
Reports.

• The SAP BW MDX Query driver introduces new flexibility when reporting
off BW cubes and queries. By writing reports with the MDX Query driver,
you gain direct access to BW cubes, display attributes, and multiple
structures.

One advantage of these drivers is that they allow business users to report
off predefined views of your SAP data. Tables and fields are first logically
grouped by an SAP content expert into queries, InfoSets, and so on. You
then make these data sources accessible to users who are designing reports
with Crystal Reports.

These same four drivers are also included in the add-ons for BusinessObjects
Enterprise (the Data Access feature), so the BusinessObjects Enterprise
processing servers can successfully run the reports you design against your
SAP systems. These drivers allow you to work with Crystal Reports.
Additionally, the Data Access feature includes the MDA SAP driver, which
lets you work with Voyager and Web Intelligence data sources. For more
information about using Voyager and Web Intelligence, see these guides:

• BusinessObjects Voyager User's Guide
• Web Intelligence Online Help
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Note:
Before you can design or process reports with the InfoSet or OpenSQL
drivers, you must install the corresponding transport file on the SAP system.

For instruction on creating Crystal reports with these drivers, consult the
BusinessObjects XI Integration for SAP Solutions User's Guide available
online.
Related Topics
• Configuring transports
• Add-Ons
• http://support.businessobjects.com/documentation/product_guides/de
fault.asp

Reporting off other SAP data sources

In addition to the previously mentioned drivers, BusinessObjects XI Integration
for SAP Solutions also includes the Open SQL driver, which allows you to
report off additional SAP data sources from within Crystal Reports,
BusinessObjects Enterprise, and Voyager.
Related Topics
• Add-Ons

Reporting off tables, views, clusters, and functions

The Open SQL driver is the most powerful of the drivers due to the flexibility
it provides for accessing data in SAP. This flexibility, however, results in a
higher level of complexity than with the InfoSet driver.

When you create reports that use the Open SQL driver, you gain easy access
to SAP's transparent tables, pool tables, cluster tables, and views. Users
who are currently involved with the production of ABAP reports will find it
easy to build reports quickly with this driver.

Advanced functionality in the driver also allows reporting against ABAP
functions and ABAP data clusters. ABAP developers can use these features
to perform advanced tasks such as reporting against data clusters in HR.
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Reporting off multidimensional data in BW

The BW Voyager has been specially designed to integrate the Online
Analytical Processing (OLAP) viewing capabilities of Voyager and Crystal
Reports with your SAP Business Information Warehouse (BW) system. Users
can connect to multidimensional BW Info Cubes and generate reports that
incorporate complex data analysis.

For additional information on OLAP analysis and reporting, refer to your
Voyager and/or Crystal Reports documentation.

Publishing from BW to BusinessObjects Enterprise

The BW Publisher allows you to publish Crystal reports (.rpt files) individually
or in batches from BW to BusinessObjects Enterprise.

Reports are published from BW to BusinessObjects Enterprise in several
ways: users who design Crystal reports can simultaneously save reports to
their roles in BW and publish them to BusinessObjects Enterprise, provided
they have sufficient rights. Users with the appropriate rights within BW and
BusinessObjects Enterprise can also publish reports individually or in batches
using the Content Administration Workbench.

Details of the publishing process depend upon the publisher configuration
that you select.
Related Topics
• Publishing reports using the Content Administration Workbench
• Add-Ons

Selecting your BW Publisher configuration

You can configure the BW Publisher in one of two ways:

• Install the BW Publisher as a service on a BusinessObjects Enterprise
machine. The BW Publisher service will start instances of the BW
Publisher as required.

• Install a local SAP Gateway to create instances as needed.
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Select the configuration method based on the requirements of your site, after
considering the advantages and disadvantages of each configuration.

BW Publisher service

Advantages:

• It is simpler to install than a local SAP Gateway.
• It is scalable because new publisher instances are created automatically

in response to increased publishing load.

Disadvantages:

• It is more difficult to administer than a local SAP Gateway because
changes to the BW Publisher service require you to edit the registry.

• It makes less efficient use of computing resources than a local SAP
Gateway because Publisher Instances are not stopped automatically
when they are no longer needed.

Local SAP Gateway

Advantages:

• It uses system resources more efficiently than a BW Publisher service
for Windows installations of BusinessObjects Enterprise.

Disadvantages

• It is more complex to install and configure than the BW Publisher service.

Note:
For UNIX installations of BusinessObjects Enterprise, install BW Publisher
as a service.

For UNIX installations of BusinessObjects Enterprise, follow the instructions
for installing the BW Publisher as a service. However, your system
configuration will vary slightly as you must manually start the required number
of BW Publisher instances.

To return to the Windows installation procedure, go to "Recommended initial
installation".

24 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Components and Features2 Reporting with BusinessObjects XI Integration for SAP Solutions



Publishing Reports

Whether you choose to configure the BW Publisher service with or without
a local SAP Gateway, the same basic publishing process occurs.

Note:
Before beginning to publish, you must configure SAP authentication in
BusinessObjects Enterprise, define a folder structure for your content, and
import SAP roles. See Configuring SAP authentication for BusinessObjects
Enterprise for complete instructions.

When a user attempts to publish one or more Crystal reports, BW looks for
a Remote Function Call (RFC) destination (of type TCP/IP) that is configured
to connect to this BW Publisher. The TCP/IP destination provides BW with
the name and port number of the SAP Gateway that the BW Publisher is
registered with.

BW then communicates over TCP/IP with the BW Publisher, and sends the
following information across the network:

• The appropriate Crystal Reports file(s), with any required translated report
strings.

Tip:
For more on translated reports, see the Integration for SAP Solutions
User's Guide.

• The name of the appropriate Central Management Server (CMS).

The SAP Gateway responds by executing the publishing command, thereby
invoking the BW Publisher. The BW Publisher logs on to the specified CMS
as the user, and checks to see if the user has the appropriate permissions
in BusinessObjects Enterprise to publish reports. If the user's rights are
sufficient, the CMS allows the reports to be added to the system.

The main difference between the two configuration types is that if you do not
install a local SAP Gateway, the BW Publisher service registers as a server
program with the SAP Gateway running on your application host, using the
name you specify as its Program ID string. This SAP Gateway may be
installed on your single BW server, or on your central instance of BW if you
have a BW cluster.
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To return to the installation procedure, go to "Recommended initial
installation".

Distributing information over the Web

SAP functionality is integrated with your version of InfoView. These features
are designed especially for SAP users:

• Users whose roles you import can log on to InfoView with their usual SAP
credentials.

• Users can browse a hierarchy of My Groups folders that correspond to
the structure of the imported roles whose content you publish from BW
to BusinessObjects Enterprise. In these folders, users can locate, view,
and refresh Crystal reports that have been saved in their BW roles.

• Users can schedule translated reports in specific languages and view
report titles and on-demand reports.

Tip:
These features require that you translate the reports within BW, before
you publish the reports to BusinessObjects Enterprise. For more
information, see the BusinessObjects XI Integration for SAP Solutions
User's Guide.

• Administrators can divide report processing by language across server
groups. This ensures that reports created or translated in a specific
language are always processed by servers that can handle data in that
language.

In addition, you are able to report off of a variety of other SAP data sources
from within Crystal Reports, Voyager, and BusinessObjects Enterprise.
Related Topics
• Reporting with BusinessObjects XI Integration for SAP Solutions
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Installing BusinessObjects
XI Integration for SAP
Solutions

3



This section describes the steps for installing BusinessObjects XI Integration
for SAP Solutions. It also provides instructions on the main installation and
configuration stages.

Installation overview
To set up BusinessObjects XI Integration for SAP Solutions, you must
complete the main installation and configuration stages in this order:

1. Check the system requirements and perform the installation procedures
that correspond to your operating environment.

See Installing on UNIX or Installing on Windows.

2. Complete the required base administrative tasks within SAP necessary
to configure your systems to work with BusinessObjects XI Integration
for SAP. Required tasks include importing transport files and setting up
authorizations in SAP, configuring SAP authentication in BusinessObjects
Enterprise, and configuring Data Access for SAP.

For complete details, see Configuring SAP authentication .

3. If you have BW, complete the following additional configuration steps:

• Setting up folders and security in BusinessObjects Enterprise
• Configuring the BW Publisher
• Configuring publishing in the Content Administration Workbench
• Configuring the SAP http request handler

For complete information, see Configuring the BW Publisher.

A number of installation tasks require the skills and security privileges of an
SAP BASIS administrator.

Note:
The Web Application Container Server (WACS) is not a supported application
server for the Business Objects XI Integration for SAP Solutions. To use
.NET InfoView on IIS together with BusinessObjects XI Integration for SAP
Solutions, you are still required to install backend applications such as CMC
or Web Services on a supported Java application server.

Once you have completed the main installation and configuration stages,
you may need to complete additional tasks, depending on the features that
you want to enable. For details, consult the remaining sections of this help.
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Note:
Throughout this guide, businessobjects_root refers to
BusinessObjects Enterprise root installation
directory/BusinessObjects.

SAP requirements for both Unix and Windows

Before you can enable ticket based Single Sign On between SAP and
BusinessObjects Enterprise, you must set up SAP to accept and create logon
tickets. This involves setting two related profile parameters on your SAP
server:

• login/accept_sso2_ticket
• login/create_sso2_ticket

The parameter values that you set depend upon whether or not the server's
certificate is self-signed or signed by the SAP CA. For complete details on
these profile parameters and configuring BW to accept and create logon
tickets, see the SAP Library > SAP Web Application Server > Security
> SAPWeb Application Server Security > User Authentication > Using
Logon Tickets.

Note:
You must re-start the SAP system to activate your changes.

Installing on UNIX
UNIX versions of the following BusinessObjects Enterprise add-on
components are provided for environments where BusinessObjects Enterprise
is running on UNIX:

• SAP Authentication
• BW Publisher
• Data Access
• Web Content

When installing BusinessObjects XI Integration for SAP Solutions on UNIX,
consider the following:

• You install the BusinessObjects Enterprise add-on components by running
the install.sh script.

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 29

3Installing BusinessObjects XI Integration for SAP Solutions
Installing on UNIX



• You can expand your deployment by distributing the BusinessObjects
Enterprise servers across multiple machines.

Related Topics
• Distributed installation

System requirements

Before installing any of the BusinessObjects XI Integration for SAP Solutions
components, ensure that your environment meets the following requirements:

• Before installing SAP integration, you must install SAP RFC SDK and
SAP JCO SDK, which can be downloaded from the SAP Marketplace at
service.sap.com/bosap-support.

• BusinessObjects Enterprise must be installed and configured correctly
on UNIX before you install the BusinessObjects XI Integration for SAP
Solutions components. Complete this installation and configuration in
accordance with the SAP BusinessObjects Enterprise Installation Guide.

• The following entry must appear in the services file on the
BusinessObjects Enterprise machine (found in /etc):

sapmsSIDport/tcp

Replace SID with the system ID of your SAP system, and replace port
with the port number of the message server that BusinessObjects
Enterprise will log onto (for example, sapmsQR6 3600/tcp). This
standard setting allows BusinessObjects Enterprise to log on to SAP with
load balancing.

• If a BusinessObjects Enterprise component requires an SAP router to
connect to an SAP system, you can configure the component using the
SAP router string. For example, when configuring an SAP entitlement
system to import roles and users, the SAP router string can be substituted
for the application server’s name. This insures that the CMS will
communicate with the SAP system through the SAP router.

Note:
The BW Publishing service installed by BusinessObjects XI Integration for
SAP Solutions cannot be configured to use an SAP router.
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SAP Java Connector

BusinessObjects XI Integration for SAP Solutions web applications (including
InfoView), and the BusinessObjects XI Integration for SAP Solutions Java
SDK require the SAP Java Connector. The SAP Java Connector is available
from http://service.sap.com/connectors/

Please see the SAP MarketPlace for information on licensing SAP Java
Connector for use in your development environment.

After you have installed BusinessObjects Enterprise, you must unpack the
archive file containing the SAP Java Connector.

Then you must do one of the following things:

• Copy the librfccm library and the libsapjcorfc library to busines
sobjects_root/enterprise120/PLATFORM_PATH, where busines
sobjects_root is the full path to your businessobjects directory,
and PLATFORM_PATH is your platform. For example, PLATFORM_PATH
is solaris_sparc for an installation on Solaris.

• Use symbolic links for the location of the librfccm library and the lib
sapjcorfc library.

• Add the location of the librfccm library and the libsapjcorfc library
to the library path.

After you have installed BusinessObjects Enterprise, you must make sapj
co.jar available to your Java application server as a shared resource either
by placing sapjco.jar in the application server's shared lib directory, or
by adding sapjco.jar to the class. See Distributed installation or consult
your application server documentation for details.

Consult the documentation included with the SAP Java Connector for more
information.

Installing the SP4 update package

To upgrade your BusinessObjects XI Integration for SAP Solutions to 3.1
SP4, you will need to download the appropriate SP4 upgrade patch from
"http://service.sap.com/patches". Once you have the patch on the system
where the integration was installed, use the following instructions to run it.

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 31

3Installing BusinessObjects XI Integration for SAP Solutions
Installing on UNIX

http://service.sap.com/connectors/


To install the SP4 update package on UNIX

1. Launch the installation by typing the following in a command line where
your installation package is located: ./install.sh <install_dir>.
The install_dir is the directory where you originally installed the
component you are upgrading.

2. Review the content of the License agreement and select Y to proceed if
you agree to the terms.

3. Press Enter.
You will be prompted for your CMS credentials.

4. Enter your CMS credentials and press Enter.
If you deployed web applications when you installed BusinessObjects
Enterprise, you will be asked if you want the installation program to
automatically redeploy web applications. If not, skip to Step 6.

Note:
If you chose to manually deploy web applications when you installed, you
will not be automatically prompted. You must manually redeploy your web
applications once the installation program has finished.

5. Select Yes if you want the installation program to automatically redeploy
web applications, select No if you want to manually deploy web
applications later.
If you selected Yes, you will be prompted to enter your web application
server credentials. Enter your web application server credentials, and
press Enter to proceed.
You are prompted to confirm that the installation can begin.

6. Press Enter.

The progress indicator displays the status of the installation.

Note:
A backup of all the files being modified by the update is created in the
INSTALL DIR/setup/backup directory.

7. Press Enter to complete the installation.

Note:

To review details of the installation, view the contents of the installation
log file located in <install_dir>/setup/logs, where <in
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stall_dir> is the directory where the product was installed. The file
will be called UNIX BOE SP2 - BusinessObjects_SP2.12.2.log.

Deploying web applications using wdeploy

Note:

• The BusinessObjects Integration for SAP Solutions installation updates
wdeploy in order to deploy BusinessObjects Integration for SAP Solutions
web content. To deploy BusinessObjects Integration for SAP Solutions
web applications after installation, you must use the wdeploy found in
the installdir/deployment folder.

• Before performing this procedure, ensure that you have deployed the
SAP Java Connector.

Related Topics
• SAP Java Connector

Deploying web applications on Tomcat

This section guides you through the process of deploying InfoView on Tomcat
servers in Unix environment.

To deploy web applications on Tomcat
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir/de
ployment folder instead of the standalone wdeploy.

Note:
If Tomcat was installed with BusinessObjects Enterprise, the BusinessObjects
Integration for SAP Solutions installation automatically deploys to the same
server.

1. Shut down Tomcat if it is running, and type sh %CATALI
NA_HOME%/bin/shutdown.sh in a property command window.

Note:
%CATALINA_HOME% represents the root directory of the Tomcat
installation.
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2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file.
See SAP Java Connector for details.

3. Create a new and empty file: %CATALINA_HOME%/conf/Catalina/lo
calhost/sap.xml

This file will be used as the context descriptor file for InfoView and the
CMC.

4. Add the following line to sap.xml in a text editor such as Notepad, and
save sap.xml: Context docBase="$tomcat/applica
tion/SAP.war" path="/SAP" debug="0" reloadable="false"
crossContext="false" trusted="false" /

5. To manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications, use wdeploy found under businessob
jects_root/deployment.
a. Move to businessobjects_root/bobje/enterprise120/ja

va/applications, and use the following command to package the
WAR files:

businessobjects_root/bobje/jdk/bin/jar cf CmcApp.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/CmcApp .

businessobjects_root/bobje/jdk/bin/jar cf InfoViewApp.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/InfoViewApp .

businessobjects_root/bobje/jdk/bin/jar cf OpenDocument.war -C
businessobjects_root/bobje/enterprise120/warfiles/WebApps/Open
Document .

businessobjects_root/bobje/jdk/bin/jar cf SAP.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/SAP .

businessobjects_root/bobje/jdk/bin/jar cf PartnerPlatformService.war
-C businessobjects_root/bobje/enterprise120/warfiles/WebApps/Part
nerPlatformService .

businessobjects_root/bobje/jdk/bin/jar cf dswsbobje.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/dswsbobje/.

b. Open the config.WAS_Type file (for example, config.tomcat55)
located under businessobjects_root/deployment, set the
parameters appropriate for your environment, and save the file.
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For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.

c. Stop Tomcat
d. Navigate to the businessobjects_root/deployment folder, and

use the following command to undeploy BusinessObjects Enterprise
web applications:

./wdeploy.sh tomcat55 -DAPP=CmcApp undeploy

./wdeploy.sh tomcat55 -DAPP=InfoViewApp undeploy

./wdeploy.sh tomcat55 -DAPP=OpenDocument undeploy

./wdeploy.sh tomcat55 -DAPP=dswsbobje undeploy

e. Restart Tomcat and navigate to the businessobjects_root/de
ployment folder, and use the following command to deploy
BusinessObjects Enterprise web applications :

./wdeploy.sh tomcat55 -DAPP=CmcApp deploy

./wwdeploy.sh tomcat55 -DAPP=InfoViewApp deploy

./wdeploy.sh tomcat55 -DAPP=OpenDocument deploy

./wdeploy.sh tomcat55 -DAPP=dswsbobje deploy

f. Use the following command to deploy SAP web applications:

./wdeploy.sh tomcat55 -DAPP=SAP deploy

./wdeploy.sh tomcat55 -DAPP=PartnerPlatformService
deploy

6. Create a new and empty file: %CATALI
NA_HOME%/conf/Catalina/local
host/PartnerPlatformService.xml

7. Add the following line to PartnerPlatformService.xml in a text ed
itor such as Notepad and save PartnerPlatformService.xml:
Context docBase="$tomcat/application/PartnerPlatform
Service.war" path="/PartnerPlatformService" debug="0"
reloadable="false" crossContext="false" trusted="false"
/

8. Restart Tomcat by typing %CATALINA_HOME%/bin/startup at the command
prompt.

9. To test that the SAP authentication module is now available, open a web
browser and type http://servername:8080/CmcApp in its address bar to
launch the Central Management Console (CMC).
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10. Log on to the CMC using your Administrator account and password.
The password is set when you install BusinessObjects Enterprise.

11. Click Authentication, and then double-click SAP.
The SAP authentication page should appear. If it does not, ensure that
the librfccm and libsapjcorfc libraries are in your businessob
ject_root/enterprise120/PLATFORM directory, and restart your
application server.

Deploying web applications on BEA WebLogic

This section guides you through the process of deploying InfoView on BEA
WebLogic in a Unix environment.

To deploy web applications on BEA WebLogic
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir/de
ployment folder instead of the standalone wdeploy.

1. Ensure that your BEA WebLogic server is not running.
2. Ensure that your CLASSPATH environment variable includes the sapj

co.jar archive file.
See SAP Java Connector for details.

3. Start your BEA WebLogic server.
4. Open a web browser, and type http://servername:7001/console in its

address bar to open the BEA WebLogic Administrative Console.

Substitute the name of the machine where you installed BEA WebLogic
for servername.

Note:
By default, BEA WebLogic uses port 7001. If you configured your
application server to use a different port number, substitute that port
number in the URL.

5. To manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications, use wdeploy found under INSTALLDIR/deployment.
a. Move to businessobjects_root/bobje/enterprise120/ja

va/applications, and use the following command to package the
WAR files:
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businessobjects_root/bobje/jdk/bin/jar cf CmcApp.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/CmcApp .

businessobjects_root/bobje/jdk/bin/jar cf InfoViewApp.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/InfoViewApp .

businessobjects_root/bobje/jdk/bin/jar cf OpenDocument.war -C
businessobjects_root/bobje/enterprise120/warfiles/WebApps/Open
Document .

businessobjects_root/bobje/jdk/bin/jar cf SAP.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/SAP .

businessobjects_root/bobje/jdk/bin/jar cf PartnerPlatformService.war
-C businessobjects_root/bobje/enterprise120/warfiles/WebApps/Part
nerPlatformService .

businessobjects_root/bobje/jdk/bin/jar cf dswsbobje.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/dswsbobje .

b. Open the config.WAS_Type file (for example, config.weblogic9)
located under INSTALLDIR/deployment, set the parameters
appropriate for your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.

c. Navigate to the businessobjects_root/deployment folder and
use the following command to redeploy related BusinessObjects
Enterprise web applications:

./wdeploy.sh weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> undeploy
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./wdeploy.sh weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> deploy

d. Use the following command to deploy SAP web applications:

./wdeploy.sh weblogic9 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=PartnerPlatformService
-Das_admin_password=<your password here> deploy

6. To test that BusinessObjects Enterprise deploys correctly, type
http://servername:7001/InfoViewApp/ in the address bar of a web
browser.

7. To test that the SAP authentication module is now available, open a web
browser and type http://servername:7001/CmcApp in its address bar to
launch the Central Management Console (CMC).

8. Log on to the CMC using your Administrator account and password.
The password is set when you first install BusinessObjects Enterprise.

9. Click Authentication, and then double-click SAP.

The SAP authentication page should appear. If it does not, ensure that
the librfccm and libsapjcorfc libraries are in your businessob
jects_root/enterprise120/PLATFORM directory, and restart your
Java application server.

For more information about wdeploy, see the BusinessObjects Enterprise
documentation.

Deploying web applications on IBM WebSphere

This section guides you through the process of deploying InfoView on IBM
WebSphere in a Unix environment.

To deploy web applications on IBM WebSphere
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir/de
ployment folder instead of the standalone wdeploy.

1. Ensure that your IBM WebSphere server is not running.

38 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Installing BusinessObjects XI Integration for SAP Solutions3 Installing on UNIX



2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file.
See SAP Java Connector for details.

3. Start your IBM WebSphere Server, and launch the Administrative Console
(for example, http://servername:9060/ibm/console).
For servername, substitute the name of the machine where you installed
IBM WebSphere. If you chose to use a port number other than the default
value for the administrative console, substitute that value for 9060.

4. To manually deploy the BusinessObjects XI Integration for SAP Solutions
web applications, use wdeploy found under INSTALLDIR/deployment.
a. Move to businessobjects_root/bobje/enterprise120/ja

va/applications, and use the following command to package the
WAR files:

businessobjects_root/bobje/jdk/bin/jar cf CmcApp.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/CmcApp .

businessobjects_root/bobje/jdk/bin/jar cf InfoViewApp.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/InfoViewApp .

businessobjects_root/bobje/jdk/bin/jar cf OpenDocument.war -C
businessobjects_root/bobje/enterprise120/warfiles/WebApps/Open
Document .

businessobjects_root/bobje/jdk/bin/jar cf SAP.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/SAP .

businessobjects_root/bobje/jdk/bin/jar cf PartnerPlatformService.war
-C businessobjects_root/bobje/enterprise120/warfiles/WebApps/Part
nerPlatformService .

businessobjects_root/bobje/jdk/bin/jar cf dswsbobje.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/dswsbobje .

b. Open the config.WAS_Type file (for example, config.web
sphere6) located in INSTALLDIR/deployment, set the parameters
appropriate to your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.
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c. Navigate to the businessobjects_root/deployment folder, and
use the following command to redeploy related BusinessObjects
Enterprise web applications:

./wdeploy.sh weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
./wdeploy.sh weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> undeploy
./wdeploy.sh weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> deploy

d. Use the following command to deploy SAP web applications:

./wdeploy.sh websphere6 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
./wdeploy.sh websphere6 -DAPP=PartnerPlatformService
-Das_admin_password=<your password here> deploy

5. To test that InfoView deploys correctly, type http://servername:9080/In
foViewApp in the address bar of a web browser.

6. To test that the SAP authentication module is now available, open a web
browser and type http://servername:9060/CmcApp in its address bar to
launch the Central Management Console (CMC).

7. Log on to the CMC using your Administrator account and password.
The password is set when you first install BusinessObjects Enterprise.

8. Click Authentication, and then double-click the SAP link.
The SAP authentication page should appear. If it does not, ensure that
the librfccm and libsapjcorfc libraries are in your businessob
jects_root/enterprise120/PLATFORM directory, and restart your
Java application server.
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Deploying web applications on SAP Web Application Server

This section guides you through the process of deploying InfoView on SAP
WAS in a UNIX environment.

To deploy web applications on SAP Web Application Server
1. Ensure that your SAP WAS server is not running.
2. Ensure that your CLASSPATH environment variable includes the sapj

co.jar archive file.
See SAP Java Connector for details.

3. Start your SAP Web Application Server.
4. To manually deploy the BusinessObjects XI Integration for SAP Solutions

web applications, use wdeploy found under INSTALLDIR/deployment.
a. Move to businessobjects_root/bobje/enterprise120/ja

va/applications, and use the following command to package the
WAR files:

businessobjects_root/bobje/jdk/bin/jar cf CmcApp.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/CmcApp .

businessobjects_root/bobje/jdk/bin/jar cf InfoViewApp.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/InfoViewApp .

businessobjects_root/bobje/jdk/bin/jar cf OpenDocument.war -C
businessobjects_root/bobje/enterprise120/warfiles/WebApps/Open
Document .

businessobjects_root/bobje/jdk/bin/jar cf SAP.war -C businessob
jects_root/bobje/enterprise120/warfiles/WebApps/SAP .

businessobjects_root/bobje/jdk/bin/jar cf PartnerPlatformService.war
-C businessobjects_root/bobje/enterprise120/warfiles/WebApps/Part
nerPlatformService .

businessobjects_root/bobje/jdk/bin/jar cf dswsbobje.war -C busines
sobjects_root/bobje/enterprise120/warfiles/WebApps/dswsbobje .

b. Open the config.WAS_Type file (for example, con
fig.nw2004)located in INSTALLDIR/deployment, set the
parameters appropriate to your environment, and save the file.
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For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.

c. Navigate to the businessobjects_root/deployment folder, and
use the following command to redeploy related BusinessObjects
Enterprise web applications:

./wdeploy.sh nw2004 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
./wdeploy.sh nw2004 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
./wdeploy.sh nw2004 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> undeploy
wdeploy.sh nw2004 -DAPP=InfoViewApp -Das_admin_pass
word=<your password here> deploy
wdeploy.sh nw2004 -DAPP=OpenDocument -Das_admin_pass
word=<your password here> undeploy
wdeploy.sh nw2004 -DAPP=OpenDocument -Das_admin_pass
word=<your password here> deploy
wdeploy.sh nw2004 -DAPP=dswsbobje -Das_admin_pass
word=<your password here> undeploy
wdeploy.sh nw2004 -DAPP=dswsbobje -Das_admin_pass
word=<your password here> deploy

d. Use the following command to deploy SAP web applications:

wdeploy.sh nw2004 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
wdeploy.sh nw2004 -DAPP=PartnerPlatformService -
Das_admin_password=<your password here> deploy

5. To test that InfoView has deployed correctly, type http://server
name:port/InfoViewApp in the address bar of a web browser.

6. To test that the SAP authentication module is now available, open a web
browser and type http://servername:port/CmcApp in its address bar
to launch the Central Management Console (CMC).

7. Log on to the CMC using your Administrator account and password. (By
default the password is blank when you first install BusinessObjects
Enterprise.)

8. Click Authentication, and then double-click the SAP link.
The SAP authentication page should appear. If it does not, ensure that
the librfccm and libsapjcorfc libraries are in your businessob
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jects_root/enterprise120/PLATFORM directory, and restart your
Java application server.

Installing on Windows
This section outlines how to install the core Business Objects products and
then how to install BusinessObjects XI Integration for SAP Solutions.

System requirements

Before installing SAP integration, you must install SAP GUI, which can be
downloaded from the SAP Marketplace at service.sap.com/bosap-
support.

All BusinessObjects XI Integration for SAP Solutions components are
supported for use with the version XI releases of BusinessObjects Enterprise,
Crystal Reports, and Voyager on Windows operating systems. For a
stand-alone installation, ensure that all requirements are met on a single
machine. For a distributed installation, ensure that each machine meets the
requirements that correspond to the components you are installing.

Note:
For a detailed list of tested environments for BusinessObjects XI Integration
for SAP Solutions, consult the platform support information available online
at http://support.businessobjects.com/documentation/supported_platforms/de
fault.asp.

Server requirements for BusinessObjects Enterprise

• Download the RFC SDK for your platform from the SAP Service
Marketplace, or using the Installation option in your SAP program.

• The files saplogon.ini and librfc32.dll need to be installed on
machines with Data Access components. The file saplogon.ini is
required for Crystal Reports machines; the file librfc32.dll is required
for client and server machines. Alternatively, you can add the full path to
the saplogon.ini file to the SAPLOGON_INI_FILE environment
variable.
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• Supported web server software must be installed and configured correctly
before you install BusinessObjects Enterprise. Consult the platform support
information available online at http://support.businessobjects.com/docu
mentation/supported_platforms/default.asp for a complete list.

• If you are using a load balanced logon, the following entry must appear
in the Services file (found in %windir%\system32\drivers\etc\)
on any BusinessObjects Enterprise machines running a CMS, Crystal
Reports Processing Server, and/or Report Job Server:

sapmsSIDportnumber/tcp

Replace SID with the system ID of your SAP system, and replace
portnumber with the port number of the message server that
BusinessObjects Enterprise will log on to (for example, sapmsQR6
3600/tcp). Ensure also that a blank line follows the entry. This standard
setting allows BusinessObjects Enterprise to log on to SAP with load
balancing.

Client requirements for Crystal Reports

If you have a BW environment, install the SAPGUI along with the BW AddOn
option from the SAP Presentation CD before you install Crystal Reports and
BusinessObjects XI Integration for SAP Solutions. Business Explorer version
3.x components are integrated into Crystal Reports.

For a detailed list of tested environments for Crystal Reports, consult the
platform support information available online at http://help.sap.com/busines
sobjects.

SAP Java Connector

To install InfoView automatically, you must install and configure SAP Java
Connector components.

To do this, copy librfc32.dll and librfc32u.dll, to the appropriate
folder.
• On 32-bit Windows: %windir%\system32
• On 64-bit Windows: %windir%\sysWOW64
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Copy sapjcorfc.dll to <BusinessObjects install
directory>\win32_x86.

Then copy sapjco.jar to the application server’s shared library folder. For
example, on a 64-bit Windows system with Tomcat 5.5, copy sapjco.jar
to C:\Program Files (x86)\Business
Objects\Tomcat55\shared\lib.

Consult the documentation included with the SAP Java Connector for more
information.
Related Topics
• Deploying the web applications using wdeploy

Installing the SP4 update package on Windows

To upgrade your BusinessObjects XI Integration for SAP Solutions to 3.1
SP4, you will need to download the appropriate SP4 upgrade patch from
"http://service.sap.com/patches". Once you have the patch on the machine
where the integration was installed, use the following instructions to run it.

To install server update packages on Windows

BusinessObjects XI 3.1 Integration for SAP Solutions SP4 supports the
unicode version of RFCLib. Before installing, ensure that your environment
has the SAP Unicode RFC library. This can be installed from your SAP install
program.

1. To launch the installation program run setup.exe.
2. On the "Welcome" dialog box, click Next.
3. On the "License Agreement" dialog box, review the content of the End

User License Agreement and click I accept the License Agreement,
then click Next to proceed if you agree to the terms.

4. Provide your CMS name and login credentials, and click Next.

Note:
If you are installing the upgrade on clustered backend servers, the name
and credentials for the first CMS you upgraded in the cluster must also
be used when upgrading the other servers in that cluster.
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If you installed Web Applications during your BusinessObjects Enterprise
installation, the "Automatically Re-Deploy Web Applications?" screen
appears. If not, skip to Step 7.

Note:
If you chose to manually deploy web applications when you installed, you
will not be automatically prompted. You must manually redeploy your web
applications once the installer has finished.

5. Click Yes if you want the installer to redeploy your web applications for
you as part of the upgrade, or click No if you want to manually redeploy
your web applications later.

6. Click Next.
If you selected No, skip ahead to Step 8. If you selected Yes you will be
prompted for your Web Application Server credentials.

7. Enter your Web Application Server credentials and click Next.
8. On the "Start Installation" dialog box, click Next to begin the installation.

The "Installation Progress" dialog box appears.

9. After the installation is complete, check to see if any BusinessObjects
Enterprise servers are still stopped. If any servers have not restarted,
start them manually through the Central Management Console (CMC),
or restart the Server Intelligence Agent (SIA) from the Central
Configuration Manager (CCM).

Note:
To review details of the installation, you can view the contents of the
installation log file located in the default installation path: C:\Program
Files\Business Objects\BusinessObjects Enterprise
12.0\Logging. The file will be called Windows BOE SP2 -
BOE_SP2_Install_0.log or CRSE 2008 SP2 - RAS_0.log. If the
installation directory was modified at the time of the original installation, the
log files are written to that directory.

Deploying the web applications using wdeploy

To deploy InfoView, you must create virtual path mappings on your Java
web application server.
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Note:

• The wdeploy tool cannot be used to deploy .NET BusinessObjects
Enterprise web applications . Please use the BusinessObjects XI
Integration for SAP Solutions installation to deploy all .NET applications.

• If you are using any of the following Web Servers, please refer to either
the Web Application Deployment Guide for UNIX or the Web Application
Deployment Guide for Windows for instructions on deploying web
applications.
• Tomcat 6
• Weblogic 10.3
• Webshpere7
• SAP Web Application Server 7.10

Deploying web applications on Tomcat

This section guides you through the process of deploying InfoView on Tomcat
servers in a Windows environment.

To deploy web applications on Tomcat
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir\de
ployment folder instead of the standalone wdeploy.

1. Ensure that you have deployed the SAP Java Connector as described in
SAP Java Connector.

2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file. (See SAP Java Connector for details.)

3. Manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications using wdeploy found under installdir\deploy
ment.
a. Move to businessobjects_root\BusinessObjects

Enterprise 12.0\java\applications\, and use the following
command to package the WAR files:

"businessobjects_root\javasdk\bin\jar.exe" cf CmcApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\CmcApp" .

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 47

3Installing BusinessObjects XI Integration for SAP Solutions
Installing on Windows



"businessobjects_root\javasdk\bin\jar.exe" cf SAP.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\SAP" .

"businessobjects_root\javasdk\bin\jar.exe" cf InfoViewApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\InfoViewApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf OpenDocument.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\OpenDocument" .

"businessobjects_root\javasdk\bin\jar.exe" cf dswsbobje.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\dswsbobje" .

"businessobjects_root\javasdk\bin\jar.exe" cf
PartnerPlatformService.war -C "businessobjects_root\ BusinessObjects
Enterprise 12.0\warfiles\WebApps\PartnerPlatformService" .

b. Open config.WAS_Type file (for example, config.tomcat55)
located under businessobjects_root\deployment, set the
parameters appropriate for your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide .

c. Stop Tomcat.
d. Move to installdir\deployment folder, and use the following

command to undeploy BusinessObjects Enterprise web applications:

wdeploy.bat tomcat55 -DAPP=CmcApp undeploy
wdeploy.bat tomcat55 -DAPP=InfoViewApp undeploy
wdeploy.bat tomcat55 -DAPP=OpenDocument undeploy
wdeploy.bat tomcat55 -DAPP=dswsbobje undeploy

e. Restart Tomcat and use the following command to deploy the following
applications:

wdeploy.bat tomcat55 -DAPP=CmcApp deploy
wdeploy.bat tomcat55 -DAPP=InfoViewApp deploy
wdeploy.bat tomcat55 -DAPP=InfoViewApp deploy
wdeploy.bat tomcat55 -DAPP=dswsbobje deploy
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f. Use the following command to deploy the following SAP web
applications:

wdeploy.bat tomcat55 -DAPP=SAP deploy
wdeploy.bat tomcat55 -DAPP=PartnerPlatformService
deploy

4. Create a new and empty file: %CATALI
NA_HOME%\conf\Catalina\local
host\PartnerPlatformService.xml

5. Add the following line to PartnerPlatformService.xml in a text
editor such as Notepad:

Context docBase="C:/PROGRA~1/BUSINE~1/deploy
ment/workdir/tomcat55/application/PartnerPlatformSer
vice.war" path="/PartnerPlatformService" debug="0"
reloadable="false" crossContext="false" trusted="false"

6. Restart Tomcat.
a. Go to Start > Tomcat > Tomcat Configuration.
b. Click Start.

7. To test that the SAP authentication module is now available, open a web
browser and type http://servername:8080/CmcApp in its address bar to
launch the Central Management Console (CMC).

8. Log on to the CMC using your Administrator account and password.
The password is set when you install BusinessObjects Enterprise.

9. Select Authentication, and then double-click SAP.
The SAP authentication page should appear. If it does not, ensure that
the librfccm32.dll is in your C:\WINDOWSWNNT\system32 directory,
and the sapjcorfc.dill is in your businessob
jects_root/win32_x86

Note:
For 64-bit installations, ensure the librfc32.dll libraries are in your
directory C:\Windows\sysWow64 directory, and the sapjcorfc.dill
is in your businessobjects_root/win32_x86 directory.
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Deploying web applications on BEA WebLogic

This section guides you through the process of deploying InfoView on BEA
WebLogic in a Windows environment.

To deploy web applications on BEA WebLogic
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir\de
ployment folder instead of the standalone wdeploy.

1. Ensure that you have deployed the SAP Java Connector as described in
SAP Java Connector.

2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file.
See SAP Java Connector for details.

3. Start the WebLogic Admin server. To start the admin server, open a
console window, navigate to the WebLogic
installdir\user_projects\domains\mydomain directory, then
execute startWebLogic.cmd.

Tip:
To start the Admin server a different way, you can go to Start > Programs
>BeaWebLogic Platform >User Projects >MyDomain >Start Server
.

4. Manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications, using wdeploy found under installdir\deploy
ment.
a. Move to businessobjects_root\BusinessObjects12.0\ja

va\applications\, and use the following command to package
the WAR files:

"businessobjects_root\javasdk\bin\jar.exe" cf CmcApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\CmcApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf SAP.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\SAP" .
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"businessobjects_root\javasdk\bin\jar.exe" cf InfoViewApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\InfoViewApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf OpenDocument.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\OpenDocument" .

"businessobjects_root\javasdk\bin\jar.exe" cf dswsbobje.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\dswsbobje" .

"businessobjects_root\javasdk\bin\jar.exe" cf
PartnerPlatformService.war -C "businessobjects_root\ BusinessObjects
Enterprise 12.0\warfiles\WebApps\PartnerPlatformService" .

b. Open config.WAS_Type file (for example, config.weblogic9)
located under installdir\deployment , set the parameters
appropriate for your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.

c. Move to installdir\deployment folder, and use the following
command to redeploy related BusinessObjects Enterprise web
applications:

wdeploy.bat weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.bat weblogic9 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
wdeploy.bat weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> undeploy
wdeploy.bat weblogic9 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> deploy
wdeploy.bat weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
wdeploy.bat weblogic9 -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
wdeploy.bat weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> undeploy
wdeploy.bat weblogic9 -DAPP=dswsbobje -Das_ad
min_password=<your password here> deploy
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d. Use the following command to deploy SAP web applications:

wdeploy.bat weblogic9 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
wdeploy.bat weblogic9 -DAPP=PartnerPlatformService
-Das_admin_password=<your password here> deploy

5. To test that BusinessObjects Enterprise deploys correctly, open a web
browser and type http://servername:7001/InfoViewApp in its address
bar.

6. To test that the SAP authentication module is now available, open a web
browser and type http://servername:7001/CmcApp in its address
bar to launch the Central Management Console (CMC).

7. Log on to the CMC using your Administrator account and password.
The password is set when you first install BusinessObjects Enterprise.

8. Select Authenticationand then double-click SAP.
The SAP authentication page should appear. If it does not, ensure that
the librfccm32.dll is in your C:\WINDOWSWNNT\system32 directory,
and the sapjcorfc.dill is in your businessob
jects_root/win32_x86

Note:
For 64-bit installations, ensure the librfc32.dll libraries are in your
directory C:\Windows\sysWow64 directory, and the sapjcorfc.dill
is in your businessobjects_root/win32_x86 directory.

Deploying web applications on IBM WebSphere

This section guides you through the process of deploying InfoView on
WebSphere in Windows environment.

To deploy web applications on IBM WebSphere
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir\de
ployment folder instead of the standalone wdeploy.

1. Ensure that you have deployed the SAP Java Connector as described in
SAP Java Connector.
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2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file.
See SAP Java Connector for details.

3. Manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications using wdeploy found under INSTALLDIR\deploy
ment.
a. Move to businessobjects_root\BusinessObjects12.0\ja

va\applications\, and use the following command to package
the WAR files:

"businessobjects_root\javasdk\bin\jar.exe" cf CmcApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\CmcApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf SAP.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\SAP" .

"businessobjects_root\javasdk\bin\jar.exe" cf InfoViewApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\InfoViewApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf OpenDocument.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\OpenDocument" .

"businessobjects_root\javasdk\bin\jar.exe" cf dswsbobje.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\dswsbobje" .

"businessobjects_root\javasdk\bin\jar.exe" cf
PartnerPlatformService.war -C "businessobjects_root\ BusinessObjects
Enterprise 12.0\warfiles\WebApps\PartnerPlatformService" .

b. Open the config.WAS_Type file (for example, config.web
Sphere6) located under installdir\deployment, set the
parameters appropriate for your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.
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c. Navigate to the installdir\deployment folder, and use the
following command to redeploy related BusinessObjects Enterprise
web applications.

wdeploy.bat webSphere6 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.bat webSphere6 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
wdeploy.bat webSphere6 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> undeploy
wdeploy.bat webSphere6 -DAPP=InfoViewApp -Das_ad
min_password=<your password here> deploy
wdeploy.bat webSphere6 -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
wdeploy.bat webSphere6 -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
wdeploy.bat webSphere6 -DAPP=dswsbobje -Das_ad
min_password=<your password here> undeploy
wdeploy.bat webSphere6 -DAPP=dswsbobje -Das_ad
min_password=<your password here> deploy

d. Use the following command to deploy SAP web applications.

wdeploy.bat webSphere6 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
wdeploy.bat webSphere6 -DAPP=PartnerPlatformService
-Das_admin_password=<your password here> deploy

4. To test that the SAP authentication module is now available, open a web
browser and type http://servername:9080/CmcApp in its address bar to
launch the Central Management Console (CMC).

5. Log on to the CMC using your Administrator account and password.
The password is set when you first install BusinessObjects Enterprise.

6. Click Authentication, and then double-click SAP.
The SAP authentication page should appear. If it does not, ensure that
the librfccm32.dll is in your C:\WINDOWSWNNT\system32 directory,
and the sapjcorfc.dill is in your businessob
jects_root/win32_x86

Note:
For 64-bit installations, ensure the librfc32.dll libraries are in your
directory C:\Windows\sysWow64 directory, and the sapjcorfc.dill
is in your businessobjects_root/win32_x86 directory.
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Deploying web applications on SAP Web Application Server

This section guides you through the process of deploying InfoView on SAP
Web Application Server in a Windows environment.

To deploy web applications on SAP Web Application Server
To deploy BusinessObjects Integration for SAP Solutions web applications
after installation, you must use the wdeploy found in the installdir\de
ployment folder instead of the standalone wdeploy.

1. Ensure that you have deployed the SAP Java Connector as described in
SAP Java Connector.

2. Ensure that your CLASSPATH environment variable includes the sapj
co.jar archive file.
See SAP Java Connector for details.

3. Manually deploy the BusinessObjects XI Integration Solutions for SAP
web applications using wdeploy found under INSTALLDIR\deploy
ment.
a. Move to businessobjects_root\BusinessObjects12.0\ja

va\applications\, and use the following command to package
the WAR files:

"businessobjects_root\javasdk\bin\jar.exe" cf CmcApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\CmcApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf SAP.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\SAP" .

"businessobjects_root\javasdk\bin\jar.exe" cf InfoViewApp.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\InfoViewApp" .

"businessobjects_root\javasdk\bin\jar.exe" cf OpenDocument.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\OpenDocument" .

"businessobjects_root\javasdk\bin\jar.exe" cf dswsbobje.war -C
"businessobjects_root\BusinessObjects Enterprise
12.0\warfiles\WebApps\dswsbobje" .
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"businessobjects_root\javasdk\bin\jar.exe" cf
PartnerPlatformService.war -C "businessobjects_root\ BusinessObjects
Enterprise 12.0\warfiles\WebApps\PartnerPlatformService" .

b. Open the config.WAS_Type file (for example, config.nw2004)
located under installdir\deployment, set the parameters
appropriate for your environment, and save the file.
For more information about config file parameters, see the “Deploying
applications after installation” chapter of the Web Applications
Deployment Guide.

c. Navigate to the installdir\deployment folder, and use the
following command to redeploy related BusinessObjects Enterprise
web applications.

wdeploy.bat nw2004 -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.bat nw2004 -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
wdeploy.bat nw2004 -DAPP=InfoViewApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.bat nw2004 -DAPP=InfoViewApp -Das_admin_pass
word=<your password here> deploy
wdeploy.bat nw2004 -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
wdeploy.bat nw2004 -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
wdeploy.bat nw2004 -DAPP=dswsbobje -Das_admin_pass
word=<your password here> undeploy
wdeploy.bat nw2004 -DAPP=dswsbobje -Das_admin_pass
word=<your password here> deploy

d. Use the following command to deploy SAP web applications.

wdeploy.bat nw2004 -DAPP=SAP -Das_admin_pass
word=<your password here> deploy
wdeploy.bat nw2004 -DAPP=PartnerPlatformService -
Das_admin_password=<your password here> deploy

4. To test that the SAP authentication module is now available, open a web
browser and type http://servername:9080/CmcApp in its address bar to
launch the Central Management Console (CMC).

5. Log on to the CMC using your Administrator account and password.
The password is set when you first install BusinessObjects Enterprise.

56 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Installing BusinessObjects XI Integration for SAP Solutions3 Installing on Windows



6. Click Authentication, and then double-click SAP.
The SAP authentication page should appear. If it does not, ensure that
the librfccm32.dll is in your C:\WINDOWSWNNT\system32 directory,
and the sapjcorfc.dill is in your businessob
jects_root/win32_x86

Note:
For 64-bit installations, ensure the librfc32.dll libraries are in your
directory C:\Windows\sysWow64 directory, and the sapjcorfc.dill
is in your businessobjects_root/win32_x86 directory.

Distributed installation
The BusinessObjects Enterprise architecture is scalable in that it allows for
a multitude of server configurations, ranging from stand-alone, single-machine
environments, to large-scale deployments supporting global organizations.
The flexibility offered by the product's architecture allows you to set up a
system that suits your current reporting requirements, without limiting the
possibilities for future growth and expansion.

Note:
This section provides details that are specific to BusinessObjects XI
Integration for SAP Solutions. For general information about distributing the
BusinessObjects Enterprise components, see the “Scaling Your System”
section of the SAP BusinessObjects Enterprise Administrator's Guide .

Installing components onBusinessObjects Enterprise
machines

If you have a distributed installation of BusinessObjects Enterprise, install
the listed BusinessObjects XI Integration for SAP Solutions components on
the appropriate machines.

If you select a default server installation of BusinessObjects XI Integration
for SAP Solutions, the setup program detects which elements of
BusinessObjects Enterprise are present, and installs the appropriate
BusinessObjects XI Integration for SAP Solutions components.
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BusinessObjects Enterprise ma-
chinesComponents

• Crystal Reports Processing Server
• Report Job Server
• Report Application Server (RAS)

Data Access

• Crystal Reports Processing Server
• Report Job Server
• RAS
• BusinessObjects Enterprise SDK

BW Publisher (installed as a service
on one or more of these machines,
or with a local SAP Gateway)

• Central Management Server
• All machines that have the Busines-

sObjects Enterprise SDK installed.
Security

• BusinessObjects Enterprise Java
SDKWeb Content

Separating BusinessObjects Enterprise from your
web server

The SAP BusinessObjects Enterprise Installation Guide available online
explains how to connect BusinessObjects Enterprise to a web server or Java
application server that is running on a different machine.

If you set up your system in this manner, you will need to install the Web
Content feature from the BusinessObjects XI Integration for SAP Solutions
installation disc onto the server that is connected to BusinessObjects
Enterprise. This feature includes the files that make up the BusinessObjects
XI Integration for SAP Solutions web application.
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Distributing the BW Publisher installation

This section explains the distribution of BW Publisher service and how to
separate the BW Publisher from other BusinessObjects Enterprise
components.

BW Publisher Service

You can load-balance publishing from BW by installing BW Publisher services
on two separate machines in the same BusinessObjects Enterprise system.

When you install the BW Publisher on the BusinessObjects Enterprise
machines, configure each one to use the same Program ID and SAP Gateway
Host and Gateway Service. After you create an RFC destination that uses
this Program ID, BW load-balances publishing between the BusinessObjects
Enterprise machines. Moreover, if one BW Publisher becomes unavailable,
BW continues to use the remaining BW Publisher.

You can add an additional level of system redundancy to any configuration
that includes multiple BW application servers. Configure each BW application
server to run an SAP Gateway. For each one, install a separate BW Publisher
service on a BusinessObjects Enterprise machine. Configure each BW
Publisher service to use the Gateway Host and Gateway service of a separate
BW application server. In this configuration, publishing from BW can continue
if either a BW Publisher or an application server fails.
Related Topics
• To start the BW Publisher

BW Publisher on a stand-alone SAP Gateway

If you want to separate the BW Publisher from other BusinessObjects
Enterprise components, install the BW using a stand-alone SAP Gateway.

In this case you must install a local SAP Gateway on the same machine as
the BW Publisher. In addition, the BW Publisher requires access to the
BusinessObjects Enterprise Software Development Kit (SDK) and the Crystal
Reports Print Engine. Thus, if you install the BW Publisher and the local SAP
Gateway on a dedicated machine, you must also install the SIA Server.
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Related Topics
• Selecting your BW Publisher configuration
• Publishing from BW to BusinessObjects Enterprise

Adding servers to BusinessObjects Enterprise

If you expand your BusinessObjects Enterprise system after installing
BusinessObjects XI Integration for SAP Solutions.
Related Topics
• Installing components on BusinessObjects Enterprise machines

Uninstalling BusinessObjects XI
Integration for SAP Solutions

This section describes uninstalling BusinessObjects XI Integration for SAP
Solutions.

Note:

If you have installed multiple SAP solutions on the same Crystal Reports or
BusinessObjects Enterprise server, and you want to uninstall them, then you
must uninstall the SAP Solutions in the reverse order in which they were
installed. Therefore, you must always uninstall the most recently installed
SAP Solution first.

To uninstall BusinessObjects XI Integration for SAP
Solutions

If you want to delete users and groups that were imported from SAP through
the Central Management Console (CMC) and the SAP authentication plug-in,
you must remove the users and groups before you uninstall BusinessObjects
XI Integration for SAP Solutions. You cannot delete SAP users from
BusinessObjects Enterprise without BusinessObjects XI Integration for SAP
Solutions.
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1. Uninstall BusinessObjects XI Integration for SAP Solutions.
• On a Windows computer, uninstall the BusinessObjects XI Integration

for SAP from Add/Remove Programs.
• On a UNIX computer, run the AddOrRemoveProducts.sh command.

2. Run the partnercafuninstall.bat or partnercafuninstall.sh
script, depending on your platform. You must provide the password for
the BusinessObjects Enterprise administrator.
• On Windows, run partnercafuninstall.bat-p BOE_PASSWORD.
• On UNIX, run partnercafuninstall.sh-p BOE_PASSWORD.
After the script finishes, you must also clean up the remaining SAP files.

3. In theinstalldir\deployment\apps folder, deleteSAP.properties
and PartnerPlatformServices.properties.

4. Undeploy and redeploy BusinessObjects Enterprise web applications
using wdeploy from the install\deployment folder and the following
commands:

wdeploy.sh <WAS type> -DAPP=CmcApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.sh <WAS type> -DAPP=CmcApp -Das_admin_pass
word=<your password here> deploy
wdeploy.sh <WAS type> -DAPP=InfoViewApp -Das_admin_pass
word=<your password here> undeploy
wdeploy.sh <WAS type> -DAPP=InfoViewApp -Das_admin_pass
word=<your password here> deploy
wdeploy.sh <WAS type> -DAPP=OpenDocument -Das_ad
min_password=<your password here> undeploy
wdeploy.sh <WAS type> -DAPP=OpenDocument -Das_ad
min_password=<your password here> deploy
wdeploy.sh <WAS type> -DAPP=dswsbobje -Das_admin_pass
word=<your password here> undeploy
wdeploy.sh <WAS type> -DAPP=dswsbobje -Das_admin_pass
word=<your password here> deploy
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Configuring SAP
authentication

4



This section explains how to configure BusinessObjects Enterprise
authentication for your SAP environment.

Accessing the SAP authentication application

After installing SAP Authentication, you must provide BusinessObjects
Enterprise with information about your SAP system. BusinessObjects XI
Integration for SAP Solutions installs a web application to assist you. This
web application is accessible through the main BusinessObjects Enterprise
administration tool, the Central Management Console (CMC). To access it
from the home page of the CMC, click Authentication.
Related Topics
• Authenticating SAP users
• Configuring SAP authentication for BusinessObjects Enterprise

Configuration overview
Once you have updated BusinessObjects Enterprise with BusinessObjects
XI Integration for SAP Solutions, you must configure your SAP system and
BusinessObjects Enterprise. These steps must be performed for BW, R/3,
and mySAP ERP systems:

• Configuring transports
• Creating and applying authorizations
• Configuring SAP authentication for BusinessObjects Enterprise
• Configuring SAP for server-side trust
• Configuring BusinessObjects Enterprise for server-side trust
• Configuring Data Access

After you have completed these steps on an R/3 or mySAP ERP system,
configuration is complete. You can begin using BusinessObjects XI Integration
for SAP Solutions.

For BW systems, additional configuration is required to enable report viewing
and report publishing. After completing these steps, go on to Configuring the
BW Publisher.
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Configuring SAP authentication for
BusinessObjects Enterprise

SAP authentication enables SAP users to log on to BusinessObjects
Enterprise using their SAP user names and passwords, without storing these
passwords in BusinessObjects Enterprise. SAP authentication also allows
you to preserve information about user roles in SAP, and to use this role
information within BusinessObjects Enterprise to assign rights to perform
administrative tasks, or access content.
Related Topics
• Authenticating SAP users

Creating a user account for BusinessObjects
Enterprise

The BusinessObjects Enterprise system requires an SAP user account that
is authorized to access SAP role membership lists, authenticate SAP users,
and so on. You will need this user name and its password when you connect
BusinessObjects Enterprise to your SAP system. For general instruction on
creating SAP user accounts and assigning authorizations through roles, see
your SAP documentation.

Use transaction SU01 to create a new SAP user account named CRYSTAL.
Use transaction PFCG to create a new role named CRYSTAL_ENTITLEMENT.
(These names are recommended but not required.) Change the new role's
authorization data by setting these values for the following authorization
objects:
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ValueFieldAuthorization object

Read, Write (33, 34)Activity (ACTVT)

Authorization for file ac-
cess (S_DATASET)

* (denotes All)Physical file name
(FILENAME)

*ABAP program name
(PROGRAM)

16Activity (ACTVT)

Authorization Check for
RFC Access (S_RFC)

BDCH, BDL5, STPA,
SUSO, SUUS, SU_US-
ER, SYST, SUNI,
PRGN_J2EE, /CRYS-
TAL/SECURITY

Name of RFC to be pro-
tected (RFC_NAME)

Function group (FUGR)
Type of RFC object to
be protected
(RFC_TYPE)

Create or Generate, and
Display (03)Activity (ACTVT)

User Master Mainte-
nance: User Groups
(S_USER_GRP)

*

Note:
For greater security, you
may prefer to explicitly list
the user groups whose
members require access
to BusinessObjects Enter-
prise.

User group in user
master maintenance
(CLASS)
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Finally, add the CRYSTAL user to the CRYSTAL_ENTITLEMENT role.

Tip:
If your system policies require users to change their passwords when they
first log on to the system, log on now with the CRYSTAL user account and
reset its password.

Connecting to SAP entitlement systems

Before you can import roles or publish BW content to BusinessObjects
Enterprise, you must provide information about the SAP entitlement systems
that you want to integrate with BusinessObjects Enterprise. BusinessObjects
Enterprise uses this information to connect to SAP when it determines role
memberships and authenticates SAP users.

To add anSAP entitlement system toBusinessObjects Enterprise

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link.

The entitlement systems settings appear.

Tip:
If an entitlement system is already displayed in the Logical system name
list, click New.

3. In the System field, type the three-character System ID (SID) of your
SAP system.

4. In the Client field, type the client number that BusinessObjects Enterprise
must use when it logs on to your SAP system.
BusinessObjects Enterprise combines your System and Client information,
and adds an entry to the Logical system name list

5. Ensure the Disabled check box is clear.

Note:
Use the Disabled check box to indicate to BusinessObjects Enterprise
that a particular SAP system is temporarily unavailable.
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6. Complete the Message Server and Logon Group fields as appropriate,
if you have set up load balancing such that BusinessObjects Enterprise
must log on through a message server.

Note:
You must make the appropriate entries in the Services file on your
BusinessObjects Enterprise machine to enable load balancing - especially
if your deployment not on a single machine. Specifically you should
account for the machines hosting the CMS, the Web application server,
as well as all machines managing your authentication accounts and
settings.

7. If you have not set up load balancing (or if you prefer to have
BusinessObjects Enterprise log on directly to the SAP system), complete
the Application Server and System Number fields as appropriate.

8. In the Username, Password, and Language fields, type the user name,
password, and language code for the SAP account that you want
BusinessObjects Enterprise to use when it logs on to SAP.

Note:
These credentials must correspond to the user account that you created
for BusinessObjects Enterprise. For details, see Creating a user account
for BusinessObjects Enterprise.

9. Click Update.
10. On the Options tab, ensure that the Enable SAP Authentication check

box is selected.

If you add multiple entitlement systems, click the Options tab to specify the
system that BusinessObjects Enterprise uses as the default (that is, the
system that is contacted to authenticate users who attempt to log on with
SAP credentials but without specifying a particular SAP system).

To verify if your entitlement system was added correctly

1. Click the Role Import tab.
2. Select the name of the entitlement system from the Logical system name

list.

If the entitlement system was added correctly, the Available roles list
will contain a list of roles that you can choose to import.
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Tip:
If no roles are visible in the Logical system name list, look for error
messages on the page. These may give you the information you need to
correct the problem.

Setting SAP Authentication options

SAP Authentication includes a number of options that you can customize
when integrating BusinessObjects Enterprise with your SAP systems. For
instance, you can enable/disable SAP Authentication or configure
BusinessObjects Enterprise to temporarily disable SAP Authentication for
SAP systems when they become unavailable.

To set SAP Authentication options

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link and then click the Options tab.
3. Review and modify settings as required.
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DescriptionSetting

Clear this check box if you want to disable SAP
Authentication completely. (To disable SAP Au-
thentication for a specific SAP System, select
that system'sDisabled check box on the Entitle-
ment Systems tab.)

Enable SAPAuthentica-
tion

In this list, select the SAP entitlement system that
BusinessObjects Enterprise uses as the default
(that is, the system that is contacted to authenti-
cate users who attempt to log on with SAP cre-
dentials but without specifying a particular SAP
system). If this list is empty, see To add an SAP
entitlement system to BusinessObjects Enter-
prise.

Note:
If you designate a default system, users from that
system do not have to enter their System ID and
client when they connect from client tools like
Live Office or Universe Designer using SAP au-
thentication. For example, if SYS~100 is set as
the default system, SYS~100/user1 would be
able to log on as user1 when SAP authentication
is chosen.

Default system

Type the number of times that BusinessObjects
Enterprise should re-attempt contacting an SAP
system to fulfill authentication requests. Setting
the value to -1 allows BusinessObjects Enterprise
to attempt to contact the entitlement system an
unlimited number of times. Setting the value to
0 limits BusinessObjects Enterprise to making
one attempt to contact the entitlement system.

Note:
Use this setting together with Keep entitlement
system disabled [seconds] to configure how
BusinessObjects Enterprise handles SAP entitle-
ment systems that are temporarily unavailable.
BusinessObjects Enterprise uses these settings
to determine when to stop communicating with
an SAP system that is unavailable, and when it
should resume communication with that system.

Max failed entitlement
system accesses
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DescriptionSetting

Keep entitlement sys-
tem disabled [seconds]

Type the number of seconds that BusinessOb-
jects Enterprise should wait before resuming at-
tempts to authenticate users against the SAP
system. For example, if you type 3 forMax failed
entitlement system accesses, BusinessObjects
Enterprise allows a maximum of 3 failed attempts
to authenticate users against any particular SAP
system; the fourth failed attempt results in Busi-
nessObjects Enterprise ceasing its attempts to
authenticate users against that system for the
amount of time specified by Keep entitlement
system disabled [seconds].

Use this field to specify how many connections
you want to keep open to your SAP system at
the same time. For example, if you type 2 in this
field, BusinessObjects Enterprise keeps two
separate connections open to SAP.

Maxconcurrent connec-
tions per system

Use this field to specify how many operations
you want to allow to the SAP system per connec-
tion. For example, if you specified 2 for Max
concurrent connections per system and 3 for
Number of uses per connection, once there
has been 3 logons on one connection, Busines-
sObjects Enterprise will close that connection
and restart it.

Number of uses per
connection

Clear this check box if you want to disable SAP
Authentication completely. (To disable SAP Au-
thentication for specific SAP Systems, select that
system'sDisabled check box on theEntitlement
Systems tab.)

Enable SAPAuthentica-
tion

Select this check box if you want BusinessOb-
jects Enterprise to create user accounts and user
folders for all role members when you actually
import the roles. Clear the check box to have
BusinessObjects Enterprise create user accounts
and user folders dynamically, when users log on
for the first time with valid SAP credentials. For
details see Importing SAP roles to BusinessOb-
jects Enterprise.

Automatically import
users
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DescriptionSetting

Use these options to specify if new user accounts
are configured to use concurrent user licenses
or named user licenses. Concurrent licenses
specify the number of people who can connect
to BusinessObjects Enterprise at the same time.
This type of licensing is very flexible because a
small number of concurrent licenses can support
a large user base. For example, depending on
how often and how long users access Busines-
sObjects Enterprise, a 100 user concurrent li-
cense could support 250, 500, or 700 users.
Named user licenses are associated with specific
users and allow people to access the system
based on their user name and password. This
provides named users with access to the system
regardless of how many other people are con-
nected.

Note:
The option you select here does not change the
number or type of user licenses that you have
installed in BusinessObjects Enterprise. You
must have the appropriate licenses available on
your system.

Concurrent users and
Named Users

Select this check box if you want to synchronize
SAP user account information when you click
Update on the Role Import tab.

Force user synchroniza-
tion

Use this field to specify where you want Busines-
sObjects Enterprise to begin replicating the BW
folder structure in the CMC and InfoView. The
default is /SAP/2.0 but you can change it to a
different folder if you want. To change this value,
you must change it both in the CMC and the
Content Administration Workbench. For details,
see To change the Content folder root.

Content folder root

4. Click Update.
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To change the Content folder root

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link.
3. Click Options and type the name of the folder in Content folder root

field.
The folder name that you type here is the folder that you want
BusinessObjects Enterprise to begin replicating the BW folder structure
from.

4. Click Update.
5. In the BW Content Administration Workbench, expandEnterprise system.
6. Expand Available systems and double-click the system that your

BusinessObjects Enterprise is connecting to.
7. Click the Layout tab and in the Content base folder, type the folder that

you want to use as the root SAP folder in BusinessObjects Enterprise
(for example, /SAP/2.0/).

Importing SAP roles to BusinessObjects Enterprise

By importing SAP roles into BusinessObjects Enterprise, you allow role
members to log on to BusinessObjects Enterprise with their usual SAP
credentials. In addition, Single Sign On (SSO) is enabled so that SAP users
are logged on to BusinessObjects Enterprise automatically when they access
reports from within the SAP GUI or an SAP Enterprise Portal.

Note:
There are often many requirements for enabling SSO. Some of these might
include using a driver and application that are SSO-capable, and ensuring
your server and web server are in the same domain. For more information
about configuring your system for SSO, refer to the appropriate security
documents in SAP and BusinessObjects Enterprise.

For each role that you import, BusinessObjects Enterprise generates a group.
Each group is named with the following convention: SystemID~ClientNum
ber@NameOfRole . You can view the new groups in the "Users and Groups"
management area of the CMC. You can also use these groups to define
object security within "BusinessObjects Enterprise". For details, see the
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“Setting Rights” chapter in the SAP BusinessObjects Enterprise
Administrator's Guide.

Consider three main categories of users when configuring BusinessObjects
Enterprise for publishing, and when importing roles to BusinessObjects
Enterprise:

• BusinessObjects Enterprise administrators

Enterprise administrators configure the BusinessObjects Enterprise system
for publishing content from SAP. They import the appropriate roles, create
necessary folders, and assign rights to those roles and folders in
BusinessObjects Enterprise.

• Content publishers

Content publishers are those users who have rights to publish content
into roles. The purpose of this category of user is to separate regular role
members from those users with rights to publish reports.

• Role members

Role members are users who belong to “content bearing” roles. That is,
these users belong to roles to which reports are published. They have
View, View on Demand, and Schedule rights for any reports published
to the roles they are members of. However, regular role members cannot
publish new content, nor can they publish updated versions of content.

You must import all content publishing and all content bearing roles to
BusinessObjects Enterprise prior to publishing for the first time.

Note:
It is strongly recommended that you keep the activities of roles distinct. For
example, while it is possible to publish from an administrator role, it is better
practice to publish only from content publisher roles. Additionally, the function
of content publishing roles is only to define which users can publish content.
Thus, content publishing roles should not contain any content; content
publishers should publish to content bearing roles that are accessible to
regular role members.

To import a role to BusinessObjects Enterprise

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link.
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3. On the Options tab, select or clear the Automatically import users
check box, depending on how you want BusinessObjects Enterprise to
handle user accounts when you import roles.
• Select the check box to have BusinessObjects Enterprise create a

user account and a user folder immediately for each member of the
role(s) that you import

When you later add members to a role within SAP, BusinessObjects
Enterprise dynamically creates additional user accounts and user
folders when new role members first log on to BusinessObjects
Enterprise with valid SAP credentials.

• Clear the check box to have BusinessObjects Enterprise import roles
without immediately creating user accounts and user folders.

BusinessObjects Enterprise dynamically creates new user accounts
and user folders when role members first log on to BusinessObjects
Enterprise with valid SAP credentials.

Once user accounts and user folders are created, you can subsequently
view them in the "Users and Groups" and "Folders" management areas
of the CMC.

4. On the Options tab, select either Concurrent users or Named users
depending on your licenses.
Note that the option you select here does not change the number or type
of user licenses that you have installed in BusinessObjects Enterprise.
You must have the appropriate licenses available on your system.

5. Click Update.
6. On the Role import tab, select the appropriate entitlement system from

the Logical system name list.

Note:
If this list is empty, see Connecting to SAP entitlement systems.

7. In the Available roles area, select the role(s) that you want to import,
and then click Add.

8. Click Update.

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 75

4Configuring SAP authentication
Configuring SAP authentication for BusinessObjects Enterprise



To check that roles and users were imported correctly

1. Ensure that you know the user name and password of an SAP user who
belongs to one of the roles that you just mapped to BusinessObjects
Enterprise.

2. For Java InfoView go to http://webserver:portnumber /InfoViewApp/
. For .NET InfoView go to http://webserver/InfoViewApp/.
Replace webserver with the name of the web server and portnumber
with the port number that is set up for BusinessObjects Enterprise. You
may need to ask your administrator for the name of the web server, the
port number, or the exact URL to enter.

3. From the Authentication Type list, select SAP.
4. Type the SAP system and system client that you want to log on to.
5. Type the user name and password of a mapped user.
6. Click Log On.

You should be logged on to InfoView as the selected user.

Configuring Data Access
This section guides you through the process of configuring data access.

Configuring SAP Logon for the Data Access

When users report off of data in SAP tables using Crystal Reports and the
Data Access, they are first prompted to select their SAP system from the
Available SAP Systems list. The Data Access retrieves this list of available
systems from the saplogon.ini file in the Windows directory on that user's
computer.

If users have the SAP GUI installed, adding a new SAP system to their SAP
GUI logon adds information about this system to their saplogon.ini file.
After the new SAP system is added, it becomes available via the Data Access
(provided they are authorized to use the system). Alternately, you may
configure and distribute SAPlogon.ini using your standard procedures.
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You can also add the full path to the saplogon.ini file to the SAPLO
GON_INI_FILE environment variable.

Consult your SAP documentation for details.
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Configuring SAP
Server-Side Trust

5



SAP Server-Side Trust Overview
This section provides procedures for configuring server-side trust between
SAP Web Application Servers (version 6.20 and up) and BusinessObjects
Enterprise. You need to set up server-side trust if you are using multi-pass
report bursting (for publications where the report query depends on the
context of the user).

Server-side trust involves password-less impersonation. To impersonate an
SAP user without providing a password, a user must be identified with SAP
using a more secure method than a regular username and password. (An
SAP user with the SAP_ALL authorization profile cannot impersonate another
SAP user without knowing that user's password.)

Enabling server-side trust using the free SAP crypto library

To enable server-side trust for BusinessObjects Enterprise using the free
SAP crypto library, you must run the relevant servers under credentials that
are authenticated using a registered Secure Network Communication (SNC)
provider. These credentials are configured within SAP to be allowed to
impersonate without a password. For BusinessObjects Enterprise, you need
to run the servers involved in report-bursting under these SNC credentials,
such as the Crystal Reports Job Server.

You also need an encryption library in order to configure server-side trust.
An SAP Cryptographic Library is available for download from the SAP web
site. Note that the SAP Cryptographic Library can be used only for setting
up server-side trust. The Cryptographic Library is available for Windows and
UNIX. For more information about the Cryptographic Library, see SAP notes
711093, 597059 and 397175 on the SAP web site.

The SAP server and BusinessObjects Enterprise need to be assigned
certificates that prove their identities to each other. Each server will have its
own certificate and a list of certificates for trusted parties. To configure
server-side trust between SAP and BusinessObjects Enterprise, you need
to create a password-protected set of certificates called a Personal Security
Environment (PSE). This document describes how to set up and maintain
the PSEs, and how to securely associate them with BusinessObjects
Enterprise processing servers.
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Client versus server SNC

In client SNC, an SNC name identifier is mapped to one (or more) SAP user
names in SU01. When a logon request is sent, the SNC name together with
the SAP name is passed to the SAP system, however no password is sent.
Provided the SNC name maps to the specified SAP name, the logon is
permitted. A client-side logon string for a direct application host logon is
shown below:

ASHOST =myserver.mydomain SYSNR=37 CLIENT=066 LANG=EN
USER=USER123
SNC_MODE=1 SNC_QOP=9 SNC_LIB="/usr/local/lib/libsapcryp
to.so"
SNC_PARTNERNAME="p:CN=TheServer, OU=Dept., O=TheCompany,
C=FR"
SNC_MYNAME="p:CN=TheUser, O=TheCompany, C=US"

The SAP user USER123 must be mapped to p:CN=TheUser, O=TheCom
pany, C=US in SU01 for this logon attempt to succeed. In server SNC on
the other hand, it is not a requirement to explicitly map between the SNC
name identifier and SAP user name. Instead, the SNC name is configured
in transaction SNC0 to be allowed to perform an impersonation-style logon
for “any” user without having to provide this users' password. For example:

ASHOST =myserver.mydomain SYSNR=37 CLIENT=066 LANG=EN
SNC_MODE=1
SNC_QOP=9 SNC_LIB="/usr/local/lib/libsapcrypto.so"
SNC_PARTNERNAME="p:CN=TheServer, OU=Dept., O=TheCompany,
C=FR"
SNC_MYNAME="p:CN=TheUser, O=TheCompany, C=US" EXTID
TYPE=UN EXTIDDATA=USER123

The server SNC impersonation logon, or logon via external ID is much more
powerful than its client counterpart. This logon enables access to any SAP
user account in the system. Other External ID logon options include Logon
Tickets and X.509 client certificates.

BusinessObjects Enterprise server responsibilities

Specific BusinessObjects Enterprise servers are relevant to the SAP
integration in terms of single sign-on (SSO). The following table lists these
servers, the type of SNC they require for particular areas of responsibility.
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Areas of responsibilitySNC typeServer

SAP Authentication role listclientWeb Application Server

Crystal Reports Dynamic Parameter
pick lists and personalization

server

Password, ticket, checking role
membership, and user lists

clientCMS

Crystal Reports view on demandserverPage Server

Scheduling Crystal ReportsserverJob Server

Viewing and scheduling WeBI reports
and List of Values (LOV) prompts

serverWeBI Processing Server

AnalysisserverMultidimensional Analysis
Service Server (Voyager)

Note:
The Web Application Server and the CMS use client-SNC and thus require
an explicit mapping of the SNC name to SAP user name. This is specified
in either transaction SU01 or SM30 for table USRACL.

For options on using server groups to manage servers running under distinct
credentials see Using server groups.

Configuring SAP for server-side trust
The following step procedure describes how to set up SNC for use with
BusinessObjects Enterprise. Please note that you should consult the SAP
documentation provided with your SAP server for more information or
troubleshooting assistance.

After you complete the steps for configuring SAP for server-side trust, proceed
to Configuring BusinessObjects Enterprise for server-side trust.

To configure SAP for server-side trust

1. From the SAP marketplace, download the SAP Cryptographic Library for
all relevant platforms.
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Note:
For more information about the Cryptographic Library, see SAP notes
711093, 597059 and 397175 on the SAP web site.

2. Ensure that you have SAP administrator's credentials for within SAP and
for the machine running SAP, and administrator's credentials for
BusinessObjects Enterprise and the machine (or machines) it is running
on.

3. On the SAP machine, copy the SAP Cryptographic Library and the
SAPGENPSE tool to <DRIVE>:\usr\sap\<SID>\SYS\exe\run\
directory (on Windows).

4. Locate the file named "ticket" that was installed with the SAP
Cryptographic Library, and copy it to the
<DRIVE>:\usr\sap\<SID>\<instance>\sec\ directory (on
Windows).

5. Create an environment variable named SECUDIR that points to the
directory where the ticket resides.

Note:
This variable must be accessible to the user under which SAP's disp+work
process runs.

6. In the SAP GUI, go to transaction RZ10 and change the instance profile
in Extended maintenance mode.
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7. In profile edit mode, point SAP profile variables to the Cryptographic
Library and give the SAP system a Distinguished Name (DN). These
variables should follow the LDAP naming convention:

DescriptionMeaningTag

The everyday name of the certificate propri-
etor.

Common
Name

CN

PG for Product Group, for example.Organization-
al Unit

OU

The name of the organization for which the
certificate was issued.

OrganizationO

The country where the organization is locat-
ed.

CountryC

For example, for R21: p:CN=R21, OU=PG, O=BOBJ, C=CA

Note:
Note that the prefix p: is for the SAP Cryptographic Library. It is required
when referring to the DN within SAP, but will not be visible when examining
certificates in STRUST or using SAPGENPSE.

8. Enter the following profile values, substituting for your SAP system where
necessary:
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ValueProfile variable

SAPSECULIBssf/name

Full path to sapcrypto libssf/ssfapi_lib

Full path to sapcrypto libsec/libsapsecu

Full path to sapcrypto libsnc/gssapi_lib

Your SAP system's DNsnc/identity/as

For example:

9. Restart your SAP instance.
10. When the system is running again, log on and go to transaction STRUST,

which should now have additional entries for SNC and SSL.
11. Right-click the SNC node and click Create.

The identity you specified in RZ10 should now appear.

12. Click OK.
13. To assign a password to the SNC PSE, click the lock icon.
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Note:
Do not lose this password. You will be prompted for it by STRUST every
time you view or edit the SNC PSE.

14. Save the changes.

Note:
If you do not save your changes, the application server will not start again
when you enable SNC.

15. Return to transaction RZ10 and add the remainder of the SNC profile
parameters:

ParameterProfile variable

1snc/accept_insecure_rfc

1snc/accept_insecure_r3int_rfc

1snc/accept_insecure_gui

1snc/accept_insecure_cpic

1snc/permit_insecure_start

1snc/data_protection/min

3snc/data_protection/max

1snc/enable

The minimum protection level is set to authentication only (1) and the
maximum is privacy (3). The snc/data_protection/use value defines that
only authentication is to be used in this case, but could also be (2) for
integrity, (3) for privacy and (9) for maximum available. The snc/accept_in
secure_rfc, snc/accept_insecure_r3int_rfc, snc/accept_insecure_gui, and
snc/accept_insecure_cpic values set to (1) ensure that previous (and
potential unsecure) communication methods are still permitted.
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16. Restart your SAP system.

You must now configure BusinessObjects Enteprise for server-side trust.
Related Topics
• Configuring BusinessObjects Enterprise for server-side trust

Configuring BusinessObjects Enterprise
for server-side trust

The following procedures need to be performed in order to configure
BusinessObjects Enterprise for server-side trust. Note that these steps are
Windows-based, but because the SAP tool is a command line tool, the steps
are very similar on UNIX.

1. To set up the environment
2. To generate a PSE
3. To configure BusinessObjects Enterprise servers
4. To configure PSE access
5. To configure SAP authentication SNC settings
6. Using server groups

To set up the environment

Before you begin, ensure that:

• The SAP Cryptographic Library has been downloaded and expanded on
the host on which BusinessObjects Enterprise processing servers run.

• The appropriate SAP systems have been configured to use SAP
Cryptographic Library as the SNC provider.

For more information, see Configuring SAP for server-side trust.

Before PSE maintenance can begin, you need to set up the library, tool, and
environment where PSEs are stored.

1. Copy the SAP Cryptographic Library (including the PSE maintenance
tool) to a folder on the machine running BusinessObjects Enterprise.
For example: C:\Program Files\SAP\Crypto
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2. Add the folder to the PATH environment variable.
3. Add a system-wide environment variable SNC_LIB that points to the

Cryptographic Library.
For example: C:\Program Files\SAP\Crypto\sapcrypto.dll

4. Create a subfolder named sec.
For example: C:\Program Files\SAP\Crypto\sec

5. Add a system-wide environment variable SECUDIR that points to the sec
folder.

6. Copy the ticket file from the SAP Cryptographic Library into the sec
folder.

To generate a PSE

SAP accepts a BusinessObjects Enterprise server as a trusted entity when
the relevant BusinessObjects Enterprise servers have a PSE and the PSE
is associated with SAP. This “trust” between SAP and BusinessObjects
Enterprise components is established by sharing the public version of each
other's certificates. The first step is to generate a PSE for BusinessObjects
Enterprise that automatically generates its own certificate.

1. Open a command prompt and run sapgenpse.exe gen_pse -v -p BOE.pse
from within the Cryptographic Library folder.

2. Choose a PIN and the DN you want for your BusinessObjects Enterprise
system.
For example, CN=MyBOE01, OU=PG, O=BOBJ, C=CA.
You now have a default PSE, with its own certificate.

3. Use the following command to export the certificate in the PSE:

sapgenpse.exe export_own_cert -v -p BOE.pse -o MyBOECert.crt

4. In the SAP GUI, go to transaction STRUST and open the SNC PSE.
You will be prompted for the password you have already assigned.

5. Import the MyBOECert.crt file created earlier:

88 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Configuring SAP Server-Side Trust5 Configuring BusinessObjects Enterprise for server-side trust



The certificates from SAPGENPSE are Base64-encoded. Make sure you
select Base64 when importing them:

6. To add the BusinessObjects Enterprise certificate to the SAP server's
PSE certificate list, click the Add to certificate list button.

7. To add SAP's certificate to BusinessObjects Enterprise's PSE, double-click
the SAP certificate.

8. Save your changes in STRUST.
9. Click the Export button and provide a file name for the certificate.

For example, MySAPCert.crt.

Note:
The format should remain Base64.

10. Go to transaction SNC0.
11. Add a new entry, where:

• The System ID is arbitrary but reflects your BusinessObjects Enterprise
system.
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• The SNC name should be the DN (prefixed by p:) that you provided
when you created your BusinessObjects Enterprise PSE (in step 2).

• The Entry for RFC activated and Entry for ext. ID activated
checkboxes are both selected:

12. To add the exported certificate to the BusinessObjects Enterprise PSE,
run the following command on the command prompt:

sapgenpse.exe maintain_pk -v -a MySAPCert.crt -p BOE.pse

The SAP Cryptographic Library is installed on the BusinessObjects Enterprise
machine. You have created a PSE that will be used by BusinessObjects
Enterprise servers to identify themselves to SAP servers. SAP and the
BusinessObjects Enterprise PSE have exchanged certificates. SAP permits
entities with access to the BusinessObjects Enterprise PSE to perform RFC
calls and password-less impersonation. Proceed to To configure
BusinessObjects Enterprise servers.
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To configure BusinessObjects Enterprise servers

After you generate a PSE for BusinessObjects Enterprise, you must configure
an appropriate server structure for SAP processing. The following procedure
creates a node for SAP processing servers, so that you can set operating
system credentials on the node level.

Note:
In this version of BusinessObjects Enterprise, servers are no longer
configured in the Central Configuration Manager (CCM). Instead, a new
Server Intelligence Agent (SIA) must be created.

1. In the CCM, create a new node for SAP processing servers.
Give the node an appropriate name such as SAPProcessor. For
information about nodes, see “Adding a node” in theSAPBusinessObjects
Enterprise Administrator's Guide.

2. In the CMC, add the processing servers you need to the new node, then
start the new servers.
For information about adding and starting servers, see the “Managing
and Configuring Servers” chapter of the SAP BusinessObjects Enterprise
Administrator's Guide.

Proceed to To configure PSE access.
Related Topics
• To generate a PSE

To configure PSE access

After you configure the BusinessObjects Enterprise node and servers (see
To configure BusinessObjects Enterprise servers for details), you need to
configure PSE access using the SAPGENPSE tool.

1. Run the following command from the command prompt:

sapgenpse.exe seclogin -p BOE.pse

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 91

5Configuring SAP Server-Side Trust
Configuring BusinessObjects Enterprise for server-side trust



Note:
You will be prompted for the PSE PIN. If you run the tool under the same
credentials used by your BusinessObjects Enterprise SAP processing
servers, you do not need to specify a user name.

2. To verify that the single sign-on (SSO) link is established, list the contents
of the PSE using the following command:

sapgenpse.exe maintain_pk -l

The results should look similar to the following:

C:\Documents and Settings\hareskoug\Desktop\sapcryp
to.x86\ntintel>sapgenpse.exe
maintain_pk -l
maintain_pk for PSE "C:\Documents and Settings\haresk
oug\My Documents\snc\sec\bobjsapproc.pse"
*** Object <PKList> is of the type <PKList_OID> ***

1. --------------------------------------------------
-----------

Version: 0 (X.509v1-1988)
SubjectName: CN=R21Again, OU=PG,

O=BOBJ, C=CA
IssuerName: CN=R21Again, OU=PG,

O=BOBJ, C=CA
SerialNumber: 00
Validity - NotBefore: Wed Nov 28 16:23:53 2007

(071129002353Z)
NotAfter: Thu Dec 31 16:00:01 2037

(380101000001Z)
Public Key Fingerprint: 851C 225D 1789 8974 21DB

9E9B 2AE8 9E9E
SubjectKey: Algorithm RSA (OID

1.2.840.113549.1.1.1), NULL

C:\Documents and Settings\hareskoug\Desktop\sapcryp
to.x86\ntintel>

You should not be prompted again for the PSE PIN after a successful
seclogin command.
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Note:
If you encounter PSE access problems, use the -O to specify PSE access.
For example, to grant PSE access to a specific user in a specific domain,
type:

sapgenpse seclogin -p BOE.pse -O <domain\user>

Proceed to To configure SAP for server-side trust.

To configure SAP authentication SNC settings

After you configure PSE access, you need to configure the SAP authentication
settings in the CMC.

1. Go to the "Authentication" management area of the CMC.
2. Double-click the SAP link.

The entitlement systems settings appear.

3. Click the SNC settings tab on the SAP Authentication page.
4. Select your entitlement system from the Logical system name list.
5. Select Enable Secure Network Communication (SNC) under Basic

Settings.
6. Enter the path for the SNC library settings in SNC library path.

Note:
This step is necessary even though the library is already defined in the
SNC_LIB environment variable.

7. Select a level of protection under Quality of Protection.
For example select Authentication.

Note:
Make sure you do not exceed the level of protection configured on the
SAP system. The level of protection is customizable and is determined
by your organization's needs and the capabilities of their SNC library.

8. Enter the SNC name of the SAP system under Mutual authentication
settings.

The SNC name format depends on the SNC library. Using the SAP
cryptography library, the distinguished name recommendation is that it
follows LDAP naming conventions. It must be have "p:" as its prefix.
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9. Ensure that the SNC name of the credentials under which BusinessObjects
Enterprise servers run appears in the SNC name of Enterprise system
field.

Note:
In scenarios where several SNC names are configured, this field should
be left blank.

10. Provide the DNs of both the SAP system and the BusinessObjects
Enterprise PSE.

Related Topics
• To configure PSE access
• Using server groups

Using server groups

Unless the processing (Crystal Report or Web Intelligence) servers are
running under credentials that have access to the PSE, you must create a
specific server group containing only these servers along with the required
supporting servers. For more information and descriptions of the various
BusinessObjects Enterprise servers, see the “Architecture” chapter in the
SAP BusinessObjects Enterprise Administrator's Guide.

There are three options to choose from when configuring content processing
servers for your SAP content
1. Maintain a single SIA, including all BusinessObjects Enterprise servers,

running under credentials that have access to the PSE. This is the simplest
option - no server groups need to be created. This approach is the least
secure in that an unnecessary number of servers have access to the
PSE.

2. Create a second SIA with access to the PSE and add to it the Crystal
Report or Web Intelligence processing servers. Delete the duplicated
servers from the original SIA. No server groups need to be created but
less servers have access to the PSE.

3. Create a SIA exclusively for use for SAP with access to the PSE. Add to
it the Crystal Report or Web Intelligence processing servers. In the
approach, only SAP content should run on these servers, and more
importantly SAP content should only run on these servers. Since in this
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scenario content needs to be directed to certain servers, you must create
server groups for the SIA.

Guidelines for using a server group

The server group needs to reference the SIA used exclusively to handle SAP
content. In addition, the server group needs to reference the following servers:
• Adaptive Servers
• Publication Servers
• Destination Job Servers

All SAP content; WebI documents and Crystal Reports need to be associated
with the server group using the strictest association, i.e. that they must run
on servers in the group. When this association is done on an object level,
the server group setting should be propagated into settings for both direct
scheduling as well as for publications.

To prevent other (non-SAP) content from ever processing on the SAP-specific
processing servers, you should create another server group that includes all
the servers under the original SIA. It is recommended that you setup a strict
association between this content and the non-SAP server group.

Configuring Data Access

This section guides you through the process of configuring data access.

Processing scheduled reports in SAP's batch mode

You can run scheduled reports in BusinessObjects Enterprise using the SAP
batch mode. The InfoSet and Open SQL drivers can run reports using either
the SAP batch or background mode when specific environment variables
are set to 1. The relevant environment variables are :

• CRYSTAL_INFOSET_FORCE_BATCH_MODE (for the InfoSet driver)

• CRYSTAL_OPENSQL_FORCE_BATCH_MODE (for the Open SQL driver)

However, it is recommended that you use this feature only when you have
a distributed installation of BusinessObjects Enterprise. When these
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environment variables are set to 1, the drivers run reports using SAP's batch
mode, regardless of the reporting component that is actually running the
report. Therefore, if you create these environment variables as system
environment variables on a machine that is running a combination of
BusinessObjects Enterprise servers, the drivers run all reports in batch mode
(including on-demand report requests from the Crystal Reports Processing
Server and the Report Application Server).

Note:
To ensure that the drivers run only your scheduled reports in batch mode
(that is reports run by the Report Job Server), avoid setting system
environment variables on machines running combinations of BusinessObjects
Enterprise servers.

Note:
SAP users who schedule reports in BusinessObjects Enterprise may require
additional authorizations in SAP.

Related Topics
• Creating and applying authorizations
• Scheduling a report in batch mode (with an Open SQL query)

To process scheduled reports in SAP batch mode

Follow the steps below to set the batch mode system environment variables
on the machine(s) running the Report Job server .
1. On Windows right-click My Computer and click Properties.
2. Go to System Properties > Advanced > Environment Variables.
3. Add the following SAP batch mode settings as system variables:

CRYSTAL_INFOSET_FORCE_BATCH_MODE=1
CRYSTAL_OPENSQL_FORCE_BATCH_MODE=1

Note:
For UNIX, add the same SAP batch mode settings to your environment
variables.

Click OK to save the new variables.
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4. Go to Start > BusinessObjects XI 3.1 > BusinessObjects Enterprise
> Central Configuration Manager.

5. Right-click Server Intelligent Agent and click Restart.

Note:
The new settings affect all the Crystal Report processing servers running
on the machine on which you have applied the batch mode environment
settings. In a distributed deployment, it is recommended that you apply
these settings on the machine running the Crystal Report Job server, and
no other Crystal Report servers.

Configuring multi-pass publications
For detailed instructions on creating multi-pass publications, see the SAP
BusinessObjects Enterprise Publisher's Guide.

Troubleshooting multi-pass publications

If you encounter problems with multi-pass publications, enable tracing for
the Crystal Reports (CR) or Multidimensional Data Access (MDA) drivers for
SAP and look at the logon string used for each job or recipient. These logon
strings should resemble the following:

SAP: Successfully logged on to SAP server.
Logon handle: 1. Logon string: CLIENT=800 LANG=en
ASHOST="vanrdw2k107.sap.crystald.net" SYSNR=00 SNC_MODE=1
SNC_QOP=1
SNC_LIB="C:\WINDOWS\System32\sapcrypto.dll"
SNC_PARTNERNAME="p:CN=R21Again, OU=PG, O=BOBJ, C=CA" EX
TIDDATA=HENRIKRPT3 EXTIDTYPE=UN

The logon string must have the appropriate EXTIDTYPE=UN (for username)
and EXTIDDATA should be the SAP username of the recipient. In this
example, the logon attempt was successful.
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Integrating BusinessObjects
Enterprise and BW

6



This section shows how to configure BW to enable and administer report
publishing from BW to BusinessObjects Enterprise. It also includes
instructions for configuring the http request handler in SAP.

Configuration overview
This section outlines the configuration steps needed to integrate BW and
BusinessObjects Enterprise.

Before beginning this section, make sure you have completed the
configuration steps outlined in Configuring SAP authentication .

About BW Publisher Service

BW Publisher Service enables you to add content to your SAP and
BusinessObjects Enterprise repositories simultaneously.

The BW Publisher Service is different from the Publishing Wizard and the
Publishing feature. The Publishing Wizard is a BusinessObjects Enterprise
component that enables you to add reports to your BusinessObjects
Enterprise repository only. The Publishing feature in BusinessObjects
Enterprise lets you distribute personalized collections of documents (known
as publications) to a mass audience.

Understanding the default folder security
patterns

When you publish content to BusinessObjects Enterprise from SAP,
BusinessObjects Enterprise automatically creates the remaining hierarchy
of roles, folders, and reports. That is, BusinessObjects Enterprise organizes
your Crystal reports in folders that are named according to the System ID
and Client Number, and according to the name of the role.

The diagram that follows shows how BusinessObjects Enterprise organizes
content when you publish two roles from one BW system:

• BusinessObjects Enterprise creates the top-level folders - that is, the
SAP, 2.0, and system (SID) folders - when you define an entitlement
system.
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• BusinessObjects Enterprise creates Role folders (imported as groups
into BusinessObjects Enterprise) as necessary, when a role is published
from BW.

• BusinessObjects Enterprise creates a Content folder for each role that
content is published to.

• Security is set on each report object, so users can view only the reports
that belong to their roles.

The diagram below displays the basic folder structure that is created.

The administrator is responsible for assigning rights to members of different
roles. To do this, the following rights should be assigned in the Content
Administration Workbench.

Content folders

BusinessObjects Enterprise imports a group for each role that is added to
the entitlement system as defined in the CMC.

To ensure that suitable default rights are granted to all members of a
content-bearing role, grant the appropriate rights in the Content Administration
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Workbench for each entitlement system that is defined in BusinessObjects
Enterprise:

1. In the Content Administration Workbench, expand Enterprise system
and then expand Available systems.

2. Double-click the system you want.

3. Click the Layout tab.

4. Set Default security policy for reports to View.

5. Set Default security policy for role folders to View On Demand.

6. Click OK.

These settings are reflected in BusinessObjects Enterprise for all content
roles. That is, roles that have content published to them. Members of these
roles will now be able to view scheduled instances of reports published to
other roles and will be able to refresh reports published to roles that they are
a member of.

Note:
It is strongly recommended that you keep the activities of roles distinct. For
example, while it is possible to publish from an administrator role, it is better
practice to publish only from publisher roles. Additionally, the function of
publishing roles is only to define which users can publish content. Thus,
publishing roles should not contain any content; publishers should publish
to content bearing roles that are accessible to regular role members.

Setting up folders and security in BusinessObjects
Enterprise

When you define an entitlement system in BusinessObjects Enterprise,
BusinessObjects Enterprise creates a logical folder structure to match your
SAP system. When you import roles and publish content to BusinessObjects
Enterprise, corresponding folders are created. As an administrator, you do
not have to create these folders. They are created as a result of you defining
an entitlement system in BusinessObjects Enterprise, importing roles into
the CMC, and publishing content to BusinessObjects Enterprise.

The diagram below displays the basic folder structure that is created.
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Note that you, the administrator, are responsible for assigning the correct
rights to these folders:

• SAP top-level folder

Ensure the Everyone group has limited access to the SAP top-level folder.

• System ID folders

Assign the principal Publisher the following rights in the CMC:

• Add objects to folder
• View objects
• Edit objects
• Modify the rights users have to objects
• Delete objects

Tip:
To make rights administration easier, you can create a customized Publisher
access level that includes these rights, and then grant the principal Publisher
this access level on relevant System ID folders. For more information about
working with access levels, see the SAP BusinessObjects Enterprise
Administrator's Guide.

For more information about how to grant principals rights on top-level folders
and on objects, see the “Setting Rights” chapter in the SAP BusinessObjects
Enterprise Administrator's Guide.

Note:
After you have set up folders and security in BusinessObjects Enterprise,
complete the tasks in Configuring the BW Publisher, and Configuring
publishing in the Content Administration Workbench. Once you have
completed those tasks, you can publish content to BusinessObjects Enterprise
from BW.
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Configuring the BW Publisher
The BW Publisher allows you to publish Crystal reports (.rpt files) individually
or in batches from BW to BusinessObjects Enterprise.

On Windows, you can configure the BW Publisher in one of two ways:

• Start the BW Publisher using a service on a BusinessObjects Enterprise
machine. The BW Publisher service will start instances of the BW
Publisher as required.

• Start the BW Publisher using a local SAP Gateway to create BW Publisher
instances.

You must select the configuration method based on the requirements of your
site, after considering the advantages and disadvantages of each
configuration. Once you have configured the BW Publisher in
BusinessObjects Enterprise, you must configure publishing in the Content
Administration Workbench.
Related Topics
• Selecting your BW Publisher configuration
• Configuring publishing in the Content Administration Workbench

Configuring the BW Publisher as a service

This section explains how to enable publishing of reports from BW to
BusinessObjects Enterprise, using the BW Publisher as a service, perform
the following procedure.

For information on adding system redundancy using multiple BW Publishers,
see Distributing the BW Publisher installation.

Starting the BW Publisher: UNIX

Run the BW Publisher script to create a publisher instance or instances to
handle publishing requests. It is recommended that you start one publisher
instance.
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Once the BW Publisher starts, it establishes a connection with the SAP
Gateway Service that you specified when you ran the BusinessObjects XI
Integration for SAP Solutions setup program.

To start the BW Publisher
1. Log on to your UNIX system under the Business Objects user account

you created for your BusinessObjects Enterprise installation.
2. Run the following script to start a publisher instance:

businessobjects/bwcepub.sh num -aPROGID -gGWHOST -xGWSERVICE

where:

• businessobjects is the root Business Objects directory where you
installed BusinessObjects Enterprise and BusinessObjects XI
Integration for SAP Solutions.

• num is the number of publisher instances to start.
• PROGID is the Program ID of the RFC Destination for the BW

Publisher. The Program ID can take any value, but must be 64
characters or fewer, and may not contain spaces. The Program ID is
case-sensitive.

Record the exact value you specify here for the Program ID. You will
need this value when you configure the RFC destination on your BW
system.

• GWHOST is the name of your Gateway Host.
• GWSERVICE is the port number of the Gateway Service.

Related Topics
• Configuring a destination for the BW Publisher service

To stop the BW Publisher: UNIX
1. Log on to your UNIX system under the Business Objects user account

you created for your BusinessObjects Enterprise installation.
2. Type ./bwcepub.sh stop.

Starting the BW Publisher: Windows

On Windows, use the Central Configuration Manager (CCM) to start the BW
Publisher service. When you start the BW Publisher service it creates a
publisher instance to service publishing requests from your BW system. If
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the volume of publishing requests increases, the BW Publisher automatically
spawns additional publishers to meet the demand.

For more information on the CCM, consult the SAP BusinessObjects
Enterprise Administrator's Guide.

Once the BW Publisher starts, it establishes a connection with the SAP
Gateway Service that you specified when you ran the BusinessObjects XI
Integration for SAP Solutions setup program.

To start the BW Publisher service: Windows
1. Start the Central Configuration Manager (CCM) from the BusinessObjects

Enterprise program group.
2. Right-click BWPublisher Service and, on the shortcut menu, click Start.

Configuring a destination for the BW Publisher service

To enable the BW Publisher, you must configure an RFC destination on your
BW server to communicate with the BW Publisher service. If you have a BW
cluster, configure the RFC destination on each server, using the central
instance of BW as your Gateway Host in every case.

If you wish to publish to multiple BusinessObjects Enterprise systems from
BW, create a separate RFC destination for the BW Publisher service in each
BusinessObjects Enterprise system. You must use unique Program IDs for
each destination, but the same Gateway host and Gateway service.

To create the required RFC destination (TCP/IP connection)
1. Execute transaction SM59, which allows you to display and maintain RFC

destinations.
2. Click Create and provide the values described in the following table.

Tip:
You cannot view all of these fields until you provide the Connection type.
The Connection type must be non-Unicode; otherwise, connection to the
BW Publisher will fail.

3. After saving your settings, click Test connection.

The connection test attempts to contact your BW Publisher service.

If the RFC destination is properly configured and can communicate with
your BW Publisher service, the result is a list showing how long it took to
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contact the service on each of four attempts. If the RFC destination cannot
contact your BW Publisher service, the result is a connection error.

Note:

• The publishing process will not work until the destination is working
successfully.

• If you plan to enforce Secure Network Communication (SNC) between
SAP and BW Publisher, you must provide your SNC options on the
Logon/Security tab for the CRYSTAL_PUBLISHER destination. For details
about SNC, see Configuring BusinessObjects Enterprise for server-side
trust.

• The RFC destination must be created as non-Unicode in the
"MDMP/Unicode " tab regardless whether your SAP system is Unicode
or non-Unicode.

For more information on RFC destinations and TCP/IP connection types,
consult your SAP documentation.

ValueField

Use a descriptive name.

Note:
Do not use the name CRYSTAL_PUB
LISHER unless you do not have the
Content Administration Workbench.
See Configuring publishing in the
Content Administration Workbench for
details.

RFC destination

Type T (for TCP/IP connection) and
press Enter.Connection type

Type a short description of the desti-
nation.Description
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ValueField

Select "Registered Server Program."Activation Type

Type the descriptive string used to
identify the process associated with
this destination. You must use the
same Program ID that you specified
when you started the BW Publisher,
when you installed BusinessObjects
XI Integration for SAP on your Busi-
nessObjects Enterprise machines.
See "Recommended initial installa-
tion". See To start the BW Publisher.

Tip:

• Program ID is case-sensitive.
• Program ID should not contain any

spaces.

Program ID

Type the name of your BW server. If
you have a BW cluster, enter the
name of the central instance of BW.
You must use the same BW server
name here that you specified when
you installed BusinessObjects XI In-
tegration for SAP on your Busines-
sObjects Enterprise machines.

For details, see "Recommended ini-
tial installation"Publishing Reports .

Gateway host
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ValueField

Type the port number that the Gate-
way host is listening on. For example,
type sapgw##, where ## represents
the instance number of your SAP
Gateway. Often, the instance number
is 00, and the value for this field is
sapgw00.

If you have defined a symbolic name
for this port (such as sapgw##), you
may use this symbolic name instead.

You must use the same port number
or symbolic name here that you
specified when you installed Busines-
sObjects XI Integration for SAP on
your BusinessObjects Enterprise
machines.

For details, see "Recommended ini-
tial installation"Distributing informa-
tion over the Web.

Gateway service

Type -LSNClibrary_path -SS-
NCpublisher_process. Here
SNClibrary_path represents the file di-
rectory in which the SNC library is locat-
ed, and SNCpublisher_process repre-
sents the name of the SNC Publisher
process.

Other
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Configuring the BW Publisher with a local SAP
Gateway

Note:
Do not use this configuration if “BusinessObjects Enterprise” is installed on
UNIX. Using this method on UNIX could result in unpredictable system
behavior.

To enable publishing of reports from BW to BusinessObjects Enterprise,
using a local SAP Gateway, perform the following procedure:

• Installing a local SAP Gateway.

• Configuring a destination for the BW Publisher.

Installing a local SAP Gateway

A local SAP Gateway must be installed on the machine where you installed
the BW Publisher. (See "Recommended initial installation".) It is
recommended that an SAP BASIS administrator perform the installation of
one of these SAP Gateways.

For up-to-date instructions on installing a local SAP Gateway, see the SAP
installation instructions included on your SAP Presentation CD.

For a detailed list of tested environments for BusinessObjects XI Integration
for SAP, consult the platforms_EN.txt file included with your product
distribution. This file includes specific version and Service Pack requirements
for application servers, operating systems, SAP components, etc.

After you have installed the SAP Gateway, use regedit to verify the TMP
and TEMP registry entries under the HKEY_CURRENT_USER\Environment
subkey. Both registry entries should hold the same string value, which must
be a valid absolute directory path. If either entry's value contains the
%USERPROFILE% variable, replace it with an absolute directory path.
Typically, both registry entries are set to C:\WINDOWS\TEMP
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Configuring a destination for the BW Publisher

To enable the BW Publisher, you must configure an RFC destination to
provide BW with the location of the machine where you have installed the
local SAP Gateway and the BW Publisher.

To create the required RFC destination (TCP/IP connection)
1. Execute transaction SM59, which allows you to display and maintain RFC

destinations.

Here you will create a TCP/IP connection.

2. Click Create and provide the values described in the following table.

Tip:
You cannot view all of these fields until you provide the Connection type.

3. After saving your settings, click Test connection.

The connection test attempts to contact your BW Publisher on the local
SAP Gateway.

If the RFC destination is properly configured and can communicate with
your BW Publisher, the result is a list showing how long it took to contact
the Gateway on each of four attempts. If the RFC destination cannot
contact your BW Publisher Service, a connection error occurs.

Note:

• The publishing process will not work until the destination is working
successfully.

• If you plan to enforce Secure Network Communication (SNC) between
SAP and BusinessObjects Enterprise, you must provide your SNC options
on the Logon/Security tab for the CRYSTAL_PUBLISHER destination. For
details about SNC, refer to the "Configuring SAP Server-Side Trust"
section in this guide.

For more information on RFC destinations and TCP/IP connection types,
consult your SAP documentation.
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Value (Windows)Field (Windows)

Use a descriptive name.

Note:
Do not use the name CRYSTAL_PUB
LISHER unless you do not have the
Content Administration Workbench.
See Configuring publishing in the
Content Administration Workbench for
details.

RFC destination

Type T (for TCP/IP connection) and
press Enter.Connection type

Type a short description of the desti-
nation.Description

Select "Start on Explicit Host."Activation Type

Type the absolute path to the BW
Publisher program (bwcepub.exe).
If you installed it in the default direc
tory on Windows, the value is:

C:\Progra~1\Busine~1\Bu
sine~1.0\win32_x86\bw
cepub.exe

Tip:
Use the MS-DOS short path name, as
shown here.

Program
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Value (Windows)Field (Windows)

Type the fully qualified domain name
or IP address of the machine where
you installed the BW Publisher. For
example: ceserver01.privatedo
main.com

Target host

Type the name of the machine where
you installed the SAP Gateway. This
should be the same machine as the
"Target host." For example:
boserver01

Gateway host

Type sapgw##, where ## represents
the instance number of your SAP
Gateway. Typically, the instance
number is 00, and the value for this
field is sapgw00

Gateway service

Configuring publishing in the Content
Administration Workbench

Once you have set up SAP authentication, and have configured the BW
Publisher, perform the functions outlined in this section to enable publishing.
These instructions will allow you to:

• Set appropriate authorizations for different users of the Content
Administration Workbench.

• Set up connections to the BusinessObjects Enterprise systems where
content is published.

• Define which roles can publish to each BusinessObjects Enterprise
system.
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• Publish content from BW to BusinessObjects Enterprise.

Users who can access the Content Administration
Workbench

There are three types of users who may access the Content Administration
Workbench:

• Content consumers, who belong to content-bearing roles and who can
view reports. They do not have authorization to do anything other than
view reports.

• BusinessObjects Enterprise content publishers, who can view, publish,
modify, and (optionally) delete reports from BW.

• BusinessObjects Enterprise administrators, who are able to perform all
tasks within Content Administration Workbench. These tasks include
defining BusinessObjects Enterprise systems, publishing reports, and
performing report maintenance.

Creating roles in BW for designated content
publishers

When you are configuring BW for integration with BusinessObjects Enterprise,
assess whether or not your current role structure allows you to quickly
designate particular BW users as BusinessObjects Enterprise content
publishers or system administrators.

It is suggested that you label any new roles you create in a descriptive
manner. Examples of descriptive role names would include BOE_CON
TENT_PUBLISHERS and BOE_SYSTEM_ADMINISTRATORS.

Tip:
In BusinessObjects Enterprise XI you can assign an administrative user
either full system administration rights or a subset of those rights. For more
information, consult “Controlling Administrative Access” in the SAP
BusinessObjects Enterprise Administrator's Guide.

To modify the rights that these new roles (or any of your existing roles) are
granted in BusinessObjects Enterprise, you must first set up SAP
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Authentication and import the roles. You can then modify the rights of each
imported role through the Central Management Console in BusinessObjects
Enterprise.

For details on creating roles, see your SAP documentation. For more
information on the use of roles in administering content, see the following
sections:

• Importing SAP roles to BusinessObjects Enterprise.

• Setting up folders and security in BusinessObjects Enterprise.

• Understanding the default folder security patterns.

Configuring access to the Content Administration
Workbench

For each type of user that can access the Content Administration Workbench,
you must apply the appropriate set of authorizations within BW. The
authorizations are listed in the following tables.

Table 6-3: Authorizations for administrative users

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC

S_TCODE

/CRYSTAL/CE_SYNCH,
SH3A, SUNIRFC_NAME

Execute (16)ACTVT

/CRYSTAL/RPTADMIN,
RSCR_MAINT_PUB-
LISH

TCD
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ValuesFieldAuthorization object

XCLIIDMAINTS_TABU_CLI

Change, Display (02,
03)ACTVT

S_TABU_DIS
&NC&DICBERCLS

DELE, RELEJOBACTION

' 'JOBGROUP

Execute (16)ACTVT

S_RS_ADMWB
WORKBENCHRSADMWBOBJ

Create new, Change,
Display, Delete (01, 02,
03, 06)

ACTVT

Create new, Delete (01,
06)ACTVTZCNTADMJOB

Display, Delete, Acti-
vate, Maintain, Check
(03, 06, 07, 23, 39)

ACTVTZCNTADMRPT
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Table 6-4: Authorizations for content publishers

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC

/CRYSTAL/CE_SYNCH,
SH3A, SUNIRFC_NAME

Execute (16)ACTVT

/CRYSTAL/RPTADMINTCD

DELE, RELEJOBACTION

S_BTCH_JOB

' 'JOBGROUP

Execute (16)ACTVT

WORKBENCHRSADMWBOBJ

Display (03)ACTVTZCNTADMCES

(New, Delete) 01, 06ACTVTZCNTADMJOB

Display, Activate, Main-
tain, Check (03, 07, 23,
39)

Delete (optional) (06)

Edit (optional) (02)

ACTVTZCNTADMRPT
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Granting content publishers the right to delete reports in the BW Content
Administration Workbench is optional. However, be aware that deleting a
report in BW also deletes the report in BusinessObjects Enterprise. If
publishers do not have sufficient rights to delete reports in BusinessObjects
Enterprise, an error results. See Setting up folders and security in
BusinessObjects Enterprise for information on granting rights in
BusinessObjects Enterprise.

Authorizations for content consumers

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC

SH3A, SUNIRFC_NAME

Execute (16)ACTVT

/CRYSTAL/RPTADMINTCD

Execute (16)ACTVT

S_RS_ADMWB WORKBENCHRSADMWBOBJ

Display (03)ACTVT

Defining a BusinessObjects Enterprise system

You must create a system definition within the Content Administration
Workbench for each BusinessObjects Enterprise system to which you want
to publish reports.
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To add a BusinessObjects Enterprise system

1. Execute the transaction /crystal/rptadmin to access the Content
Administration Workbench.

2. From the Operations pane, select Enterprise System.
3. Double-click Add new system.
4. On the System tab, enter the following values:

• Type a descriptive name in the Alias field. Avoid using spaces or
special characters, as these characters need special treatment when
the alias name is used while configuring Enterprise Portals.

• Type the name of the machine that is running your BusinessObjects
Enterprise CMS. If you configured your CMS to listen on a port other
than the default, type CMSNAME:PORT

• Select Default system if you want to publish reports to this system
from any role that has not been explicitly assigned to a
BusinessObjects Enterprise system. Only one BusinessObjects
Enterprise system can be the default.

In the list of all available systems, the default system is indicated with
a green checkmark.

5. Click Save.
6. On the RFC Destinations tab, add each RFC destination that is

associated with this BusinessObjects Enterprise system. To add a
destination, click the Insert Row button. In the list that appears,
double-click the name of the RFC destination.

Note:
A BusinessObjects Enterprise system may have multiple destinations to
add system redundancy. See Distributing the BW Publisher installation
for more information.

7. Next, test the destination. Select the destination you just added by clicking
the gray box to the left of its name.

8. Click Verify CE definition.

This test verifies that BW can contact the specified BW Publisher, and
can log on to this BusinessObjects Enterprise system using the Crystal
entitlement user account.
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9. On the HTTP tab, enter the following values:
• Protocol

Type http (unless the web server that is connected to BusinessObjects
Enterprise is configured to use https).

• Web server host and port

Type the fully qualified domain name or IP address of the web server
that hosts your BusinessObjects EnterpriseInfoView. For a installation
that uses a Java application server, include the port number. For
example:

boserver01.businessobjects.com:8080

• Path

Type:

SAP

This path is essentially the virtual path that your web server uses when
referring to the sap subfolder of your BusinessObjects Enterprise web
content. Provide an alternate value only if you have customized your
web environment and the location of the BusinessObjects Enterprise
web content files.

Do not include a forward slash at the beginning or at the end of this
entry.

• Viewer application

Type the name of your viewer application. Type reportview.do to use
the default viewer for BusinessObjects Enterprise that use the Java
version of InfoView. If BusinessObjects Enterprise was installed on
Windows using the default ASP.NET configuration, type iviews/re
port_view.aspx to use the default browser.

10. On the Languages tab, select the languages of reports that will be
published to this BusinessObjects Enterprise system.

11. Use the Roles tab to add the content-bearing roles that you want to
associate with this BusinessObjects Enterprise system. See Importing
SAP roles to BusinessObjects Enterprise for more information.

12. Click the Insert Row button.
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A list of roles available to add to this BusinessObjects Enterprise system
is displayed.

Note:
Each role can publish to only one BusinessObjects Enterprise system. If
the roles that you want to add to this BusinessObjects Enterprise are not
displayed in the list, click Cancel to return to the Roles tab. Then click
Reassign Roles.

13. Select the roles that you want to publish to this BusinessObjects Enterprise
system, and click the Ok button.

14. Next, set the default security settings for content published to this
BusinessObjects Enterprise system. Click the Layout tab, and select the
security settings that are used by default for reports and roles folders.
Consult your SAP BusinessObjects Enterprise Administrator's Guide for
more information about these security settings.

Note:

• A folder is created automatically in BusinessObjects Enterprise for
each role published to that system. This folder contains shortcuts to
the reports published under that role.

• Once you have configured a BusinessObjects Enterprise system,
changing the default security levels here will not affect the security
levels of published role folders or reports. To change the default
security levels for all roles and content published to BusinessObjects
Enterprise, delete the roles folders and shortcuts in BusinessObjects
Enterprise. (This will not delete the actual reports.) Then change the
security settings here, and republish the roles and reports.

15. Click the Ok button at the bottom to save your settings and create the
BusinessObjects Enterprise system in the Content Administration
Workbench.

You are now able to publish reports to BusinessObjects Enterprise from BW.

Publishing reports using theContentAdministration
Workbench

After a report has been saved to BW, you can publish it using the Content
Administration Workbench. You can use the Content Administration
Workbench to publish individual reports, or you can publish all reports saved
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to a particular role. Only a user who has the authorizations granted to a
Crystal content publisher (see Creating and applying authorizations) can use
the Content Administration Workbench to publish and maintain reports.

Publishing roles or reports

1. Execute the transaction /crystal/rptadmin to access the Content
Administration Workbench.

2. From the Operations pane, select Publish reports.

3. To find content saved to your BW system, double-click Select reports
and roles to publish.

A dialog box designed to help you filter the available roles and reports
appears.

4. From the BusinessObjects Enterprise System list, select the
BusinessObjects Enterprise system or systems containing content that
you want to display.

Note:
The BusinessObjects Enterprise System list contains all available
systems defined on this BW system.

5. Next, filter your results to limit the number of reports and roles that will
be displayed. Use these options:

• Object version

Selecting "A: active" displays all reports that can be published.
Selecting the blank option displays all reports. (The remaining options
are SAP reserved terms.)

• Object status

Select "ACT Active, executable" to display only reports that have been
published. Select "INA Inactive, not executable" to display only reports
which have not been published. Leave the field blank to display all
reports. (The remaining options are SAP reserved terms.)

• Role filter

If you type text in this box, only the roles that match what you type
here are displayed. Use * as a wildcard character. For example, to
display all roles beginning with the letter d, type "d*".
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• Report description

If you type text in this box, only the reports whose descriptions match
what you type here are displayed. Use * as a wildcard character to
match any number of characters. Use + as a wildcard to match 0 or
1 characters. For example, to display all reports whose description
contains the word revenue, type *revenue*.

6. Click OK.

The list of reports that meet your criteria appears in the right-hand panel.

The reports are arranged in a hierarchy: BusinessObjects Enterprise
system > Roles on that system > Reports saved to the role.

Each item in the hierarchy is labeled with a red, yellow, or green dot.
Items higher in the hierarchy reflect the status of the items that they
contain, with the least favorable condition percolated to the top of the
hierarchy. For example, if one report in a role is yellow (active), but all of
the rest are green (published), then the role shows as yellow (active).

• Green: The item is fully published. If the item is a BusinessObjects
Enterprise system or a role, all reports in that item are published.

• Yellow: The item is active, but not published. If the item is a report,
the item is available for publishing. If the item is a role or a
BusinessObjects Enterprise system, then all content is active and at
least one item that the role or system contains has not been published.

• Red: The item is SAP content, and is not available for publishing using
the Content Administration Workbench. Content is not available for
publishing until it has been activated using the BW Administration
Workbench.

7. Select the reports that you want to publish.

To publish all o f the reports in a role, select the role. To publish all roles
on a BusinessObjects Enterprise system, select the system.

Note:
When you select a role (or a system), all reports contained in that role
(or system) are selected. To clear this selection, clear the role (or system)
checkbox, and then click Refresh.

8. Click Publish.
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Note:
Reports published in the background are processed as system resources
become available. To use this option, click In background instead of
Publish. See Scheduling background publishing for details.

9. Click Refresh to update the display of the status of BusinessObjects
Enterprise systems, roles, and reports in the Content Administration
Workbench.

Tip:
To view a report, right-click the report and select View. To see which
queries are used by the report, right-click the report and select Used
Queries.

Note:
After you have published a report to BusinessObjects Enterprise, if you
want to overwrite the report you published, click the Overwrite button.

Scheduling background publishing

Publishing reports in the background, either immediately or as a scheduled
job, conserves system resources. It is recommended that you publish reports
in the background to improve system responsiveness.

Publishing reports periodically, as scheduled jobs, synchronizes the report
information between BW and your BusinessObjects Enterprise system. It is
recommended that you schedule all reports (or roles containing these reports).
You can also manually synchronize roles and reports using the Update status
option of the Report Maintenance operation. See Updating the status of
reports for details.

To publish a report immediately
1. Use the Content Administration Workbench to find the reports or roles

that you want to publish, as described in Publishing roles or reports.
2. In the Content panel, select the roles or reports to publish.

Note:
Only active (green or yellow) reports or roles are available to be published.

3. Click In background to publish the selected items as a background
process.

The “Define Background Job” transaction appears.
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4. To publish the item immediately, click Start Condition, and then click
Immediate and save the job.

The job appears under Scheduled jobs in the Operations tree.

A user with administrative privileges may need to release this job (using
transaction SM37) before it is published.

To publish a report as a scheduled job
1. Use the Content Administration Workbench to find the reports or roles

that you want to publish, as described in Publishing roles or reports.
2. In the Content panel, select the roles or reports to publish.

Note:
Only active (yellow) reports or roles are available to be published.

3. Click In background to publish the selected items as a background
process.

The “Define Background Job” transaction appears.

4. To publish the item at a scheduled time, click Start Condition.
5. Click Date/Time and specify when the job should start.
6. Click Periodic job, and then Period values.

Use the Period Values dialog to specify how often the job should run.

7. Click Save to save the period values, and then click Save again to save
the job.

The job appears under Scheduled jobs in the Operations tree.

A user with administrative privileges may need to release this job (using
transaction SM37) before it is published.

Updating system information for published reports

The BW Publisher uses the SAP system information entered here to update
the data source of published reports. You can choose to use the local BW
application server, or the central BW instance if you prefer a load balancing
configuration.
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To update system information
1. Execute the transaction /crystal/rptadmin to access the Content

Administration Workbench.
2. From the Operations pane, select Publish reports.
3. Under SAP system settings, double-click Set BW source parameters.
4. To change an existing BW system, click Display ->Change, and then

update the information about the listed system.
5. To add a new BW system (or a load-balanced system), first select any

existing entries, and click Delete. Then click New Entries, and add
information about the new system.

6. Click Save.

Maintaining reports

Report maintenance tasks include synchronizing information about reports
between BusinessObjects Enterprise and BW (Update status), deleting
unwanted reports (Delete reports), and updating reports migrated from
previous versions of BusinessObjects Enterprise (Post-migration).

Updating the status of reports

If you make a change to a published report on a BusinessObjects Enterprise
system (such as changing which role a report is published to), the change
is not reflected in BW until you synchronize BusinessObjects Enterprise and
BW. You can schedule a publishing job to periodically synchronize
BusinessObjects Enterprise and BW (seeScheduling background publishing),
or you can manually update the status of the report using the Report
Maintenance tool.

To update reports
1. Execute the transaction /crystal/rptadmin to access the Content

Administration Workbench.
2. Under Report Maintenance, double-click Update Status.
3. Use the dialog that appears to filter the list of displayed BusinessObjects

Enterprise systems, roles, and reports, as described in Publishing roles
or reports.
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4. Select the reports you want to update from the displayed list.

To select all reports and roles on a BusinessObjects Enterprise system,
select the system.

5. Click Version Check.

BW connects to the BusinessObjects Enterprise systems containing the
reports you have indicated, to synchronize information. If BW cannot
contact a BusinessObjects Enterprise system, it returns an error message.
You must correct the problem before you can update the status of reports
on that system in BW.

Deleting reports

Deleting a published report from BW using the Content Administration
Workbench also deletes the report from BusinessObjects Enterprise. Only
users who have been granted the authorizations necessary to delete reports
on both BW and the BusinessObjects Enterprise system can remove reports.

Note:
If a user has rights to delete a report on BW, but not on the BusinessObjects
Enterprise system where that report is published, you may encounter an
error.

To delete reports
1. Execute the transaction /crystal/rptadmin to access the Content

Administration Workbench.
2. Under Report Maintenance, double-click Delete reports.
3. Use the dialog that appears to filter the list of displayed BusinessObjects

Enterprise systems, roles, and reports, as described in Publishing roles
or reports.

4. Select the reports you want to delete from the displayed list.

To select all reports and roles on a BusinessObjects Enterprise system,
select the system.

Note:
You cannot delete reports using the Content Administration Workbench
if their status dot is red. These reports are SAP content.

5. Click Delete reports.
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BW connects to the BusinessObjects Enterprise systems containing the
reports you have indicated, to delete the reports. If BW cannot contact a
BusinessObjects Enterprise system, it returns an error message. You
must correct the problem before you can delete these reports.

Configuring theSAPhttp request handler
To enable viewing of reports in BW, you must configure BW to use the http
request handler that is included as part of the Content Administration
Workbench. Then, when a BW user opens a Crystal report from within the
SAPGUI, BW is able to route the viewing request over the Web appropriately.

Use the transaction SICF to access the list of virtual hosts and services active
on your BW system. Create a new node named ce_urlunder BW in the
default_host hierarchy and add /CRYSTAL/CL_BW_HTTP_HANDLER to
the handler list. You may have to manually activate this service after creating
it.
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Managing the SAP
Enterprise Portal

7



SAP Enterprise Portal overview
SAP Enterprise Portal provides a single point of access to information,
enterprise applications, and services. This scalable portal provides you with
the tools to manage your information, to analyze it, and to share and
collaborate this information with others.

With BusinessObjects XI Integration for SAP Solutions, users can include
and view Crystal reports from within the SAP Enterprise Portal. For example,
users can choose to create a new iView inside of the portal and include a
report in this iView.

The portal provides administrators with tools to manage and monitor the
portal. Using iViews, administrators use the administration tools in the portal
to configure the BusinessObjects Enterprise backend. Administrators can
also include and incorporate multiple BusinessObjects Enterprise systems
into one SAP Enterprise Portal. For more information on configuring
BusinessObjects Enterprise, refer to Configuring publishing in the Content
Administration Workbench. For information on SAP Enterprise Portal, refer
to your SAP documentation.

Content access points

The following different access points for content are provided with
BusinessObjects XI Integration for SAP Solutions:

• Sample iViews
• URL iViews
• BusinessObjects Enterprise Knowledge Management and Collaboration

Solution (CMC)

Single sign-on requirements

To facilitate access and administration, you need to enable single sign-on
between the SAP Enterprise Portal and the BusinessObjects Enterprise
systems incorporated in the portal.

For single sign-on to work:
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• The Enterprise Portal and the application server used by BusinessObjects
Enterprise must reside in the same domain. This requirement enables
token-based logon to use single sign-on.

• User roles from the SAP entitlement systems must be imported into the
BusinessObjects Enterprise backend. For more information seeImporting
SAP roles to BusinessObjects Enterprise.

• BusinessObjects Enterprise InfoView must be configured to support single
sign-on. If you are using BusinessObjects Enterprise Java InfoView you
must modify the web.xml file which is located by default in the following
directory:

<INSTALLDIR>\BusinessObjects Enterprise
12.0\warfiles\WebApps\InfoViewApp\WEB-INF

For BusinessObjects Enterprise .NET InfoView, you must modify the
web.config file which is located by default in the following directory:

<INSTALLDIR>\BusinessObjects Enterprise 12.0\Web
Content\InfoViewApp\InfoViewApp

You must modify the parameters to specify the values listed in the table
below.

Required valueParameter name

secSAPR3authentication.default

falsesiteminder.enabled

truesso.enabled

Using sample iViews
The BusinessObjects XI Integration for SAP Solutions install includes sample
iViews. The sample iViews can be used to view Crystal Report Alerts or to
view reports by selecting their corresponding thumbnail. These files are by
default located in the following directory:
<INSTALLDIR>\BusinessObjects\BusinessObjects Enterprise
12.0\Web Content\Enterprise 12\SAP\iviews\import\ep

This folder contains all the files that are needed for you to import sample
iViews to your portal. The subfolder ep contains files for SAP Enterprise
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Portal (.epa files). Within each of these subfolders are additional subfolders
that contain the corresponding files for JSP.

These samples include three sample iViews:

• Alert iView

Alert iViews displays all alerts for a specific user.

• iView Template

iView template is a template that allows users to create new iViews as a
type of BusinessObjects Enterprise Report.

• Thumbnail iView

Thumbnail iViews displays reports from BusinessObjects Enterprise as
a thumbnail.

You can import these files through the Portal Administration portion of your
SAP Enterprise Portal. For more information on importing, see “Importing
iViews for Enterprise Portal”.

Note:

• After importing the .epa files, you need to change the system setting for
these iViews. By default, the system is set to "SAP_BW".

• You also need to configure the BusinessObjects Enterprise server
parameters for your system in the Portal System Landscape.

iView Template

BusinessObjects Enterprise iView templates provide templates for users to
create new Crystal Report iViews. Before create a new iView, you need to
upload the master iView .par file.

The master iView .par file is named com.businessobjects.pct.mas
teriview.par, and is located the same directory as the sample iView
com.businessobjects.pct.sap_pik.epa file.

The iView template is available in the SAP Enterprise Portal in the list of
iView templates when you create a new iView. The template is designed to
report Crystal Reports only.
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Alert iView

This iView presents all triggered alerts in a table. The table contains the
report name, alert message, and the date when the alert was triggered. The
alert message provides a link to the report instance that triggered the alert.

You can specify the following parameters for this iView:

• SAP_SYSID: The ID for the SAP system that's used for the Alert iView
(for example, DEB).

• SAP_CLIENT: The client of the SAP system that's used for the Alert iView
(for example, 800).

These parameters are automatically filled by SAP Enterprise Portal.

Thumbnail iView

This iView displays all reports in a thumbnail format (as a report preview).
When the user moves the mouse over the report preview, a brief description
of the report appears. The user can view a report by clicking the thumbnail.

Note:
When you save a Crystal report, select the Save Preview Picture option (on
the Reporting tab of the Options dialog box). Selecting this option ensures
that the report is saved with a thumbnail image which is used by the
Thumbnail iView.

You can specify the following parameters for this iView:

• SAP_SYSID: The ID for the SAP system that's used for the Thumbnail
iView (for example, DEB).

• SAP_CLIENT: The client of the SAP system that's used for the Thumbnail
iView (for example, 800).

These parameters are automatically filled by SAP Enterprise Portal.
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How to configure imported content

After you have imported the import files for the iViews, you will find the folder
(SAP BusinessObjects Enterprise Integrations) in the Portal Content Directory.
The delivered iViews are configured to work with the system alias "SAP_BW".
Either you can configure a new alias inside the SAP Portal landscape to
reflect this system alias "SAP_BW" or you can change the iViews to make
use of another system alias.

After assigning the correct system alias to these iViews you need to proceed
with the following steps:

• Configure the BusinessObjects Enterprise server for the system.

• Create a page containing these iViews.

• Create a role containing the page.

• Assign the role to a user.

• Include the role into the navigation inside the portal.

In addition, specify the Application Parameter for each iView. For this property,
enter “cmsname”=[cms] for the fully qualified server name.

For more information on creating and setting roles, refer to your SAP
documentation.

ImportingSAPEnterprise Portal business
packages

In order to use the Sample iViews, you need to import specific business
packages from BusinessObjects Enterprise to the Enterprise Portal. There
are two methods to do this.

To import business packages from SAP Enterprise
Portal

1. In SAP Enterprise Portal, while in the administrator role, select the System
Administration tab.
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2. Click Transport and then click Import.
3. Specify where the files to be imported are found.

• Server: Select this option if the files are on the server.

• Client: Select this option if the files are on your local client.

Note:
By default the Java sample iViews is located in the following directory:

<INSTALLDIR>\BusinessObjects Enterprise 12.0\Web
Content\Enterprise12\SAP\iviews\import\ep\jsp

The .NET sample iViews are located in the following directory:

<INSTALLDIR>\BusinessObjects Enterprise 12.0\Web
Content\Enterprise12\SAP\iviews\import\ep\aspx

4. Click Browse and navigate to the.epa file that you want to import.
5. Click Select to choose the package that you want to import.

The package is automatically unpacked and the individual objects are
listed in the Object Preview.

6. On the Content to be Overwritten list, specify whether you want to
overwrite existing content or not by clicking All or None.
• None: Content objects that already exist in the portal (for example,

roles, worksets, and so on) are not overwritten.

• All: All existing content objects are overwritten.

7. Click Import to begin importing the file.

A new screen appears showing you the status of the import. You can
stop the import at any time by clicking Cancel Import. The status of the
import is updated automatically until the import has finished. When the
import is complete, any error messages that occurred are listed in the
Details of Import Status table. There is a link for each error that you can
use to navigate directly to an explanation of the error.
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To import BusinessObjects Enterprise master iView
par file

1. Logon to SAP Enterprise Portal as an administrator, and select the
System Administration tab.

2. Click Support, and in the Support Desk, click Portal Runtime.
3. In the “Portal Anywhere” table, click Administration Console.
4. Click Browse, and navigate to the master iView com.businessob

jects.pct.masteriview.par file for the BusinessObjects Enterprise
iView template that you want to import.
By default the file is located in the following directory C:\Program
Files\Business Objects\BusinessObjects Enterprise
12.0\Web Content\Enterprise12\SAP\iviews\import\ep

5. Click Upload to choose the package that you want to upload.

Specific SAP NetWeaver 7.3 considerations

SAP NetWeaver 7.3 does not support par files - the usual format by which
SAP BusinessObjects iViews are distributed. However by using a tool
provided by SAP NetWeaver 7.3 - the PAR Migration tool- it is possible to
convert par files into Enterprise Archive - .ear - files.

Using the PAR Migration Tool

In the current SAP NetWeaver version, PAR (Portal Application Archive) files
are no longer supported. When upgrading portal applications from SAP
NetWeaver 7.0 to the current version, you need to migrate .par files to .war
files. The .war files are then automatically packaged into .ear files. For
more information, consult your NetWeaver 7.3 documentation.

The PAR Migration Tool is a wizard that enables you to migrate standalone
.par files, as well as .par files contained in .sca and.sda files . You can
simultaneously migrate multiple applications.

The PAR Migration Tool provides the following options for selecting the files
to migrate:
• Browse and upload individual files
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• Upload all the files from a specific folder on the local server
• Upload files from imported transport packages.

Note:
The import process cannot import .par , .sda, or .sca files containing
PAR files, because as mentioned earlier, this file type is no longer supported.
When importing a transport package, the files that cannot be imported must
be saved to the local file system. The PAR Migration Tool wizard enables
you to view, select and then migrate these files to a supported format. After
migration is complete you can download the files.

To migrate PAR files for NetWeaver 7.3

1. In the SAP NetWeaver 7.3 Enterprise Portal, navigate to System
Administration Support.

2. Select the PAR Migration Tool.
The PAR migration Tool wizard is uploaded and its initial screen is
displayed.

3. Upload files to the "Available Files" list using any of the following methods:
• Upload files from imported transport packages.
• Browse for and upload individual files.
• Specify the path of a local folder from which to upload the files.

4. Select and move the files you want to migrate to the Selected Files list.
5. Click Next.

The selected files are migrated and displayed in the Migrated Files list.

6. Select the files to download, and then click eitherDownload orDownload
All.
The files are download to the specified directory.

The files can now be deployed on the portal.

Once the files are deployed you can run the iView applications. For more
information on deploying ear files consult your NetWeaver 7.3
documentation.
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To deploy ear files to the NetWeaver 7.3 Enterprise Portal

After migrating com.businessobjects.pct.masteriview.ear file, it
must be deployed to the NetWeaver portal using a shell script that is shipped
together with the portal. To locate the required P4 port of the NetWeaver
Portal , can do one of the following:
• Add a “4” to the port number of the portal application server. For example,

use 502004 if the portal application server port number is 50200.
• Access the SAP System Information page at http://<Portal

Hostname>:<port>/sap/monitoring/SystemInfo

1. Launch a command-line prompt to the following directory:
<INSTALLDIR>/usr/sap/<SID>/<Instance_Number>/j2ee/de
ployment/scripts

2. Execute the following command:

deploy <user>:<password>@<host>:<port> <archive> [-
no_start]

the table below briefly explains the arguments above:

DescriptionArguments

The user executing the command. This user must have
administrative privileges.

user

The password associated with the user executing the
command.

password

The target AS Java host.host

The target P4 port number.port

The path to the archive.archive

Specifies not to start the modules once deployed.no_start

Example:

J2EE_ADMIN:<pass123>@myhost:50804 EJBs/OurEJB.jar -
no_start
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Configuring the BusinessObjects
Enterprise server entry point

Before you use any iViews, you need to configure your BusinessObjects
Enterprise server. Using SAP Enterprise Portal, you need to specify the host
name and the path for your BusinessObjects Enterprise server.

To configure the BusinessObjects Enterprise system
in SAP NetWeaver

1. From the top-level navigation bar, choose System Administration; then
choose System Configuration.

2. From the Detailed Navigation iView, choose System Landscape.
3. In the Portal Catalog, expand Portal Content.
4. In the folder containing the systems, right-click a system and choose

Open, and then choose Object.
5. In the System Landscape Editor, from the Edit list, select Crystal

Enterprise Server.
6. In the BusinessObjects Enterprise Editor, enter the following parameters:

• Host Name of Crystal Enterprise Server:

Here you need to enter the BusinessObjects Enterprise server as fully
qualified host name (including the port).

For example: BusinessObjects001.business.net:1080

• Path of BusinessObjects Enterprise Server:

Here you need to enter the path to the SAP web application you want
to use for this system.

For example: /SAP

Note:
This path starts with a "/" but does not end with a "/".

• Protocol:

The protocol which gets used by the viewer applications.
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All these settings function as a template (with the selected settings) for all
iViews running against the system. Thus, you can have different settings for
each system.

Therefore, you can have the following:

• Different BusinessObjects Enterprise server per system.

• Different viewer applications per system.

To configure the BusinessObjects Enterprise system
in NetWeaver 7.3

The required EAR files for BusinessObjects Enterprise must be deployed on
the Enterprise Portal. For more information consult your NetWeaver 7.3
documentation.

Use the procedure below to configure the Enterprise Portal landscape for
BusinessObjects Enterprise in NetWeaver 7.3.

1. In the Enterprise Portal, go to System Administration > System
Configuration > System Landscape .

2. Expand the "Portal Content" tree structure and create a new folder.
3. In the new folder, right-click New > System.
4. Select "'SAP system using dedicated application server'" from Available

Templates and then click Next.
5. Specify the following System Properties and then click Next:

• System Name
• System ID (optional)
• System ID Prefix (optional): for example com.sapbusinessobjects
The "Defined Aliases" page is displayed.

6. Specify the alias for the system being configured and click Add > Next.
The alias specified will be used by other objects to refer to the system.
The alias can be identical to the System Name or System ID specified in
the previous step.
The "Template Properties" page is displayed.

7. Specify values for the following properties:
Under the "Connector" category:
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• Application Host
• Gateway Host
• Gateway Service (optional)
• Logical System Name
• SAP Client
• SAP System ID
• SAP System Number
• System Type: SAP_BW
Under the "User Management" category:
• Logon Method: SAPLOGONTICKET

Uncheck the Run connection test after click Next checkbox if you do
not want to test SSO connectivity to the SAP entitlement system.

8. Click Finish.
9. On the new system object you have created, clickProperties > All >

Show Category > Crystal Enterprise Server > Modify Properties.
10. Specify the following:

• Hostname of Crystal Enterprise Server - for example <hostname>:8080
• Path of Crystal Enterprise Server
• Protocol of Crystal Enterprise Server - for example HTTP

11. Click Save to submit and save all the modified properties.

Using URL iViews
URL iViews can be used to access Crystal and Web Intelligence Reports
based on SAP data sources. This type of iView leverages URL Reporting
capabilities through Business Objects' OpenDocument functionality. URL
reporting using OpenDocument provides URL access to multiple report types
passing a URL string to a BusinessObjects Enterprise server. OpenDocument
controls how reports are generated and displayed.

The OpenDocument resource files are by default available after
BusinessObjects Enterprise is installed. For further information refer to
BusinessObjects Enterprise documentation in the "Get More Help" section
of this guide.
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To configure a URL iView to access a report

You can use either the .NET or Java OpenDocument resources to create
your URL iVIew to create a report.

1. Provide the URL iView you are going to use to access the report.
For example, the URL iView for .NET:

http://hostname.domain.com:port/OpenDocument/open
doc/openDocument.aspx

For Java:

http://hostname.domain.com:port/OpenDocument/open
doc/openDocument.jsp

2. Add the following parameter values shown in the table below:

ValueURL Parameter

report's unique IDiDocID

Note:
The report's unique ID, can be found in the properties of a report in
InfoView.

Note:
Additional parameters can be appended to a URL Iview to define the
viewer, refresh options and many other parameters that are report-type
specific. For a full listing of these parameters see the Viewing Reports
and Documents using URLs document that is available on the support
site. For more information see the “Get More Help” section at the end of
this guide.

The URL iView is ready to redirect you from the SAP Enterprise Portal
to view your report in BusinessObjects Enterprise.

3. Click Preview to redirect to InfoView.
If single sign-on has been correctly configured, you should automatically
be logged into InfoView using your SAP credentials.
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To configure a URL iView to access InfoView

You can use either the .NET or Java OpenDocument resources to create
your URL iVIew to create a report.

1. Open your browser.
2. Type the URL used to access InfoView:

For Java use the following format:http://hostname.do
main.com:port/InfoViewApp

For .NET use:http://hostname.domain.com:port

3. Add the following three parameter values

Value to typeURL Parameter

three digit system IDsap_sysid

three digit client numbersap_client

two digit language codelanguage

4. Click Preview to redirect to InfoView.
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Configuring the BusinessObjects
Enterprise repository for Knowledge
Management and Collaboration (KMC)

SAP NetWeaver provides Knowledge Management & Collaboration (KMC)
capabilities via the SAP Enterprise Portal (SAP EP). SAP EP uses the
BusinessObjects Enterprise repository.

This section describes how to install, configure and maintain BusinessObjects
Enterprise repository in SAP Enterprise Portal (SAP EP). This information
is intended for the SAP EP administrator who is responsible for configuring
repository managers.

Quick reference: configuring the BusinessObjects
Enterprise repository for SAP EP

Administrators experienced with SAP EP and BusinessObjects Enterprise
may want to follow these steps to quickly configure Business Objects
Enterprise for knowledge management and collaboration. For more detailed
instructions, see the instructions that follow this quick reference.

1. Upload BusinessObjectsKM.par into SAP EP from the Administration
Console within Portal Runtime.

2. In the Repository Manager, create a new instance.
To save time, you can duplicate the existing one using the following steps:
a. Make sure Property Search Manager is Not Set.

This is because the Property Search Manager class in some SAP EP
deployments may prevent the BusinessObjectsKM.par from
starting properly.

b. Make sure the service "layout" is selected.
c. Specify the host and port of the CMS you want to connect to.
d. Replace WEB_SERVER_AND_PORT with the host and port of your

web server in the OpenDoc URL, Dispatch URL and web service URL.
e. Make sure the specified SAP System ID has been imported into the

CMS, and the certificate of the EP has been imported in this SAP
system.
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3. On the KM Content page, right-click the repository and choose Details
> Settings > Presentation on the context menu.

4. Click Select profile to select the BOBJELayout layout and select the
Apply settings to all subfolders check box.

To install the BusinessObjects Enterprise
repository

1. Log on to SAP EP with administrator rights.
2. Go to the Administration console (under System Administration > Support

> Portal Runtime), browse to the BusinessObjectsKM.par file and click
Upload.

Note:
After installing SAP IK, you can get the par file from %Business
Objects%/BusinessObjects Enterprise
12.0/java/applications (for Windows Installer) or on the CD (for
UNIX Installer).

3. To undeploy BusinessObjects Enterprise repository, return to the
Administration console, select BusinessObjectsKM.par, and click Clean.

Configuring the BusinessObjects
Enterprise repository

To configure BusinessObjects Enterprise repository, you need to configure
settings in SAP EP, BusinessObjects Enterprise, and an SAP BW system.

To understand why, consider the following workflow:

• When a user logs onto SAP EP, a logon ticket is issued by SAP EP.
• When the user clicks BusinessObjects Enterprise repository, the logon

ticket (and the configured SAP_System_ID and SAP_Client) is passed
to BusinessObjects Enterprise.

• The ticket is then validated against the SAP BW system specified by the
SAP_System_ID.

The following step procedures describe how to configure all of the
components involved in using the BusinessObjects Enterprise repository
with SAP EP.
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To configure SAPBWforBusinessObjects Enterprise
repository

To use the BusinessObjects Enterprise repository, you need to configure
the following settings in SAP BW.

1. Make sure the SAP BW system and SAP EP are in the same domain.
2. Make sure the user has the same name on the SAP EP and SAP BW

systems.

Note:
If the SAP EP user doesn’t exist in SAP BW system, create one.

3. Make sure the certificate of SAP EP has been imported into the SAP BW
system.
a. Go to System Administration > System Configuration > Keystore

Administration.
b. Select SAPLogonTicketKeypair-cert, clickDownload verify.der

File to local machine (verify.der.zip), and then unzip it.
c. In the SAP system where you want to authenticate the SAP EP user,

start transaction STRUSTSSO2.
d. Choose Import Certificate for the system PSE.
e. Browse to the downloaded verify.der and set the encoding to

binary.
f. Click Add to PSE and Add to ACL. In the new dialog box, the system

ID is the portal’s system ID (generally the same as CN), and client is
000.

g. After a successful log on to SAP EP, a user will get the MYSAPSSO2
cookie, which can be verified by the SAP system.

To configure BusinessObjects Enterprise for SAPEP

Before implementing the following instructions, make sure SAP EP and the
BusinessObjects Enterprise web application server are in the same domain.

1. Make sure the SAP BW system and role have been imported for the SAP
EP user:
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Add the SAP BW system as an entitled system in BusinessObjects
Enterprise.

a.

b. Import the corresponding role into BusinessObjects Enterprise.
c. In the BusinessObjects Enterprise repository configuration, specify

the names of the CMS and the SAP BW system ID.

2. To enable single sign-on when viewing a report, set opendoc.session
cookie.enabled to false in the web.xml file for the OpenDocument
web application.

3. To see localized error messages (optional):
a. Copy the following files to the dswsbobje/WEB-INF/lib folder on

your web server:
• ceresprops_LANG.jar
• federation_LANG.jar
• webreporting_LANG.jar
• ws-langpack-resource_LANG.jar

b. In the dswsbobje/WEB-INF/classes/langpacks.properties
file, set INSTALLEDLANGUAGES=LANG1,LANG2 and so on.

4. If you want users to be able to log onto the BusinessObjects Enterprise
web applications via HTTPS, follow these optional steps:
a. Download the certificate of BusinessObjects Enterprise Web Service.
b. Use the following command to import the certificate to a keystore:

%java_home%\bin\keytool -import -v -trustcacerts -
alias tomcat -file server.cer -keystore client.key
store -keypass password -storepass password

c. Put the keystore file in the SAP EP server.
d. In the configuration settings for BusinessObjects Enterprise in the

Repository Manager, specify the location and password of the keystore
file.

To configure the client

• Make sure all clients have cookies enabled.
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To configure SAPEP for BusinessObjects Enterprise
repository

1. Go to System Administration > System Configuration > Knowledge
Management >Content Management >RepositoryManagers, choose
the BusinessObjects Enterprise repository.

2. Specify the following items:

DescriptionSetting

The name of the CMS you want to connect to. One BusinessObjects Enterprise
repository instance maps to one BusinessObjects Enterprise CMS. To view
objects for multiple CMSs, create multiple BusinessObjects Enterprise repository
instances. For example: cms_host_name:port

CMS

The prefix of one instance, which will be displayed in the KM Content iview. For
example: /BOERM

Prefix

The SI_ID of the object in BusinessObjects Enterprise that you want to use as
the starting folder in KM. For example: 23

Starting folder
SID

The client number of the SAP BW system which is used for single sign-on.
Provide your 3-digit client number

SAP Client

The system ID of the SAP BW system which is used for single sign-on. Provide
your 3-digit System ID

SAP System
ID

Set to Yes to hide URL parameters from the user. This ensures that after a
document is launched, the browser address bar will not contain any encoded
credentials used to access the document.

Hide URL pa-
rameters when
viewing

The URL of Web Service provider for logging SAP EP user onto BusinessObjects
Enterprise. For example: http://Web-server:port/dswsbobje/services/

Web Service
URL

The URL to use for cleanup when the user clicks Logoff.

An example for Java:

http://host/PartnerPlatformService/service/app/logoff.do

An example for .NET:

http://host/PartnerPlatformService/Shared/Logon/Logoff.as
px

Logoff URL
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DescriptionSetting

The URL in BusinessObjects Enterprise for viewing an object or its latest in-
stance.

An example for Java:

http://host/OpenDocument/opendoc/openDocument.jsp

An example for .NET:

http://host/OpenDocument/opendoc/openDocument.aspx

OpenDoc URL

The URL in BusinessObjects Enterprise for performing tasks such as scheduling
objects and viewing an object's history.

An example for Java:

http://host/SAP/jsp/Action_Dispatch/dispatch.jsp

An example for .NET:

http://host/SAP/Action_Dispatch/Dispatch.aspx

Dispatch URL

The class name of the Property Search Manager. Make sure this is set to
Not Set.

Property
Search Manag-
er

Enable the required services.
• To enable BusinessObjects Enterprise-specific commands, select layout.
• To enable search, select properties.
• To enable collaboration, select the collaboration features you want to use.

(For example, comment, discussion, or rating.)
• To enable subscription, select subscription.

Repository
Services

The location of keystore file for connecting to CMS with the HTTPs web service.
See step 3 for additional configuration steps required for HTTPS.

Keystorefile

The password for the keystore. See step 3 for additional configuration steps
required for HTTPS.

Keystorepwd

Note:
• The CMS, Web Service URL, OpenDoc URL and Dispatch URL can

be on different machines.
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• Changes to the CMS, SAP_System_ID, SAP_Client and starting folder
ID settings will take effect when the user has logged off and logged
back on again.

3. If you want to use HTTPS for logon to BusinessObjects Enterprise, you
also need to perform the following optional steps:
a. Download the certificate of the BusinessObjects Enterprise Web

Service.
b. Import the certificate to a keystore using the following command:

%java_home%\bin\keytool -import -v -trustcacerts -
alias tomcat -fileserver.cer -keystore client.key
store
-keypass password -storepass password

c. Put the keystore file on the SAP EP server.
d. In the BusinessObjects Enterprise repository configuration settings,

specify the location and password of the keystore.

To configure the BusinessObjects Enterprise layout

To make BusinessObjects Enterprise properties and commands appear
properly, you need to change the layout set of your configured
BusinessObjects Enterprise repository to the BusinessObjects Enterprise
layout.

1. Go to Content Administration > KM Content, right-click the
BusinessObjects Enterprise repository and choose Details from the
context menu.

2. On the "Details" page, click Settings > Presentation, then click Select
Profile and choose "BOBJELayout".

3. To apply the layout to all folders in the repository, check Apply settings
to all subfolders.

4. Click Save.
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Configuring collaboration

The collaboration feature allows users to easily discuss objects stored in
BusinessObjects Enterprise. Collaboration features include comments,
discussions, feedback, personal notes and rating.

To enable the collaboration features for your users, select the features you
want in the BusinessObjects Enterprise repository settings in Content
Management > Repository Managers.

Configuring subscription

Subscription notifies users who have subscribed to a folder or document on
changes to it. The notification can be sent via email or SMS. You can also
set subscription to send notifications at certain intervals or according to
certain events.

The requirements for subscription are:

• The subscription service is enabled for the BusinessObjects Enterprise
repository in Content Management > Repository Managers.

• The user has chosen to Subscribe the BusinessObjects Enterprise
repository.

• Your mail server or SMS server has been configured to allow subscription.

TomaintainBusinessObjecets Enterprise
repository instances

1. Go to System Administration > System Configuration > Knowledge
Management > Content Management > Repository Managers, and choose
the BusinessObjects Enterprise repository.
A predefined instance of the BusinessObjects Enterprise repository
appears. You can modify the predefined instance or create a new one.

2. To create a new instance:
a. Click New.
b. Provide the required information and click OK.
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For more information about these settings, see To configure SAP EP
for BusinessObjects Enterprise repository.

3. To modify an existing instance:
a. Select an instance and click Edit.
b. Modify the settings you want to change.

Note:
All changes except Repository Services settings can take effect
immediately. (Changes to Repository Services require the J2EE server
to restart.)

Using the BusinessObjects Enterprise
Knowledge Management and
Collaboration (KMC) solution

This section describes how to use a Business Objects Repository in SAP
EP. It includes procedures for logging on, navigating, viewing, scheduling,
creating, copying, moving, downloading, subscribing, searching, and
troubleshooting.

Logging on and off
After the SAP Enterprise Portal (SAP EP) administrator has configured a
BusinessObjects Enterprise Repository, SAP EP users should be able to
access this repository through the Knowledge Management (KM) content or
through a KM iView using single sign-on.

To log off, click Logoff on either the View menu or the BusinessObjects
menu. If you do not log out, the sessions will be automatically terminated
according to the timeout settings.

Navigation
You can navigate to a folder using the breadcrumb navigation, which appears
at the top of the screen, or using the tree list on the left.
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You can browse through all folders of the CMS specified in the
BusinessObjects Enterprise repository that you have access to. After entering
the BusinessObjects Enterprise repository, you should see three folders:

• Inbox

Your personal inbox.

• My Favorites

Your Favorites folder.

• <Starting_Folder_Name>

The starting folder is seen as Root folder within KM content. However
you may define any subfolder to the Root folder (Public Folder) in you
KM iView

If you have changed the navigation type to By Category, two categories
should appear in the first level:

• Personal Category

• Corporate Category

To change navigation settings

You must be logged onto BusinessObjects Enterprise repository.

• To change the navigation type, click View, and then click By Folder or
By Category.

After changing navigation type, you will be redirected to the original page
of KM Content.

Note:
The default navigation type is By Folder. If you change your navigation
type, you will browse folders by that navigation type during your current
BusinessObjects Enterprise session. The navigation type will be reset to
By Folder when you log off.
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Performing common tasks
Most common tasks can be performed using either commands in the menus
or using the context menus for individual objects.

The following table provides a list of common commands, with descriptions
and links to additional resources.

DescriptionTask

Click Folder>Refresh to get the latest view of BusinessObjects
Enterprise information. If there are any changes to the folder
that you are browsing, they will appear when you clickRefresh.

Refresh

Click the context menu of an object and chose View to view
the object on demand. The content appears in a new window.

Note:
This command does not apply to folder objects.

View

If an object has been scheduled and has at least one successful
instance, you can click the View Latest Instance command
to view the most recent successful instance. The content ap-
pears in a new window.

Note:
This command does not apply to folder objects.

View latest in-
stance

Click Schedule to schedule a new instance of an object. The
Schedule command appears in the context menu for an object
if it can be scheduled (for example, a Crystal report or a Web
Intelligence document), and if you have the right to schedule
it.

Schedule

Click History to view a history of an object's scheduled in-
stances. The History command appears in the context menu
for an object if it contains instances.

History

Click Goto > MyInfoView to open MyInfoView in a new win-
dow.

MyInfoView

For more information, see To create a document.Create

You can copy or move documents or folders from one reposi-
tory to another. For more information, see To copy or move
documents.

Copy / Move
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DescriptionTask

You can delete documents or folders in the BusinessObjects
Enterprise repository. For more information, see To delete
a document.

Delete

Click the context menu of an object and choose Details to
see detailed information about the object, including name,
description, the last date the object was run, and the size
of the object. The Details page also shows collaboration
information for the object, if the collaboration service has
been enabled for the repository. For more information on
collaboration, see Collaboration.

Details

To download a copy of an object to your local machine, click
the context menu of the object and choose Download.

Download

Note:
More advanced user tasks are discussed in Performing advanced tasks.

To create a document

You can create new objects, such as Desktop Intelligence, Voyager, and
Web Intelligence documents, and save them to BusinessObjects Enterprise.

Note:
You can also upload document types such as Crystal reports, text files, and
Microsoft documents to BusinessObjects Enterprise.

• To create a new document, click Folder > New, and then choose the
type of document you want to create.

A new window will appear where you can configure the new document.

To copy or move documents

You can copy or move documents or folders from one repository to another.
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Note:
If a folder is copied or moved, the objects in the folder are also copied or
moved in the BusinessObjects Enterprise Repository. For some SAP EP
repositories, the name of the source object cannot be passed. In this case,
the CUID of the new object in BusinessObjects Enterprise is used as its
name.

1. Select the check box next to each document that you want to copy or
move.

You can select multiple checkboxes in order to copy or move multiple
documents.

2. Click the Selection menu, then click Copy or Move.

Note:
If you have insufficient rights to perform the move or copy action, an error
message appears.

To delete a document

You can delete documents or folders in the BusinessObjects Enterprise
repository.

Note:
If you delete a folder, its contents are also deleted.

1. Select the check box next to each document that you want to delete.

You can select multiple checkboxes in order to delete multiple documents.

2. Click the Selection menu, then click Delete.

Note:
To delete a single object, you can right-click it and choose Delete from
the context menu.

Note:
If you do not have the appropriate rights to delete objects, you may receive
an error message.
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Performing advanced tasks
The following tasks may require additional administrative settings. Contact
your system administrator for more information.

Search

If the Search service is enabled within the BusinessObjects Repository, you
can search a folder by clicking the context menu of the folder and choosing
Search from here.

A new window opens where you can type keywords to search for. The search
is a "fuzzy" search, based on the properties of the objects.

Subscribe

You can subscribe to a document or folder to be notified at certain intervals
of changes that occur, such as document creation, edits, or deletions.

This feature is available to users only if the subscription service is enable on
the BusinessObjects Enterprise Repository.

To subscribe to a document or folder, click the its context menu and choose
Subscribe. A new window appears where you can configure the subscription
settings.

These Subscribe command is also available on the Details page of an object.
For information on how to navigate to the Details page, see Performing
common tasks .

Collaboration

The collaboration feature allows you easily discuss objects. To initiate a
collaboration about an object, click context menu of the object and choose
one of the collaboration commands:

• Give Feedback. This option is like a review, but is visible only to the
feedback writer and the object author.
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• Start a discussion.
• Rate. Select a rating level (Excellent, for example).
• Write a review. This option is visible to all users.

These commands are also available on the Details page of an object. For
information on how to navigate to the Details page, see Performing common
tasks .
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Defining Security for the
Open SQL driver

9



This section shows how to use the Security Definition Editor to define
table-level and row-level security for specific SAP tables when you access
them using the Open SQL driver. The Security Definition Editor enables you
to maintain your current SAP security levels when you deploy the Open SQL
driver.

Security Definition Editor overview
When you deploy the Data Access component and distribute the database
drivers, you allow SAP users to access the data stored within your SAP R/3,
mySAP ERP, and BW systems. By default, the Open SQL driver provides
an open reporting environment where there are no data access restrictions.
(You can, however, easily reverse this default behavior with the Security
Definition Editor's Global Lock feature, which initially restricts users from
accessing all SAP tables. For details, see Choosing your table-level security
model.)

If you need to deploy a security model that regulates users' access to SAP
data, use the Security Definition Editor (transaction /CRYSTAL/RLS) to
restrict data access at the table level and at the row level. The Security
Definition Editor defines security for transparent tables, pool tables, cluster
tables, and tables containing data clusters (for instance, PCL2). The
restrictions that you specify are enforced whenever a user attempts to connect
to SAP with the Open SQL driver, whether to design, refresh, or schedule a
Crystal report. Thus, in order to design, refresh, or schedule a Crystal report
against R/3, mySAP ERP or BW, users require access to all of the tables
referred to by the report.

Data access restrictions that you define using the Security Definition Editor
are applied on a per-client basis. That is, the restrictions you apply affect all
users who access SAP using the same client used to define the restrictions.

In previous versions of BusinessObjects XI Integration for SAP, data access
restrictions were client-independent. To preserve restrictions that you defined
using earlier versions of this tool, follow the instructions in Migrating your
existing security model before continuing.

Note:
The Security Definition Editor is provided by the Security Definition Editor
transport, which you import into your SAP system when you set up the Data
Access. For details, see Configuring transports.
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Migrating your existing security model
To continue to use the data access restrictions that you defined using a
previous version of BusinessObjects XI Integration for SAP (using the ZRLS
transaction), you can import these restrictions into client-dependent form
using /CRYSTAL/RLS. Import these data restrictions before using
/CRYSTAL/RLS to create or modify additional restrictions. Any changes you
made using /CRYSTAL/RLS will be overwritten when you import the global
restrictions.

To apply your global data access restrictions to additional clients, import
these restrictions once for each client.

To migrate data access restrictions

1. Enter the transaction /CRYSTAL/RLS in your SAP system.
2. Under the Extras menu, select Import Global Data.

A dialog appears, warning you that importing these restrictions will
overwrite any restrictions you have defined using /CRYSTAL/RLS.

3. Click Yes.

Your global, client-independent data access restrictions are imported.

Choosing your table-level securitymodel
For enhanced flexibility, the Security Definition Editor provides a Global Lock
feature, which allows you to define the basis of your data access security
model in one of two ways:

• Global Lock disabled

This open security model initially provides all users with access to all
tables. To customize the model to match your current SAP security
configuration, you can prevent users from accessing particular tables on
a table-by-table basis. When you first deploy the Data Access , the Global
Lock is disabled by default.

• Global Lock enabled
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This closed security model initially denies all users access to all tables.
To customize the model to match your current SAP security conventions,
you can authorize users to access particular tables on a table-by-table
basis. Additionally, you can specify a list of custom functions that users
can still report off when the Global Lock is enabled. For details, see
Customizing authorizations for specific functions for details.

Once you have enabled or disabled the Global Lock, you can refine the
security model by customizing data access authorizations for particular tables.
For details, see Customizing authorizations for specific tables.

To enable/disable the Global Lock

1. From the SAPGUI, execute transaction /CRYSTAL/RLS.

The "Security Definition Editor" appears.

2. You now have two options:
• If you want to enable the Global Lock, select the Allow access only

to the tables specified above option.

• If you want to disable the Global Lock, ensure that the Allow access
only to the tables specified above option is not selected.

Now that you've chosen an open or closed basis for your security model,
you can customize authorizations for particular users and tables, thereby
allowing or disallowing data access in order to match your SAP security
conventions.

Customizing authorizations for specific
tables

Whether you have enabled or disabled the Global Lock feature, you may
need to customize the data access authorizations for one or more SAP tables.
If the Global Lock is enabled, you will need to allow all or some users to
access particular tables. (Otherwise, users will be unable to design or refresh
reports against the SAP system.) Alternatively, if the Global Lock is disabled,
you may need to prevent all or some users from accessing tables that contain
sensitive data.
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In either case, whether you want to secure a table or to permit access to a
table, you must use an authorization object for that purpose. (You can
customize a new authorization object, or reuse an existing one.) Then, using
the Security Definition Editor, you associate the authorization object with the
table in question. Finally, you incorporate the new authorization object into
your current configuration of user profiles or roles.

Essentially, by associating an authorization object with an SAP table, you
define that table as an exception to the Global Lock settings that you have
made within the Security Definition Editor. In other words, once you've
associated an authorization object with a table, that table is withheld from
all users—regardless of your Global Lock settings. You must then use the
authorization object according to your usual SAP security conventions in
order to provide particular users with access to the SAP table.

To customize authorizations for a specific table

1. Create a new authorization object.

For this example, create an authorization object called ZTABCHK that
consists of one authorization field called TABLE. The ZTABCHK
authorization is being used to secure the VBAK table from all but a
particular subset of users.

Note:
Use transaction SU21 to create the authorization object, or see the SAP
Help for more information on creating authorization objects.

2. From SAP, execute transaction /CRYSTAL/RLS.

The "Security Definition Editor" screen appears.

You will now associate your new authorization object with an SAP table.

3. In the Table name field, type the name of the table whose security
definition you will customize.

For this example, type VBAK.

4. Click Create.

The "Authorization entries" screen appears

5. Click Create.
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The "Authorization Object entry" dialog box appears.

6. Click Reference to an authorization object.

For details on the second option—Reference to an already defined table
or group—see Defining table authorizations by group. Click OK.

The "Authorization Object entry" screen appears.

7. In theAuthorization object name field, type the name of the authorization
object that you created in step 1.

For this example, type ZTABCHK.

8. Click Create.

The "Authorization field values" screen appears.

9. In the Field value list, type the name of the table whose security definition
you want to customize.

For this example, type VBAK.

10. Click Save.

You have now associated your customized authorization object with a
specific SAP table.

11. Exit the Security Definition Editor.
12. Following your usual procedure, incorporate the new authorization object

into your configuration of user profiles or roles.

For instance, following this example, you would apply the ZTABCHK
authorization object to the subset of users who need to access the VBAK
table.

Depending on the version of R/3 or mySAP ERP that you are using, and
the SAP authorization model that you have already deployed, you can
accomplish this in various ways:

• Attach the new authorization object to a new role that you in turn add
to each user's security profile.

• Attach the new authorization object to a new profile that you in turn
add to each user's security profile.
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The end result is that the authorization is added to the master user data,
so the database drivers can adhere to your customized data access
restrictions.

Note:
Regardless of the method you use, ensure that your new authorization
holds the name of the correct database table in its TABLE field value. In
this example, the VBAK table must be specified.

Customizing authorizations for specific
functions

When the Global Lock feature is disabled, report designers essentially have
the freedom to call any function on the SAP system. To restrict the functions
available to report off, enable the Global Lock. This restricts users from calling
any functions on the SAP system. In the /CRYSTAL/AUTHFCN table, you
can specify a list of functions that are exceptions to the Global Lock. That
is, you can specify a list of functions that users are able to call. To access
the list of functions, use the /CRYSTAL/RLS tool and go to Extras > Function
modules.

Defining table authorizations by group
The Security Definition Editor provides two ways for you to quickly define
table authorizations for tables that require similar levels of security:

• You can reference a table to any other table whose data access
authorizations you have already defined.

The Reference to an already defined table or group option is provided
in the "Select authorization entry type" screen, which appears in the
Security Definition Editor when you create an authorization entry for a
table.

• You can reference multiple tables to a group table that acts as a security
template.

To create a group table, execute transaction /CRYSTAL/RLS and specify
a nonexistent table name in the Editor. (When the specified table does
not exist, the Editor assumes instead that you are creating a group or
template.) The main screen listing all the definitions will show the table
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type as group. You can now share security levels by referencing existing
tables to this security template.

Applying row-level security
Sometimes table-level security does not allow you to secure data in a way
that corresponds with the security privileges of your SAP users: you may
need to grant all users access to a particular table, while at the same time
limiting a subset of those users to a certain portion of the table's data. To
accomplish this, use the Security Definition Editor to define an additional
level of security for the individual rows of data.

In general, row-level security is based on a particular field within a table. For
instance, you might need to prevent users from seeing data for all customers
within a Sales table. To enable this type of restriction, you create an
authorization object and use the Security Definition Editor to associate the
object with the Customer field in the Sales table. Then, when you apply the
new authorization object to each user's profile or role, you specify the
Customer values for those customers whose Sales records the user is
permitted to view. When the user designs or refreshes reports against the
Sales table, data is returned only for those customers that you have specified.

Essentially, by associating an authorization object with a field within an SAP
table, you define that table as an exception to the Global Lock settings that
you have made within the Security Definition Editor. In other words, once
you've associated an authorization object with a field, the parent table is
secured from all users—regardless of your Global Lock settings. You must
then use the authorization object according to your usual SAP security
conventions in order to provide particular users with access to rows of data
within the SAP table.

You can secure rows in a table by using authorization objects, custom
functions, or both.

Securing rows using authorization objects

In order to define row-level security for tables, you can create an authorization
object and use the Security Definition Editor to associate the object with one
of the table's fields. You then apply the new authorization object to the roles
or profiles of SAP users who need to access any of the table's data. When
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you apply the authorization object, you specify the rows of data that each
user is permitted to access.

To define row-level security using an authorization object

1. Create a new authorization object.

For this example, create an authorization object called Z_BUKRS that
consists of one authorization field called BUKRS. This authorization is
being used to secure the GLT0 table based on the values in the BUKRS
(Company Codes) field.

Note:
Use transaction SU21 to create the authorization object, or see the
SAPGUI Help for more information on creating authorization objects.

2. Execute transaction /CRYSTAL/RLS to access the Security Definition
Editor.

3. In the Table name field, type the name of the table that contains the rows
you want to secure.

For this example, type GLT0.

Note:
You can now use wildcards to specify the table name. This is an efficient
way to apply an authorization to multiple tables with similar names
simultaneously. Use * to specify zero or more characters and + to specify
one character.

4. Click Create.
5. In the "Authorization entries" screen, click Create.
6. In the "Select authorization entry type" screen, click Reference to an

authorization object.
7. Click OK to access the "Authorization Object entry" screen.
8. In theAuthorization object name field, type the name of the authorization

that you created in step 1.

For this example, you would type Z_BUKRS.

9. Click Create.

The "Authorization field values" screen appears.
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10. In the Field value list, type the equals sign (=) and the name of the field
that you want to secure.

For this example, you would type =BUKRS.

Tip:
To view a list of available fields, right-click the Field value list and, on the
shortcut menu, click Possible entries. Double-click the desired field (in
this case, BUKRS) to insert it along with the required equals sign (=).

11. Click Save.
12. Exit the Security Definition Editor.
13. Following your usual procedure, apply the new authorization object to the

profiles or roles of the appropriate users.

For instance, following this example, you would apply the Z_BUKRS
authorization object to each user who needs to access rows of data within
the GLT0 table. When you apply the authorization object, you enter the
appropriate Company Code values into the BUKRS authorization field,
thereby specifying the Company Codes that the specified user is
authorized to access.

Depending on the version of R/3 or mySAP ERP that you are using, and
the SAP authorization model that you have already deployed, you can
accomplish this in various ways:

• Attach the new authorization to a new role that you in turn add to each
user's security profile.

• Attach the new authorization to a new profile that you in turn add to
each user's security profile.

The end result is that the authorization is added to the master user data,
so the database drivers can adhere to your customized data access
restrictions.

Securing rows using custom security exits

In addition to, or instead of using authorization-based restrictions for tables,
you can secure rows using custom security exits. That is, you can map table
fields to function parameters so that you can define the call to one function
to handle the post filtering for any table.
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Note:

• You must give a value (either constant or field-mapped) for all non-optional
parameters.

• Make mappings between compatible types. For example, do not link a
function parameter for a date to a number field. Mapping incompatible
types results in a failure at runtime.

The following example shows how to map table fields to function parameters
in a custom security exit.

To define row-level security using a custom security exit

1. Execute transaction /CRYSTAL/RLS.
2. In the Table name field, type the name of the data table whose rows you

want to secure.

For this example, type PA0000 to secure the rows in that table.

Note:
You can now use wildcards to specify the table name. This is an efficient
way to apply an authorization to multiple tables with similar names
simultaneously. Use * to specify zero or more characters and + to specify
one character.

3. Click Create.

The "Authorization entries" screen appears.

This screen lists the authorization entries (if any) that are currently applied
to the table.

4. Click Custom exit.

The "Edit custom function security exit mappings" window appears.

5. In the Function name field, type the name of the function that you want
to use to secure the table, and then click Transfer.

For this example, type HR_CHECK_AUTHORITY_INFTY.

6. For each necessary parameter, specify a value or field to map to that
parameter.

In this example make the entries listed in the table below:

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 171

9Defining Security for the Open SQL driver
Applying row-level security



Field nameImported parameter name

'0000'INFTY

=PERNRPERNR

=SUBTYSUBTY

7. Click Save.

You are returned to the "Authorization entries" screen, which now indicates
that there is an active custom security exit for this table.

When a user attempts to access a table secured by a custom security
exit, the driver checks the appropriate field(s) in the table. The field values
you mapped are passed as parameters to the function you selected, in
this example HR_CHECK_AUTHORITY_INFTY. When authorization
restrictions are combined with the values you mapped, the authorization
restrictions filters the results first, and then the mapped values further
filter the results.
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Understanding communication between
BusinessObjects Enterprise components

This chapter shows what ports are used for communication specifically
between BusinessObjects XI Integration for SAP Solutions and SAP systems
when configuring to work with firewalls. You need to configure
BusinessObjects Enterprise system to work in a firewalled environment first,
for detailed information about this, please refer to “Working with Firewalls”
section in SAP BusinessObjects Enterprise Administrator's Guide.

Guidelines for communication with
BusinessObjects XI Integration for SAP
Solutions

BusinessObjects Enterprise components include browser clients, rich clients,
servers, and the BusinessObjects Enterprise SDK hosted in the Web
Application server. BusinessObjects Integration for SAP Solutions
components can be distributed installed on the appropriate machines. It is
helpful to understand the basics of communications with BusinessObjects
Integration for SAP Solutions components before configuring your
BusinessObjects Enterprise system to work with firewalls. Deployments of
BusinessObjects Integration for SAP Solutions must conform to these general
communication rules:

• The CMS (along with Security components) must be able to initiate
communication with SAP system on SAP System Gateway port.

• The Crystal Reports Job Server and Crystal Reports Processing Server
(along with Data Access components) must be able to initiate
communication with SAP system on the SAP System Gateway port.

• The BW Publisher component must be able to initiate communication
with the SAP system on the SAP System Gateway port.

• BusinessObjects Integration for SAP Solutions components deployed on
the SAP Enterprise Portal side (for example, iView and KMC) must be
able to initiate communication with BusinessObjects Enterprise web
applications on HTTP/HTTPS ports.

• The web application server must be able to initiate communication on the
SAP System Gateway service.
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• Crystal Reports must be able to initiate communication with the SAP host
on the SAP System Gateway port and SAP System Dispatcher port.

The port that the SAP Gateway service is listening on is the same as that
specified in the installation. For more details about SAP Gateway service,
consult your SAP documentation.

Note:
If a BusinessObjects Enterprise component requires an SAP router to connect
to an SAP system, you can configure the component using the SAP router
string. For example, when configuring an SAP entitlement system to import
roles and users, the SAP router string can be substituted for the application
server’s name. This insures that the CMS will communicate with the SAP
system through the SAP router.

Detailed port requirements for the
BusinessObjects Integration for SAP
Solutions

This section lists the requirements for communication with BusinessObjects
Integration for SAP Solutions. If you deploy BusinessObjects Enterprise with
firewalls, you can use this information to open the minimum number of ports
in those firewalls necessary for BusinessObjects Integration for SAP
Solutions.

Port requirements for BusinessObjects Enterprise servers

The following ports are required for their corresponding servers in
BusinessObjects Enterprise:

• Central Management Server Name Server port
• Central Management Server Request port
• Input File Repository Server Request port
• Output File Repository Server Request port
• Report Application Server Request port
• Crystal Reports Cache Server Request port
• Crystal Reports Processing Server Request port

For detailed information about how to configure your BusinessObjects
Enterprise system to work in an environment with firewalls, see the “Working
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with Firewalls” chapter in the SAPBusinessObjects Enterprise Administrator's
Guide.

Port requirements for SAP

BusinessObjects Integration for SAP Solutions uses the SAP Java Connector
(SAP JCO) to communicate with the Enterprise Resource Planning side.
You require these ports:

• SAP Gateway service listening port (for example, 3300).
• SAP Dispatcher service listening port (for example, 3200).

The following table summarizes the specific port configurations that you
need.
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ActionPortDestination com-
puter

PortSource
computer

AllowWeb Service
HTTP/HTTPS port

BusinessObjects
Enterprise Web
Application Server

AnySAP

AllowCMS Name Server portCMSAnySAP

AllowCMS Requested portCMSAnySAP

AllowSAP System Gateway
Service port

SAPAnyWeb Appli-
cation Serv-
er

AllowSAP System Gateway
Service port

SAPAnyCentral
Manage-
ment Server
(CMS)

AllowSAP System Gateway
Service port and SAP
System Dispatcher port

SAPAnyCrystal Re-
ports

Example: BusinessObjects Enterprise servers
separated from SAP by a firewall

This example shows how to configure a firewall for BusinessObjects
Enterprise and SAP to work together in a deployment where separated by
a firewall. In this deployment scenario, BusinessObjects Enterprise and
BusinessObjects Integration for SAP Solutions components are deployed
across these machines:

• Machine boe_1 hosts the Web Application Server and the BusinessObjects
Enterprise SDK.

• Machine boe_2 hosts the back-end servers, including the Central
Management Server, the Input File Repository Server, the Output File
Repository Server, the Crystal Reports Cache Server, Crystal Reports
Job Server, Web Intelligence Job Server, Web Intelligence Report Server,
Report Application Server, and the Crystal Reports Processing Server.

• Machine sap hosts the SAP system, which communicates with
BusinessObjects Enterprise through BusinessObjects Integration for SAP
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Solutions. In this example, the SAP System Gateway Service port is 3300
and the SAP System Dispatcher port is 3200.

To configure this example, you require the following:

1. Communication prerequisites:

• The CMS (along with Security components) must be able to initiate
communication with SAP system on SAP System Gateway port.

• The Crystal Reports Job Server and Crystal Reports Processing Server
(along with Data Access components) must be able to initiate
communication with the SAP system on the SAP System Gateway
port.

• The BusinessObjects Integration for SAP Solutions components
deployed on the SAP Enterprise Portal side (for example, iView and
KMC) must be able to initiate communication with the BusinessObjects
Enterprise web applications on HTTP/HTTPS ports.

• The web application server must be able to initiate communication on
the SAP System Gateway service.

2. The web application server must communicate with all Business Objects
Enterprise servers on machine boe_2. Configure the port numbers for
each server on these machines. Note that you can use any free port
between 1,025 and 65,535.
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The port numbers chosen for this example are listed in the following table.

Port numberServer

6411Central Management Server

6415Input File Repository Server

6420Output File Repository Server

6425Crystal Reports Cache Server

6430Crystal Reports Job Server

6435Web Intelligence Processing Server

6440Report Application Server

6445Crystal Reports Processing Server

3. Configure the firewalls Firewall_1 and Firewall_2 to allow communication
to the fixed ports on the BusinessObjects Enterprise servers and the web
application server that you set in BusinessObjects Enterprise, and Fire
wall_3 to allow communication between the BusinessObjects Enterprise
system and SAP system.

In this example, you open the HTTP port for the Tomcat application server.

Table 10-1: Configuration for Firewall_1

ActionPortDestination
computerPort

Allow8080boe_1Any

Table 10-2: Configuration for Firewall_2

ActionPortDestination
computerPortSource

computer

Allow6410boe_2Anyboe_1

Allow6411boe_2Anyboe_1
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ActionPortDestination
computerPortSource

computer

Allow6415boe_2Anyboe_1

Allow6420boe_2Anyboe_1

Allow6425boe_2Anyboe_1

Allow6430boe_2Anyboe_1

Allow6435boe_2Anyboe_1

Allow6440boe_2Anyboe_1

Allow6445boe_2Anyboe_1

Table 10-3: Configuration for Firewall_3

ActionPortDestination
computerPortSource com-

puter

Allow3300sapAnyboe_1

Allow3300sapAnyboe_2
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This section describes some common installation and configuration issues
in order to assist you in troubleshooting your BusinessObjects XI Integration
for SAP Solutions implementation.

Locating and generating log files
You can create and view several log files to help determine the cause of
errors. The core BusinessObjects Enterprise server components log
information by default to the logging directory of your BusinessObjects
Enterprise installation.

To enable logging for your SAP drivers, go to
HKEY_LOCAL_MACHINE\SOFTWARE\Business Objects\Suite
12.0\SAP and create a new string key called TraceDir (this name is
case-sensitive). Set trace dir directory (such as c:\sapikLog\) as the
registry value. Then, change the trace level from No to Yes for each
component that you want to enable logging for.

DisablingSAPentitlement systems in the
CMC

In the CMC, you can temporarily disable a connection between
BusinessObjects Enterprise and an SAP entitlement system. This may be
useful to maintain the responsiveness of BusinessObjects Enterprise in cases
such as the scheduled down time of an SAP entitlement system.

To temporarily disable a connection to an SAP
entitlement system

1. In the CMC, go to the Authorization management area.
2. Double-click the SAP link.
3. In the Logical system name list, select the system you want to disable.
4. Select the Disabled check box.
5. Click Update.
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Note:
See the SAP BusinessObjects Enterprise Administrator's Guide for a number
of sections devoted to general system troubleshooting, such as web server
configuration, path mapping, report processing, and so on. You can download
our product documentation from our customer support site: http://support.busi
nessobjects.com/documentation/product_guides/default.asp .

Reports, tables, and functions

If the SAP data source does not appear when you create a new report, there
may be a problem with the driver installation, or required files may have been
deleted since installation. Run the Crystal Reports–SAP Edition installation
again.

Errors when connecting to SAP

If an error message indicates that the RSAQ_REMOTE_FUNCAREA_CATALOG
function module was not found, you may be trying to use the InfoSet driver
to access a system that is older than R/3 4.6c. The InfoSet driver is supported
only for versions 4.6c and later of SAP R/3 and for mySAP ERP.

Viewing document and reports
If an InfoView user recognizes any of the following symptoms when using
the InfoView, it means that the partnercafinstall.bat file was not run
when you installed BusinessObjects Integration for SAP Solutions.
• in the "Document List", the My Group folder does not appear.
• In the "Document List", every SAP multilingual report appears, instead

of the specific reports based on the user's Preferred Viewing Locale
setting.

• When viewing an SAP report that uses parameters, Online Prompting
does not appear.

• When scheduling an SAP multilingual report, the "Languages" section
does not appear on the "Schedule" page.

• When scheduling an SPA report that uses parameters, the "Parameters"
section does not appear on the "Schedule" page.
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• On the "History" page for an SAP report, the Show all instances
scheduled in all languages checkbox does not appear.

If a user recognizes any of these symptoms, manually run the partner
cafinstall.bat or partnercafinstall.sh file, depending on you
environment.

To run the partnercafinstall command

1. Locate the partnercafinstall file.
• On a Windows computer, the partnercafinstall.bat file is

located at<INSTALL_DIR>common\4.0\java\lib\, where <IN
STALL_DIR> is the folder where BusinessObjects Enterprise is
installed.

• On UNIX, the partnercafinstall.sh is located at $BOB
JEDIR/bobje/java/lib/, where $BOBJEDIR is an environment
variable that identifies the root folder where BusinessObjects Enterprise
is installed.

2. Run the appropriate script, using BOE_PASSWORD as a parameter, where
BOE_PASSWORD is the administrative password.
• On Windows, run partnercafinstall.bat BOE_PASSWORD.
• On UNIX, run partnercafinstall.sh BOE_PASSWORD .
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This section lists the names and contents of the transports that are included
on the installation CD. Also read the transports_EN.txt file located in
the transports directory on the installation CD. This text file lists the names
of the files that make up each transport.

Note:

• For NetWeaver 7.0.2 or higher, several transports will be included as part
of NetWeaver. If you are only using NetWeaver BI integration, you will
not have to import any transports into NetWeaver to enable the SAP
Integration Product. The transports included with NetWeaver are listed
below.
• Authentication Transport
• Authentication Helper Transport
• Content Administration Workbench
• BQ Query Parameter Personalization Transport
• BW MDX Connectivity Transport

• If you download the integration for SAP solutions from the self-extraction
file on the SAP Service Market Place Web site, the transport files
discussed in this chapter are extracted to the following locations:
• On Windows, to the system temp folder %Temp%\Transports
• On Unix, to the installer extraction destination folder

Overview
BusinessObjects XI Integration for SAP includes nine transports: the Open
SQL Connectivity transport, the InfoSet Connectivity transport, the Row-level
Security Definition transport, the Cluster Definition transport, the
Authentication Helpers transport, the Content Administration Workbench,
the BW Query parameter personalization transport, the MDX transport, and
the ODS transport.

The contents of each transport are listed here. To determine which transports
you need to import, see Configuring transports.

There are two different sets of the transports: Unicode compatible transports
and ANSI transports. If you are running a BASIS system of 6.20 or later, use
the Unicode compatible transports. If you are running a BASIS system earlier
than 6.20, use the ANSI transports. The transports_EN.txt file located
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in the transports directory on the installation CD lists the Unicode
compatible and ANSI transport files.

Note:
When checking for possible installation conflicts, ensure that none of the
object names already exists in your SAP system. Objects use a /crystal/
namespace by default, so it is not necessary to create this namespace
yourself. If you do create the /crystal/ namespace manually, you will be
prompted for license repair keys that you cannot access.

Open SQL Connectivity transport

The Open SQL Connectivity transport enables the drivers to connect to and
report off the SAP system.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

Open SQL functionsFunction group/CRYSTAL/OPENSQL

Helper programProgram/CRYSTAL/OS
QL_AUTH_FORMS

Helper programProgram/CRYSTAL/OSQL_EXE
CUTE

Helper programProgram/CRYSTAL/OS
QL_TYPEPOOLPROG

Helper programProgram/CRYSTAL/OS
QL_TYPEPOOLS
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DescriptionTypeObject

Helper programProgram/CRYSTAL/OS
QL_UTILS

Reporting authorization
objects

Authorization object
classZSSI

Reporting authorization
objectAuthorization objectZSEGREPORT

Cluster meta dataTable
/CRYSTAL/OS
QL_CLU_ACTKEY_EN
TRY

Function meta dataTable/CRYSTAL/OS
QL_FCN_PARAM

Function meta dataTable/CRYSTAL/OS
QL_FCN_PARAM_FIELD

Table meta dataTable/CRYSTAL/OS
QL_FIELD_ENTRY

Table meta dataTable/CRYSTAL/OSQL_OB
JECT_ENTRY

RLS meta dataTable/CRYSTAL/OS
QL_RLS_CHK_ENTRY

RLS meta dataTable/CRYSTAL/OS
QL_RLS_FCN_ENTRY
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DescriptionTypeObject

RLS meta dataTable/CRYSTAL/OS
QL_RLS_VAL_ENTRY

Cluster meta dataTableZCLUSTDATA

Cluster meta dataTableZCLUSTID

Cluster meta dataTableZCLUSTKEY

Cluster meta dataTableZCLUSTKEY2

RLS meta dataTable/CRYSTAL/AUTHCHK

RLS meta dataTable/CRYSTAL/AUTHFCN

RLS meta dataTable/CRYSTAL/AUTHKEY

RLS meta dataTable/CRYSTAL/AUTHOBJ

RLS meta dataTable/CRYSTAL/AUTHREF

Old RLS meta dataTableZSSAUTHCHK

Old RLS meta dataTableZSSAUTHOBJ

Old RLS meta dataTableZSSAUTHKEY
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DescriptionTypeObject

Old RLS meta dataTableZSSAUTHREF

Old RLS meta dataTableZSSAUTH FCN

InfoSet Connectivity transport

The InfoSet Connectivity transport enables the InfoSet driver to access
InfoSets. This transport is compatible with R/3 4.6c and later. Do not import
this transport if you are running R/3 4.6a or earlier.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

InfoSet wrapper func-
tionsFunction group/CRYSTAL/FLAT

Batch mode executionProgram/CRYS
TAL/QUERY_BATCH

Streaming batch mode
execution.Program/CRYS

TAL/QUERY_BATCH_STREAM
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Row-level Security Definition transport

This transport provides the Security Definition Editor, which is a tool that
serves as a graphical interface to the /CRYSTAL/AUTH tables in the Open
SQL Connectivity transport. For details on using the Security Definition Editor,
see Security Definition Editor overview.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

Function group for table
maintenance view for
function restrictions

Function group/CRYSTAL/TABMNT

Main programProgram/CRYSTAL/RLSDEF

Include program contain-
ing the module defini-
tions

Program/CRYSTAL/RLS_IN
CLUDE1

Include program contain-
ing the subroutine defini-
tions

Program/CRYSTAL/RLS_IN
CLUDE2

Table maintenance defi-
nitionTable contentsTDDAT [/CRYSTAL/AU-

THFCN]

Table maintenance defi-
nitionTable contentsTVDIR [/CRYSTAL/AU-

THFCN]

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 191

12Transport Files
Overview



DescriptionTypeObject

Table maintenance defi-
nition

Definition of transport
and maintenance object/CRYSTAL/AUTHFCNS

Main program transac-
tionTransaction/CRYSTAL/RLS

Helper transaction
called internally by main
program.

Transaction/CRYSTAL/RLSFCN

Cluster Definition transport

This transport provides the Cluster Definition tool. This tool enables you to
build up a metadata repository for ABAP data cluster definitions. These
definitions provide the Open SQL driver with the information it requires in
order to report off these data clusters. For details on using the Cluster
Definition Tool, see the “Reporting off clusters” section of the SAP
BusinessObjects XI Integration User's Guide.

Note:
ABAP data clusters are not the same as cluster tables. Cluster tables are
already defined in the DDIC.

DescriptionTypeObject

Main programProgramZCIMPRBG

Include programProgramZCRBGTOP

192 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Transport Files12 Overview



DescriptionTypeObject

Main program transac-
tionTransactionZCDD

Authentication Helpers transport

Note:
For NetWeaver 7.0.2 or higher, this transport will be provided as part of
NetWeaver.

This transport provides access to the higher performance user list used by
the SAP SAP BusinessObjects Enterprise security plug-in. This enhancement
frees users from having to enter their credentials more than once to access
any of the SAP BusinessObjects Enterprise, R3, and BW systems.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

Security helper func-
tionsFunction group/CRYSTAL/SECURITY

Content Administration Workbench

Note:
For NetWeaver 7.0.2 or higher, this transport will be provided as part of
NetWeaver.

This transport provides content administration functionality for BW systems.
It is available only as a Unicode compatible transport.
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DescriptionTypeObject

Development classPackage/CRYSTAL/BC

Multi CE-aware HTTP
request handlerClass

/CRYS
TAL/CL_BW_HTTP_HAN
DLER

Report activityDomain/CRYSTAL/OB
JECT_STATUS_DOM

CE object securityDomain/CRYSTAL/OBJ_POLI
CY_DOM

Report activityData element/CRYSTAL/OB
JECT_STATUS

CE object securityData element/CRYSTAL/OBJ_POLI
CY

Publisher stubsFunction group/CRYSTAL/CE_SYNCH

Status messagesMessage class/CRYSTAL/CA_MSG

Program componentProgram/CRYS
TAL/CE_SYNCH_FORMS

Program componentProgram/CRYSTAL/CON
TENT_ADMIN
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DescriptionTypeObject

Program componentProgram
/CRYSTAL/CON
TENT_AD
MIN_CLASS_D

Program componentProgram
/CRYSTAL/CON
TENT_AD
MIN_CLASS_I

Program componentProgram/CRYSTAL/CON
TENT_ADMIN_CTREE

Program componentProgram/CRYSTAL/CON
TENT_ADMIN_FORMS

Program componentProgram
/CRYSTAL/CON
TENT_ADMIN_MOD
ULES

Program componentProgram/CRYSTAL/CON
TENT_ADMIN_PAIS

Program componentProgram/CRYSTAL/CON
TENT_ADMIN_PBOS

Program componentProgram
/CRYSTAL/CON
TENT_AD
MIN_TAB_FRM

Program componentProgram/CRYSTAL/CON
TENT_ADMIN_TOP
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DescriptionTypeObject

Program componentProgram/CRYSTAL/PUB
LISH_WORKER

Program componentProgram/CRYSTAL/PUB
LISH_WORKER_DISP

Program componentProgram
/CRYSTAL/PUB
LISH_WORK
ER_DISP_I

Program componentProgram
/CRYSTAL/PUB
LISH_WORK
ER_FORMS

Program componentProgram/CRYSTAL/PUB
LISH_WORKER_PROC

Program componentProgram
/CRYSTAL/PUB
LISH_WORK
ER_PROC_I

Program componentProgram
/CRYSTAL/PUB
LISH_WORK
ER_SCREEN

Application stateTable/CRYSTAL/CA_DEST

Application stateTable/CRYSTAL/CA_JOB

Application stateTable/CRYSTAL/CA_JOB2
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DescriptionTypeObject

Application stateTable/CRYSTAL/CA_LANG

Application stateTable/CRYSTAL/CA_PARM

Application stateTable/CRYSTAL/CA_ROLE

Application stateTable/CRYSTAL/CA_SYST

Application stateStructure/CRYS
TAL/MENU_TREE_ITEMS

Application stateTable/CRYSTAL/REPORT_ID

Main program transac-
tionTransaction/CRYSTAL/RPTADMIN

Wrapper for report editProgram/CRYSTAL/EDIT_RE
PORT

Functions for report editFunction Group/CRYSTAL/EDIT_RE
PORT

Crystal AuthorizationsAuthorization object
classZSSI

CE operationsAuthorization objectZCNTADMCES

Report operationsAuthorization objectZCNTADMRPT
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DescriptionTypeObject

Background job opera-
tionsAuthorization objectZCNTADMJOB

ODS connectivity transport

This transport enables the ODS Query driver to access ODS data. This
transport is compatible with BW 3.0B patch 27 or higher and BW 3.1C patch
21 or higher.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

ODS functionsFunction group/CRYSTAL/ODS_RE
PORT

BWQuery parameter personalization transport

Note:
For NetWeaver 7.0.2 or higher, this transport will be provided as part of
NetWeaver.

This transport provides support for personalized and default parameter values
in reports based on BW queries.
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DescriptionTypeObject

Development classPackage/CRYSTAL/BC

Variable definitionStructure/CRYSTAL/PERS_VAR

Value definitionStructure/CRYSTAL/PERS_VAL
UE

Personalization func-
tionsFunction Group/CRYSTAL/PERS

BWMDX connectivity transport

Note:
For NetWeaver 7.0.2 or higher, this transport will be provided as part of
NetWeaver.

This transport enables the MDX Query driver to access BW cubes and
queries. This transport is compatible with BW 3.0B patch 27 or higher and
BW 3.1C patch 21 or higher.

DescriptionTypeObject

Development classPackage/CRYSTAL/BC

MDX functionsFunction group/CRYSTAL/MDX
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DescriptionTypeObject

Dataset structureTable definition
/CRYS
TAL/MDX_STREAM_LAY
OUT

ExceptionClass/CRYS
TAL/CX_BAPI_ERROR

ExceptionClass/CRYSTAL/CX_META
DATA_ERROR

ExceptionClass/CRYSTAL/CX_MISS
ING_STREAMINFO

ExceptionClass/CRYS
TAL/CX_NO_MORE_CELLS

ExceptionClass
/CRYS
TAL/CX_NO_MORE_MEM
BERS

ExceptionClass
/CRYS
TAL/CX_NO_MORE_PROP
ERTIES

ExceptionClass
/CRYS
TAL/CX_SAVE_SES
SION_STATE

Dataset processorClass/CRYSTAL/MDX_AP
PEND_DATA
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DescriptionTypeObject

Dataset processorClass/CRYSTAL/MDX_READ
ER_BASE

Dataset processorClass
/CRYS
TAL/MDX_READ_DI
MENSIONS

Dataset processorClass
/CRYS
TAL/MDX_READ_MEA
SURES

Dataset processorClass
/CRYS
TAL/MDX_READ_PROP
ERTIES

Metadata structureTable type/CRYSTAL/MDX_AX
IS_LEVELS

Metadata structureTable type/CRYSTAL/MDX_PROP
ERTY_KEYS

Metadata structureTable type/CRYSTAL/MDX_PROP
ERTY_VALUES

Metadata structureTable type
/CRYS
TAL/MDX_STREAM_LAY
OUT_TAB
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Configuring transports
To set up the Data Access or BW Publisher component of BusinessObjects
XI Integration for SAP, you must import the appropriate transports from the
installation disc to your SAP system. The Data Access and the BW Publisher
use the contents of these transport files when communicating with the SAP
system.

The transports provided with BusinessObjects XI Integration for SAP are
located in the transports directory on the installation cd. These sections
provide you with details on setting up the appropriate transports:

• Types of transports
• Selecting which transports to import
• Checking for conflicts
• Importing the transport files

The installation and configuration procedures required on the SAP system
must be performed by a BASIS expert who is familiar with the Change and
Transport system and who has administrative rights to the SAP system. The
exact procedure for importing transport files varies, depending upon the
version of BASIS that you are running. For specific procedural details, refer
to your SAP documentation.

When you first deploy the Data Access , all users can access all of your SAP
tables by default. To secure the SAP data that users can access, use the
Security Definition Editor. For complete details, see Security Definition Editor
overview.

After you have imported transports, you must configure the appropriate levels
of user access. Create the required authorizations and apply them through
profiles or roles to SAP users who will be designing, running, or scheduling
Crystal reports. For details, see Creating and applying authorizations.

To return to the reporting overview, click Reporting off BW queries, InfoSets,
Operational Data Stores, and MDX cubes.

Types of transports

There are two different sets of the transports: Unicode compatible transports
and ANSI transports. If you are running a BASIS system of 6.20 or later, use
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the Unicode compatible transports. If you are running a BASIS system earlier
than 6.20, use the ANSI transports. The transports_EN.txt file located
in the transports directory on the installation cd lists the Unicode
compatible and ANSI transport files.

Each transport is described here. For details about the contents of each
transport file, see Transport Files.

• Open SQL Connectivity transport

The Open SQL Connectivity transport enables the Open SQL driver to
connect to and report off the SAP system.

• Row-level Security Definition transport

This transport provides the Security Definition Editor, which is a tool that
serves as a graphical interface to the /crystal/auth tables in the Open
SQL Connectivity transport. For details on using the Security Definition
Editor, see Security Definition Editor overview.

• Cluster Definition transport

This transport provides the Cluster Definition tool. This tool enables you
to build up a metadata repository for ABAP data cluster definitions. These
definitions provide the Open SQL driver with the information it requires
in order to report off these data clusters. For details on using the Cluster
Definition Tool, see the "Reporting off clusters" section of the
BusinessObjects XI Integration for SAP User's Guide.

Note:
ABAP data clusters are not the same as cluster tables. Cluster tables are
already defined in the DDIC.

• InfoSet Connectivity transport

The InfoSet Connectivity transport enables the InfoSet driver to access
InfoSets and SAP Queries.

• Authentication Helpers transport

This transport provides the Single Sign On enhancement for the SAP
authentication plug-in. This enhancement frees users from having to enter
their credentials more than once to access any of the BusinessObjects
Enterprise, R3, and BW systems.

• Content Administration Workbench transport
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This transport provides content administration functionality for BW
systems. It is available only as a UNICODE compatible transport.

• BW Query parameter personalization transport

This transport provides support for personalized and default parameter
values in reports based on BW queries.

Note:
Read the transports_EN.txt file located in the transports directory
on the installation CD. This text file lists the names of the files that make up
each transport.

Selecting which transports to import

Import the transports that are required for your R/3, mySAP ERP, or BW
system. Select the Data Access components that you want, and import the
required transports.

NotesTransportSAP System

Open SQL Connectivity
• Row-level Security

Definition
• Cluster Definition

R/3 or mySAP ERP

InfoSet Connectivity

Recommended. Required
if you have installed the
SAP Solution Tools Plug-
in (ST-PI).

Authentication Helpers

Open SQL Connectivity
• Row-level Security

Definition
• Cluster Definition
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NotesTransportSAP System

InfoSet Connectivity

BW

Recommended. Required
if you have installed the
SAP Solution Tools Plug-
in (ST-PI).

Authentication Helpers

Required.Content Administration
Workbench

Required.BW Query parameter
personalization

Checking for conflicts

The contents of the transport files are registered automatically under the
Business Objects namespace when you import the files. The Business
Objects namespace is reserved for this purpose within recent versions of
R/3 and MYSAP ERP. However, object names for some objects such as
authorization objects, authorization classes, and legacy objects may not
contain the appropriate prefixes. It is recommended that you check these
object types for conflicts prior to importing the transport files.

If the function group, any of the function modules, or any of the other objects
already exists on the SAP system, then you must resolve the namespace
before importing the BusinessObjects XI Integration for SAP transport files.
Refer to your SAP documentation for the procedures appropriate to your
version of SAP.

Importing the transport files

Read the transports_EN.txt file located in the transports directory
on the installation CD. This text file lists the exact names of the files that
make up each transport. (The cofiles and data directories below the
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transports directory correspond to the .../trans/cofiles and
.../trans/data directories on your SAP server.)

You must import the Open SQL Connectivity transport before importing the
Row-level Security Definition or the Cluster Definition transports. You may
import the other transports in any order.

Note:

• After copying files from CD to server, ensure that all files are writable
before you import the transports. Imports fail if the import files are
read-only.

• Because the transports are binary files, on UNIX installations you must
add the files by FTP in Binary mode (to avoid file corruption). In addition,
you must have write permissions for the UNIX server.
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This section details the various SAP authorizations required when working
with BusinessObjects XI Integration for SAP.

Authorizations overview
This appendix provides a list of SAP authorizations that, in our experience
and in our test environment, are required when carrying out common tasks
with BusinessObjects XI Integration for SAP. Additional authorization objects
or fields may be required, depending upon your individual implementation.

From each authorization object, you must create an authorization and define
the appropriate field values. You then apply the appropriate authorizations
to the profiles (or roles) of your SAP users. The following sections describe
the required authorizations and provide you with the necessary field values.
For procedural details that are specific to your version of SAP, refer to your
SAP documentation.

Note:

• The information in this appendix is provided as a guideline only.
• The ZSEGREPORT authorization object belongs to the ZSSI object class,

which is installed when you import the BusinessObjects XI Integration for
SAP transport files needed to support Open SQL queries.

Creating and applying authorizations
Next you must create and apply the authorizations needed by each user to
access information using the Desktop Intelligence Integration for SAP. The
exact procedures for creating, configuring, and applying authorizations
depend upon the version of SAP that you have installed.

Creating and applying authorizations provides a list of SAP authorizations
that, in our experience and in our test environment, are required when
carrying out common tasks with BusinessObjects XI Integration for SAP.
Additional authorization objects or fields may be required, depending upon
your individual implementation.

For information on the authorizations needed by content publishers,
administrators of the content publishing tool, and users who view reports
from within BW, see Configuring publishing in the Content Administration
Workbench.
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Actions in BW
This section guides you through a list of various actions in BW.

From within Crystal Reports

This section guides you through a list of various actions in BW from within
Crystal Reports.

Creating a new report from a query in a BW role

ValuesFieldAuthorization object

USER_ROLE*ACT_GROUP

S_USER_AGR

01, 02, 06ACTVT

FUGRRFC_TYPE

S_RFC RS_PERS_BODRFC_NAME

16ACTVT

TABLCTS_ADMFCTS_CTS_ADMI
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ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT

* USER_ROLE denotes the name of any role that the user belongs to. You
can enter multiple values in this field.

* QUERY_OWNER denotes the name of the owner of the query. If you specify
a name, you can report off only those queries with that owner. Enter * to
report off of queries with any owner.

**For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.
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Opening an existing report from a BW role

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC

SUSO, SUNI. RSCR,
SH3A, RFC1, RZX0,
RZX2, RS_PERS_BOD,
/CRYSTAL/PERS,
RSOB

RFC_NAME

16ACTVT

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT
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* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Previewing or refreshing a report

ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
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can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Verifying the database (refreshing table definitions in a report)

ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.
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** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Setting the location of the data source

ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.
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** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Saving a report to a BW role

ValuesFieldAuthorization object

USER_ROLE *ACT_GROUP

S_USER_AGR

01, 02, 06ACTVT

TABLCTS_ADMFCTS_CTS_ADMI

* USER_ROLE denotes the name of any role that the user belongs to. You
can enter multiple values in this field.

Preparing a report for translation while saving to BW

ValuesFieldAuthorization object

USER_ROLE *ACT_GROUP

S_USER_AGR

01ACTVT

TABLCTS_ADMFCTS_CTS_ADMI

* USER_ROLE denotes the name of any role that the user belongs to. You
can enter multiple values in this field.
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Saving a report and simultaneously publishing it to
BusinessObjects Enterprise

ValuesFieldAuthorization object

USER_ROLE *ACT_GROUP

S_USER_AGR

01ACTVT

TABLCTS_ADMFCTS_CTS_ADMI

INFO_AREA ***RSINFOAREA

S_RS_COMP

INFO_CUBE ***RSINFOCUBE

REPRSZCOMPTP

COMP_ID ***RSZCOMPID

COMP_ID ***RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER **RSZOWNER

16ACTVT
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* USER_ROLE denotes the name of any role that the user belongs to. You
can enter multiple values in this field.

** QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

*** For INFO_AREA , INFO_CUBE , or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Starting the Business Explorer Query Designer

ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT
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ValuesFieldAuthorization object

TABLCST_ADMFCTS_CTS_ADMI

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

From within InfoView

This section guides you through a list of various actions in BW from within
InfoView.

Logging on to BusinessObjects Enterprise with SAP credentials

ValuesFieldAuthorization object

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD
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Viewing an SAP BW report on demand

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, RSOB, SUNIRFC_NAME

16ACTVT

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT
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ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_ODSO

0CRM_OLVMRSODSOBJ

DATARSODSPART

03ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Refreshing a report from the viewer

ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_COMP
INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID
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ValuesFieldAuthorization object

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT

INFO_AREA**RSINFOAREA

S_RS_ODSO

0CRM_OLVMRSODSOBJ

DATARSODSPART

03ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.
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Scheduling a report

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, RSOB, SUNIRFC_NAME

16ACTVT

INFO_AREA**RSINFOAREA

S_RS_COMP

INFO_CUBE**RSINFOCUBE

REPRSZCOMPTP

COMP_ID**RSZCOMPID

COMP_ID**RSZCOMPID

S_RS_COMP1

REPRSZCOMPTP

QUERY_OWNER*RSZOWNER

16ACTVT
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ValuesFieldAuthorization object

INFO_AREA**RSINFOAREA

S_RS_ODSO

0CRM_OLVMRSODSOBJ

DATARSODSPART

03ACTVT

* QUERY_OWNER denotes the name of the owner of the query from which
you are creating the report. If you enter the name of the query owner, you
can only report off of queries with this owner. Enter * to denote any query
owner.

** For INFO_AREA, INFO_CUBE, or COMP_ID enter * to denote any value.
If you specify a specific value, you can only report off of queries that contain
these info areas, cubes, and component IDs.

Reading dynamic picklists in report parameters

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, RSOBRFC_NAME

16ACTVT
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Actions in R/3 and mySAP ERP
This section guides you through a list of various actions in R/3 and mySAP
ERP.

From within Crystal Reports using the Open SQL
driver

This section guides you through a list of various actions in R/3 and mySAP
ERP from within Crystal Reports using the Open SWL driver.

Logging on to an SAP server

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, /CRYS-
TAL/OPENSQLRFC_NAME

16ACTVT
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Creating a new report

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, /CRYS-
TAL/OPENSQLRFC_NAME

16ACTVT

01ACTVTZSEGREPORT

Opening or previewing an existing report

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, /CRYS-
TAL/OPENSQLRFC_NAME

16ACTVT

02ACTVTZSEGREPORT
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Verifying the database (refreshing table definitions in a report)

ValuesFieldAuthorization object

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD

02ACTVTZSEGREPORT

FUGRRFC_TYPE

S_RFC /CRYSTAL/OPENSQLRFC_NAME

16ACTVT

Setting the location of the data source

ValuesFieldAuthorization object

02ACTVTZSEGREPORT

FUGRRFC_TYPE

S_RFC /CRYSTAL/OPENSQLRFC_NAME

16ACTVT
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FromwithinCrystal Reports using the InfoSet driver,
reporting off InfoSet

This section guides you through a list of various actions in R/3 and mySAP
ERP from within Crystal Reports using the InfoSet driver, reporting off InfoSet.

Logging on to an SAP server

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYSTRFC_NAME

16ACTVT

Creating a new report from an InfoSet on R/3 and mySAP ERP

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC /CRYSTAL/FLAT,
SKBW, AQRCRFC_NAME

16ACTVT
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ValuesFieldAuthorization object

TABLCTS_ADMFCTS_CTS_ADMI

Note:
Also add enough authorizations to view data rows. For example, P_ORIG
or P_APAP (see Setting the location of the data source).

Verifying the database (refreshing table definitions in a report)

ValuesFieldAuthorization object

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD

Setting the location of the data source

ValuesFieldAuthorization object

AQTGSYSTGENER-
ATESY, SAPDBPNPREPID

P_ABAP

2COARS
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FromwithinCrystal Reports using the InfoSet driver,
reporting off an ABAP query

This section guides you through a list of various actions in R/3 and mySAP
ERP from within Crystal Reports using the InfoSet driver, reporting off an
ABAPA query.

Logging on to an SAP server

ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYSTRFC_NAME

16ACTVT

Creating a new report from an ABAP query on R/3 and mySAP
ERP

ValuesFieldAuthorization object

AQTG02==========P6,
SAPDBPNPREPID

P_ABAP

2COARS

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 229

13Authorizations
Actions in R/3 and mySAP ERP



ValuesFieldAuthorization object

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD

03ACTVT

S_TABU_DIS

Name of table groupGROUP

Verifying the database (refreshing table definitions in a report)

ValuesFieldAuthorization object

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD

FUGRRFC_TYPE

S_RFC SKBWRFC_NAME

16ACTVT

230 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Authorizations13 Actions in R/3 and mySAP ERP



Setting the location of the data source

ValuesFieldAuthorization object

AQTG02==========P6,
SAPDBPNPREPID

P_ABAP

2COARS

ST0R, ST0MS_ADMI_FCDS_ADMI_FCD

FUGRRFC_TYPE

S_RFC SKBWRFC_NAME

16ACTVT

03ACTVT

S_TABU_DIS

Name of table groupGROUP

From within BusinessObjects Enterprise

This section guides you through a list of various actions in R/3 and mySAP
ERP from within BusinessObjects Enterprise.
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Scheduling a report in dialog mode (with an Open SQL query)

ValuesFieldAuthorization object

CLASS

S_USER_GRP

03ACTVT

FUGRRFC_TYPE

S_RFC SYST, RFC1, /CRYS-
TAL/OPENSQLRFC_NAME

16ACTVT

02ACTVTZSEGREPORT

Note:
The value for CLASS is BLANK.

Scheduling a report in batch mode (with an Open SQL query)

ValuesFieldAuthorization object

CLASS

S_USER_GRP

03ACTVT
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ValuesFieldAuthorization object

FUGRRFC_TYPE

S_RFC SYST, RFC1, /CRYS-
TAL/OPENSQL, SH3ARFC_NAME

16ACTVT

' 'JOBGROUP

S_BTCH_JOB

RELEJOBACTION

02ACTVTZSEGREPORT

YBTCADMINS_BTCH_ADM

Note:
The value for CLASS is BLANK.

Running and designing BW BeX queries

When creating a report from a universe based on a BW BeX query, if a date
dimension is included, the system administrator needs to grant S_RS_IOBJ
authorization to both the user designing the Universe and the user running
the report.
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ValuesFieldAuthorization object

03ACTVT

S_RS_IOBJ

RSIOBJ

RSIOBJ_CAT

RSIOBJ_PART

Crystal entitlement system
See Creating a user account for BusinessObjects Enterprise for a complete
listing.
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More Information

A



LocationInformation Resource

http://www.sap.comSAP BusinessObjects product
information

Navigate to http://help.sap.com/businessobjects and on
the "SAP BusinessObjects Overview" side panel click All
Products.

You can access the most up-to-date documentation cover-
ing all SAP BusinessObjects products and their deployment
at the SAP Help Portal. You can download PDF versions
or installable HTML libraries.

Certain guides are stored on the SAP Service Marketplace
and are not available from the SAP Help Portal. These
guides are listed on the Help Portal accompanied by a link
to the SAP Service Marketplace. Customers with a mainte-
nance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support
representative.

SAP Help Portal

http://service.sap.com/bosap-support > Documentation
• Installation guides: https://service.sap.com/bosap-inst

guides
• Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation
guides, upgrade and migration guides, deployment guides,
release notes and Supported Platforms documents. Cus-
tomers with a maintenance agreement have an authorized
user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the
SAP Service Marketplace from the SAP Help Portal, use
the menu in the navigation pane on the left to locate the
category containing the documentation you want to access.

SAP Service Marketplace
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LocationInformation Resource

https://cw.sdn.sap.com/cw/community/docupedia

Docupedia provides additional documentation resources,
a collaborative authoring environment, and an interactive
feedback channel.

Docupedia

https://boc.sdn.sap.com/

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
Developer resources

https://www.sdn.sap.com/irj/boc/businessobjects-articles

These articles were formerly known as technical papers.

SAP BusinessObjects articles
on the SAP Community Net-
work

https://service.sap.com/notes

These notes were formerly known as Knowledge Base ar-
ticles.

Notes

https://www.sdn.sap.com/irj/scn/forumsForums on the SAP Communi-
ty Network

http://www.sap.com/services/education

From traditional classroom learning to targeted e-learning
seminars, we can offer a training package to suit your
learning needs and preferred learning style.

Training

http://service.sap.com/bosap-support

The SAP Support Portal contains information about Cus-
tomer Support programs and services. It also has links to
a wide range of technical information and downloads.
Customers with a maintenance agreement have an autho-
rized user ID to access this site. To obtain an ID, contact
your customer support representative.

Online customer support
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LocationInformation Resource

http://www.sap.com/services/bysubject/businessobjectscon
sulting

Consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise
is available in topics such as relational and multidimensional
databases, connectivity, database design tools, and cus
tomized embedding technology.

Consulting

238 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

More InformationA

http://www.sap.com/services/bysubject/businessobjectsconsulting
http://www.sap.com/services/bysubject/businessobjectsconsulting


Index
A
ABAP queries, reporting off 21
accounts

for BusinessObjects Enterprise 65
system 65

Alert iView 133
Apache Tomcat 5.5

deploying web applications 47
wdeploy 47

architecture 16
diagram 18

authorizations
applying 208
applying for data access users 208
Content Administration Workbench 115
creating 208
for BusinessObjects Enterprise 65
for data access 208
rights in BusinessObjects Enterprise 102

B
Business Information Warehouse. See BW 16
BusinessObjects Enterprise 16

adding servers 60
configuring 148, 150
configuring server 139
creating account for 65
distributing components 57
importing roles 73
layout 152
server groups 94
UNIX installation types 29
UNIX requirements 30

BusinessObjects Enterprise (continued)
Windows installation types 43
Windows requirements 43

BusinessObjects Enterprise repository
client 149
configuring 147, 148
installing 147
instances 153

BW 16
configuring 64
enabling viewing 128
integrating with BusinessObjects Enterprise

100
reporting off queries 21
requirements 29

BW Publisher 16, 23
configuring as a service 104
configuring on UNIX 104
distributing components 59
selecting a configuration 23

BW Publisher service 104
configuring 104
creating RFC destination 106
starting 104

C
Central Management Server (CMS) 20
client requirements 44
Cluster Definition tool 192, 202
Cluster Definition transport 192, 202
CMC

Automatically import users check box 69
disabling SAP authentication 69
Enable SAP Authentication check box 69

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 239



CMC (continued)
options

Max failed entitlement system accesses
field 69

Options
Keep entitlement system disabled field

69
SAP Authentication 69

collaboration 159
configuring 153

comments 153
communication, over TCP/IP 23
components 192, 202

Cluster Definition tool 192, 202
of the product 16
Security Definition Editor 162

Content Administration Workbench 118
adding BusinessObjects Enterprise systems

118
applying authorizations 115
defining user access levels 115
deleting reports 127
overview of report publishing 113
publishing reports 121
publishing reports in background 124
synchronizing report information 124, 126
updating data source of reports 125

cookies 149
Crystal Reports 16, 44

requirements 44
Crystal Reports Explorer 47

integrating with InfoView 47
Tomcat 47

customizing
security definitions 162

D
data access

required authorizations 208
Data Access 16, 186

contents of the transports 186

Data Access (continued)
installation overview 202

data access restrictions 162
data sources 21
default security patterns 100
defining security 162
discussions 153, 159
distributing 57

BW Publisher components 59
components 57
reports over the Web 26
web application server 58
web content 26

documents
copying 157
creating 157
deleting 158
moving 157

E
Enterprise Portal 6.0 134, 136
entitlement systems 67

F
feedback 153, 159
firewalls 174

communication 174
configuration example 177
port requirements 175

G
global lock feature 163
green checkmark, for default system 119
groups 73
GWSETUP 110

240 SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide

Index



I
imported content, configuring 134
importing

.par files 136
business packages 134
master iView par file 136

InfoSet Connectivity transport 202
InfoSets, reporting off 21
installation 13, 28

default security levels 100
distributed 57
troubleshooting 182

installing 28
on UNIX 29
on Windows 43
SAP Gateway on Windows 110

iViews 130
alerts 133
enabling viewing 128
folders 132
samples 131
setting alias name 131
thumbnail 133
URL iViews 141

K
KMC

client 149
collaboration 159
common tasks 156
configuring 146
configuring BusinessObjects Enterprise

Repository 146
copying documents 157
creating documents 157
deleting documents 158
logging on and off 154
navigation 154
navigation options 155
search 159

KMC (continued)
subscribe 159

L
locking down tables 163

M
mapping roles 73
MDX cubes 21
minimum requirements, UNIX 30
minimum requirements, Windows 43

O
object rights 102
objects

copying 157
creating 157
deleting 158
moving 157

Open SQL Connectivity 202
Open SQL Connectivity transport 202
Open SQL driver 162

default security model 162
defining security 162

OpenDocument
WAR files 141

P
personal notes 153
Personal Security Environment

see PSE 80
port requirements

firewalls 175
prerequisites to installing UNIX 30
prerequisites to installing Windows 43
product overview 16

SAP BusinessObjects Enterprise Integration for SAP Solutions Installation and Administration Guide 241

Index



PSE
configuring access 91
generating 88
server-sde trust 80

publishing 23
defining roles for, in BW 114
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